Investigation of Surface Models and the Use of a Smart Rock for Rockfall Modeling

Corinne R. Disenhof

University of New Hampshire, Durham

Follow this and additional works at: https://scholars.unh.edu/thesis

Recommended Citation
https://scholars.unh.edu/thesis/1244

This Thesis is brought to you for free and open access by the Student Scholarship at University of New Hampshire Scholars' Repository. It has been accepted for inclusion in Master's Theses and Capstones by an authorized administrator of University of New Hampshire Scholars' Repository. For more information, please contact nicole.hentz@unh.edu.
INVESTIGATION OF SURFACE MODELS AND THE USE OF A SMART ROCK FOR ROCKFALL MODELING

BY

CORINNE R. DISENHOF

B.S., University of New Hampshire, 2009

THESIS

Submitted to the University of New Hampshire

in Partial Fulfillment of

the Requirements for the Degree of

Master of Science

in

Civil Engineering

September, 2018
This thesis has been examined and approved in partial fulfilment of the requirements for the degree of Master of Science in Civil Engineering by:

Thesis Director, Dr. Jean Benoît, Professor, Civil and Environmental Engineering

Dr. Majid Ghayoomi, Associate Professor, Civil and Environmental Engineering

Neil Olson, MS, Hydrogeologist, NH Department of Transportation

Krystle Pelham, BS, Engineering Geologist, NH Department of Transportation

On August 21, 2018

Original approval signatures are on file with the University of New Hampshire Graduate School.
DEDICATION

To my parents, for their unwavering support.
ACKNOWLEDGEMENTS

I would like to thank my advisor, Dr. Jean Benoit, for his help and support throughout this project and throughout graduate school in general.

Thanks to Artur Apostolov for his time in developing the rockfall Smart Rock and his help and advice pertaining to its use. I would also like to thank John Ahern with the UNH Technical Service Center for his assistance with rock preparation.

Major thanks and appreciation to the New Hampshire Department of Transportation Bureau of Materials and Research, in particular Krystle Pelham, Neil Olson, and Glenn Roberts, for their support and interest in this project, access to the rock cut database, and the time and effort involved in allowing us to drag rocks up rock cuts and drop them. Thanks also to the Rock Remediation Technicians with Ameritech for being willing to help out! And thank you, Neil, for the introduction to VisualSfM and CloudCompare and all the discussions that accompanied them.

Acknowledgements also to the NHDOT for access to high resolution rock cut data sets. These included the terrestrial lidar data from Woodstock, NH, from Professor John Kemeny at the University of Arizona, and the photogrammetry data from Londonderry, NH, from Robert DeFrancesco with GPI. Sam Lingeman with UNH GIS provided the Lamprey River 1 m resolution digital elevation model.

Huge thanks to my fellow graduate students at UNH, in particular Fernanda Fischer, Ryan van der Heijden, and Amin Borghei, for moral support as well as help with rockfall field experiments, theoretical discussions, and Matlab programming.

And of course, thank you to my parents, who supported my decision to return to graduate school somewhat later than planned and helped me cross 3000 miles and many years to get here.
TABLE OF CONTENTS

DEDICATION ........................................................................................................................... iii

ACKNOWLEDGEMENTS ........................................................................................................ iv

TABLE OF CONTENTS .......................................................................................................... v

LIST OF TABLES ...................................................................................................................... x

LIST OF FIGURES .................................................................................................................. xi

LIST OF SYMBOLS ................................................................................................................ xvi

LIST OF ACRONYMS ............................................................................................................. xvii

ABSTRACT ............................................................................................................................. xviii

1 INTRODUCTION ................................................................................................................ 1

1.1 Objective ......................................................................................................................... 2

1.2 Thesis Overview ........................................................................................................... 3

2 BACKGROUND .................................................................................................................. 4

2.1 Rockfall ........................................................................................................................... 4

2.2 Rockfall Hazard Rating Systems and Rock Cuts in New Hampshire ......................... 8

2.3 Experimental Rockfall ................................................................................................. 13

2.4 Rockfall Modeling ........................................................................................................ 20

2.5 Surface Elevation Models ............................................................................................ 24

2.5.1 Survey Data and Manual Measurements ................................................................ 24
5.1.1 Surface Models .......................................................... 112
5.1.2 Modeled Rocks .......................................................... 117
5.1.3 Coefficients of Restitution ........................................... 118
5.1.4 Results ........................................................................... 124
5.1.4.1 Comparison of Coefficients of Restitution – Trajectories and Runout ........................................ 125
5.1.4.2 Comparison of Coefficients of Restitution – Rotational Velocity .............................................. 129
5.1.4.3 Comparison of Slope Models – Trajectories and Runout ......................................................... 132
5.1.4.4 Comparison of Slope Models – Rotational Velocity ............................................................... 138
5.1.5 Summary from College Woods........................................ 140

5.2 Derry, NH ......................................................................... 142
5.2.1 Surface Model............................................................... 142
5.2.2 Results........................................................................... 144

5.3 Crawford Notch, Hart’s Location, NH .................................. 150
5.3.1 Surface Model............................................................... 150
5.3.2 Results........................................................................... 151

5.4 Summary ........................................................................... 158

6 SUMMARY AND CONCLUSIONS ............................................ 160

6.1 Summary ........................................................................... 160
6.2 Conclusions ...................................................................... 161
6.3 Future Work .................................................................... 162

LIST OF REFERENCES ................................................................ 164
APPENDIX A. CREATING A POINT CLOUD USING STRUCTURE FROM MOTION

FREEWARE .................................................................................................................................................. 170

APPENDIX B. COEFFICIENTS OF RESTITUTION ..................................................................................... 196

APPENDIX C. TRAJECTORIES OUTPUT FROM VIDEO PHYSICS .............................................................. 199

APPENDIX D. SMART ROCK DATA FOR COLLEGE WOODS TRIALS ............................................... 208

APPENDIX E: ROCKFALL MODEL BASICS AND TABLES OF ROCKFALL MODEL
PARAMETERS USED.................................................................................................................................... 226
# LIST OF TABLES

Table 2.1: Summary table of rockfall experiments, taken from Duffy and Turner (2012) ........ 15

Table 2.2: Rockfall velocities modeled using three modeling programs (from Arpin and Arndt, 2010). ........................................................................................................................................... 23

Table 3.1 Coefficients of restitution used for comparison of analysis methods. ...................... 50

Table 4.1: Characteristics of rocks used for experimental rockfalls........................................ 77

Table 4.2: Estimated mass moments of inertia (I) for each test rock ....................................... 77

Table 4.3: Summary of experimental runout results for both test rocks................................. 90

Table 4.4: Smart Rock data summary for the 5kg rock trials in College Woods....................... 92

Table 4.5: Smart Rock data summary for the 11kg rock trials in College Woods ...................... 93

Table 4.6: Rock runout from Derry, NH from the trials with SR data ....................................... 98

Table 4.7: Smart Rock data summary for the experimental trials in Derry, NH ....................... 99

Table 4.8: Runout distances from Crawford Notch trials....................................................... 103

Table 4.9: Smart Rock data summary for experimental trials at Crawford Notch ............... 104

Table 4.10: Summary of the range of maximum rotational velocities measured at each
experimental location........................................................................................................... 109

Table 5.1: Field measurements compared to digital measurements on the College Woods SfM
model........................................................................................................................................ 114

Table 5.2: Default coefficients from RocFall 6.0 .................................................................... 119

Table 5.3: Original sources of coefficients of restitution drawn from the literature .............. 120

Table 5.4: All coefficients used for modeling the College Woods slope............................... 124

Table 5.5: Coefficients of restitution used for Derry rock cut models.................................... 144
LIST OF FIGURES

Figure 2.1 Rockfall motion on variable slopes. After Ritchie (1963) ............................................ 5
Figure 2.2: Rockfall from New Hampshire rock cuts................................................................. 6
Figure 2.3: Examples of jointing and types of rock slope failure.................................................. 7
Figure 2.4: Map of rock cuts in New Hampshire and their RHRS ratings..................................... 11
Figure 2.5: Representative rock cuts in New Hampshire.............................................................. 12
Figure 2.6: Rockfall and design parameters from Ritchie (1963) ................................................. 16
Figure 2.7: Example design chart for a 21.3 m high 4V:1H slope from Pierson et al. (2001) . .... 17
Figure 2.8: Measured rotational velocities from Ushiro et al. (2006) (Wyllie, 2015) .................. 18
Figure 2.9: A rockfall test in California (Markham, 2010).......................................................... 19
Figure 2.10: Rotational velocity results from Caviezel et al. (2018b)........................................... 20
Figure 2.11: 2D and 3D trajectory models...................................................................................... 21
Figure 2.12: A cross-section from the construction plans of I-93 Exit 4 ........................................ 25
Figure 2.13: Basic acquisition of terrestrial and aerial lidar data.................................................. 26
Figure 2.14: Availability of digital elevation models in New Hampshire ........................................ 28
Figure 2.15: Differences in data resolution for various surface models....................................... 29
Figure 2.16: A SfM point cloud of rock cut 110 at Crawford Notch, Hart's Location, NH ............ 30
Figure 2.17: A 3D runout model using two data resolutions. After Crosta et al. (2015) ............ 31
Figure 2.18: The rockfall Smart Rock, showing the orientation of the internal instrument axes. 34
Figure 3.1: Velocities before and after a rock impacts a slope. After Wyllie (2015) ....................... 36
Figure 3.2: Experimental drop test for determining the energy coefficient of restitution (after Ashayer, 2007) .................................................................................................................. 38
Figure 3.3: Trajectories from lumped mass (a) and rigid body (b) rockfall simulations.............. 40
Figure 3.4: An example of a slope profile with slope roughness varied from the original slope. 43
Figure 3.5: Location of rock cut 64 along I-93 exit 4 southbound onramp. 44
Figure 3.6: Locations of the survey stations and available cross-sections along the I-93 exit 4 southbound onramp. 45
Figure 3.7: A section of the photogrammetry point cloud (a) and mesh surface (b) from Londonderry, NH 46
Figure 3.8: Location of the Barron Mountain rock cut 47
Figure 3.9: A terrestrial lidar scan from the Barron Mountain rock cut. 48
Figure 3.10: Surface models for Barron Mountain 49
Figure 3.11: Trajectories modeled using different analysis methods. 52
Figure 3.12: Histograms comparing runout distances using differing analysis methods. 53
Figure 3.13: Station 912+00, western side of the road. 54
Figure 3.14: Elevation profiles from different surface models at station 912+00. 54
Figure 3.15: Original and simplified slope data for Sta. 912+00. 56
Figure 3.16: Trajectories of a 50 kg square rock modeled for Sta. 912+00 using different slope models. 57
Figure 3.17: Comparison of rock end points for different slope models for station 912+00. 58
Figure 3.18: Average and maximum rock path ending locations, Station 912+00, Londonderry 58
Figure 3.19: Station 913+50, northern side of the road. 60
Figure 3.20: Elevation profiles from different surface models at Station 913+50. 60
Figure 3.21: Trajectory models of a 50 kg rock on three elevation models at Station 913+50. 61
Figure 3.22: Histograms and cumulative percentages of rock runout for each slope model for Station 913+50. 62
Figure 3.23: Average and maximum rock path ending locations, Station 913+50, Londonderry 63
Figure 3.24: Comparison of profiles used for Barron mountain rockfall models...................... 64
Figure 3.25: Comparison of the original and simplified cross-sections, Barron Mountain.......... 65
Figure 3.26: Example of a DEM profile with surface roughness variation applied. ................. 65
Figure 3.27: Trajectories of a 50 kg rock from Barron Mountain section 7A........................... 66
Figure 3.28: Modeled rock runout from Barron Mountain 7A.............................................. 67
Figure 3.29: Average and maximum rock path ending locations, Barron Mountain............... 68
Figure 4.1: Smart Rock sensor and shell ................................................................................. 71
Figure 4.2: Preparing the test rock for the Smart Rock ......................................................... 72
Figure 4.3: Results of a drop test with the redesigned "rockfall" Smart Rock ......................... 75
Figure 4.4: Rocks used for Smart Rock experiments and experimental rockfalls................. 76
Figure 4.5: Orientation of the SR when inside rock 1 (left) and rock 2 (right)....................... 77
Figure 4.6: Sneed and Folk (1958) particle shape classification diagram .............................. 77
Figure 4.7: The location of the experimental slope used in Durham, NH............................ 80
Figure 4.8: The rock slope in College Woods used for SR rockfall experiments.................... 81
Figure 4.9: A rock being pulled up the new rock cut in Derry, NH ..................................... 84
Figure 4.10: Experiment locations at rock cut 110, Crawford Notch .................................... 85
Figure 4.11: Rockfall tests at Crawford Notch, rock cut 110............................................... 87
Figure 4.12: Trajectory analysis for College Woods trial 7 .................................................... 88
Figure 4.13: Adjusted trajectories of the falling rocks in College Woods from video analysis .. 89
Figure 4.14: Measured runout distances on the College Woods slope ................................. 91
Figure 4.15: Rock runout distances for College Woods projected to the horizontal plane ...... 91
Figure 4.16: SR acceleration and rotational velocity for T7 with the compact elongated, 5 kg rock, College Woods................................................................. 94
Figure 4.17: SR acceleration and rotational velocity for T15 with the compact bladed, 11 kg rock, College Woods................................................................. 95
Figure 4.18: First impact of the SR with the ground in Derry............................................. 98
Figure 4.19: SR results for Derry trial 2, using the 5 kg rock............................................. 100
Figure 4.20: SR results for Derry Trial 7, using the 11 kg rock............................................. 102
Figure 4.21: SR data for Crawford Notch location 1, trial 1............................................. 106
Figure 4.22: SR data for Crawford Notch location 2, trial 4............................................. 107
Figure 5.1: Comparison of surface models used to model the College Woods slope ............ 113
Figure 5.2: SfM model of College Woods........................................................................... 114
Figure 5.3: Mesh created of the College Woods SfM point cloud........................................ 115
Figure 5.4: Comparison of the two digital elevation models for College Woods................... 116
Figure 5.5: Examples of modeled rocks 1 (a) and 2 (b).................................................... 118
Figure 5.6: Experimental determination of $R_E$................................................................. 122
Figure 5.7: Trajectories modeled using varied coefficients of restitution......................... 126
Figure 5.8: Modeled rockfall runout using varying coefficients of restitution, College Woods. 127
Figure 5.9: Average and maximum rock path ending locations, College Woods comparison of coefficients.............................................................................................. 128
Figure 5.10: Comparison of measured and modeled rotational velocity with changing coefficients of restitution, College Woods............................................. 131
Figure 5.11: Trajectories modeled on differing surface models.......................................... 133
Figure 5.12: Example of slope roughness variation applied to manual and 1 m DEM profiles. 135
Figure 5.13: Comparison of runout results for College Woods with and without added slope roughness ................................................................. 136
Figure 5.14: Modeled rockfall runout using varying surface models, College Woods .............. 136
Figure 5.15: Average and maximum rock end path locations, College Woods slope model comparison .......................................................................................................................... 137
Figure 5.16: Comparison of measured and modeled rotational velocity with changing surface models, College Woods .................................................................................................................. 139
Figure 5.17: SfM model of the Derry, NH rock cut ................................................................. 143
Figure 5.18: Trajectory simulations for the Derry rock cut ..................................................... 146
Figure 5.19: Output from RocFall showing rock ending locations for Derry simulations........ 147
Figure 5.20: Comparison of average modeled values to measured rotational velocities, Derry 149
Figure 5.21: Model of the Crawford Notch rock cut and cross-section locations ................. 151
Figure 5.22: Trajectory model and rock path end points for Crawford Notch location 1. ....... 152
Figure 5.23: Trajectory model and rock path end points for Crawford Notch location 2. ........ 153
Figure 5.24: Comparison of averaged modeled versus measured rotational velocity, location 1 Crawford Notch ................................................................................................................. 155
Figure 5.25: Comparison of average modeled versus measured rotational velocity, location 2, Crawford Notch ................................................................................................................. 156
LIST OF SYMBOLS

a – Acceleration
F – Force
g – Acceleration due to gravity: 9.8 meters per second
h – Height
I – Moment of inertia
KE – Kinetic energy
kN – Kilonewton
m – Mass
μ – Coefficient of friction
μr – Rolling coefficient of friction
ω – Rotational (angular) velocity
φ – Friction angle
Re – Energy coefficient of restitution
RE – Total energy coefficient of restitution (translational and rotational)
R_t – Impulse coefficient of restitution
RN – Normal coefficient of restitution
RT – Tangential coefficient of restitution
ν – Velocity
LIST OF ACRONYMS

2D – 2 Dimensional

3D – 3 Dimensional

3DEP – 3 Dimensional Elevation Program

Caltrans – California Department of Transportation

CRSP – Colorado Rockfall Simulation Program

DEM – Digital Elevation Model

DOT – Department of Transportation

dps – Degrees per second

EOP – Edge of Pavement

GIS – Geographic Information System

GPS – Global Positioning System

Lidar – Light Detection and Ranging (also spelled LIDAR or LiDAR)

NH – New Hampshire

NHDOT – New Hampshire Department of Transportation

NH GRANIT – NH Geographically Referenced Analysis and Information Transfer System

ODOT – Oregon Department of Transportation

RHRS – Rockfall Hazard Rating System

SfM – Structure from Motion

SR – Smart Rock

TIN – Triangular Irregular Network

USGS – United States Geological Survey

VTrans – Vermont Agency of Transportation
ABSTRACT

INVESTIGATION OF SURFACE MODELS AND THE USE OF A SMART ROCK FOR ROCKFALL MODELING

by

Corinne R. Disenhof

University of New Hampshire, September 2018

Rockfall is a worldwide problem, claiming lives and causing damage to infrastructure. Common and well-studied in mountainous areas, it nevertheless poses hazards in less rugged terrain as well. In New Hampshire, major instances of rockfall occur infrequently, despite the well-publicized demise of the Old Man in the Mountain. To maintain this level of safety, the Department of Transportation monitors and remediates rock cuts along roadways to minimize the threat of rockfall. However, detailed assessments of rock slope stability, such as 3D structural and stability analyses and 2D rockfall runout modeling, are rare. A major limit on these analyses is the lack of detailed digital data, such as terrestrial lidar, which can be expensive to obtain. This thesis examines the use of readily-available digital data to perform rockfall modeling and also assesses the use of an instrumented “Smart Rock” to obtain measurable data from experimental rockfall events. Digital elevation models and a simple photogrammetry methodology are used to create 2D profiles of rock exposures for rockfall runout modeling. Rockfall models are compared to video analyses and Smart Rock measurements of experimental rockfalls to verify the modeling results. The redesigned “rockfall” Smart Rock is shown to characterize rock motion throughout the rockfall path.
1 INTRODUCTION

Rockfall is a hazard throughout the world. In the United States, millions of dollars are spent annually for the maintenance, stabilization, and hazard mitigation of rock slopes, to prevent falling rocks from threatening lives and property (Pierson et al., 2001). Experimental and theoretical methods of assessing rockfall hazards have existed for decades to help understand the hazard levels of rock slopes and to estimate the location, size, and impact of a rockfall. This can help design engineered protective structures, such as catchment ditches, barriers, and netting, but real rockfall data for use in design are limited.

Full scale rockfall experiments and computer simulations are the primary ways of predicting rockfall trajectories and impact velocities. Experiments are used to determine the distance a rock will travel from the slope and its location of impact using field measurements. Trajectories, bounce heights, and velocities are typically determined using video footage. Computer simulations have also been in use for decades, using digital representations of rock slopes and mathematical models to predict the motion of falling rocks. However, for these models to present accurate results, they need to be calibrated with location-specific data, such as detailed slope models and material properties.

This research examines the use of surface models such as digital elevation models and photogrammetry for rockfall modeling from highway rock cuts, to determine if readily-available data can be used to create accurate models. Coupled with this, a Smart Rock developed at the University of New Hampshire was used to record rockfall motion. Field experiments were performed to evaluate the applicability of the Smart Rock for comparison, calibration, and verification of rockfall models.
These rockfall experiments were conducted on a 6 m tall slope in College Woods in Durham, NH, an approximately 15 m tall, newly created rock cut in Derry, NH, and on a 30 m tall rock cut in Crawford Notch, Hart’s Location, NH.

This thesis presents three sets of computer simulations comparing rockfall models created with high resolution slope data to those created using digital elevation models that are available from the NH GRANIT geospatial database. Experimental rockfalls conducted with the Smart Rock are compared to computational models built using a variety of surface models and model input parameters.

1.1 Objective

The objectives of this research are to investigate whether readily-available digital data might be suitable for basic modeling of rockfall from rock cuts in New Hampshire and to demonstrate the functionality of a Smart Rock for rockfall applications.

The following steps were performed to meet these objectives.

- Two dimensional rockfall models were created for existing rock cuts that have high-resolution slope data as well as digital elevation models. Predicted rockfall runout from the models was compared using different surface data resolutions.
- Experimental rockfalls were performed at three locations. The University of New Hampshire’s Smart Rock embedded in the test rocks was used to describe rock motion in terms of acceleration and rotational velocity.
- Experimental data were used for calibration of, and comparison to, rockfall simulations using varying model inputs and high- and low- resolution surface models.
1.2 Thesis Overview

Chapter 1 discusses the motivation and objective of the current research. Chapter 2 reviews rockfall mechanisms and rock slope hazard assessments, in addition to summarizing previous experimental rockfalls conducted by others, rockfall modeling techniques, and the different types of surface models that may be used for rockfall modeling. It also provides some background on the Smart Rock developed by the University of New Hampshire.

Chapter 3 discusses the two-dimensional rockfall modeling performed for two rock cuts in New Hampshire in order to compare simulations using varying surface elevation models. Experimental rockfalls using the Smart Rock are discussed in Chapter 4. Computer simulations of rockfall on the experimental slopes are discussed in Chapter 5 and compared to the experimental data acquired using the Smart Rock. Finally, Chapter 6 provides a summary of this research project and offers conclusions and suggestions for future work.

Appendix A outlines a methodology for creating a three dimensional model of a rock slope using readily available equipment and software. Appendix B presents a table of coefficients of restitution from the literature. Appendix C provides trajectory figures for the experimental rockfalls analyzed in this research, and Appendix D provides the Smart Rock data from these experiments. Appendix E provides a brief overview of the RocFall software, tables of data used for the calculation of coefficients of restitution, and rockfall model parameters.
2 BACKGROUND

2.1 Rockfall

Expanding infrastructure in mountainous and rocky terrain potentially exposes the public to landslide and rockfall hazards. Rockfall occurs when loose rocks become dislodged and tumble from a rock face or slope. Unlike a rock avalanche or landslide, rockfall typically involves smaller material volumes and rock movement that includes free fall as well as sliding, bouncing, or rolling, as seen in Figure 2.1 (Turner and Duffy, 2012b). The source may be high natural slopes in mountainous areas or excavated rock cuts created during construction of infrastructure. Rock cuts along modern road construction are often designed with wide catchment ditches and engineered stabilization methods to mitigate the hazard from potentially unstable rock. However, many rock cuts exist that were created prior to modern design recommendations, or where the extent of the rock exposure is so significant that absolute protection measures are economically or physically impossible. Older cuts in particular may be susceptible to rockfall, due to techniques of excavation that often left fractured and frequently overhanging rock as well as insufficient distance between the rock face and roadway (Pierson and Van Vickle, 1993). Older rock cuts may also be more highly weathered than freshly broken rock, which decreases the integrity of the rock and makes rockfall more likely. Figure 2.2 shows examples of rockfall from rock cuts in New Hampshire (NH), which fortunately in these cases did not reach the roadways.

A rockfall occurs when blocks of rock separate from the main body of the rock exposure. Separation typically occurs along discontinuities such as joints, fractures, or bedding planes. These may intersect with each other or with an exposed slope face. Joints and fractures may be widened and weakened by physical weathering, such as wedging by freeze-thaw or plant growth, or by
chemical weathering such as the degradation of rock-forming minerals to clay (Wyllie, 2015). Mechanically, a rock face fails when the weight of a rock block exceeds the forces holding it in place, either along one or more joints or by the force of gravity exceeding its tensile strength. Several restraining forces may prevent a block from falling. These include other rock, earth, or barriers acting as containment or buttresses, friction between the block and the adjacent surfaces, or engineered stabilization methods such as rock bolts or shotcrete.

If a plane of weakness such as a joint is exposed by an excavation (“daylighting”), the friction and cohesion of the joint and/or the tensile strength of the rock remain as the sole restraining forces unless stabilized. If a fracture or joint set intersects other discontinuities such
Figure 2.2: Rockfall from New Hampshire rock cuts.
a) Overhanging rock and a rockfall (far right) at Crawford Notch, Harts Location, NH. This rock cut is considered the most hazardous in NH. The two fallen rock blocks to the far right of the image are approximately 1 m wide each and came within 3 m of the road. b) Pieces of rock that toppled from a cut in Stoddard, NH. The source of the fall can be seen as gaps in the rock face; 3 >1 m blocks are in the ditch. For scale, the presplit spacing (distance between lines from blasting) is approximately 1 m.

that the block is no longer attached to the rock face (Figure 2.3), friction and cohesion between the rock surfaces will control failure. If a set of discontinuities dips at a higher angle than the angle of friction between the rock block and the slope, the rock will fail when excavation removes its support. If the rock fails along one joint set, the failure may be by plane sliding (Figure 2.3c). Wedge sliding occurs when failure happens along the intersection of two joint sets (Figure 2.3d), and toppling occurs when bedded rock dipping away from an excavation fails under its own weight (Figure 2.3e). These failure modes can occur individually or in more complex combinations (Goodman, 1989). Once a rock fails, it may move in any of the combination of rolling, bouncing,
sliding, or falling, dependent primarily on the slope geometry, as shown in Figure 2.1 (Ritchie, 1963).

![Figure 2.1: Examples of jointing and types of rock slope failure.](image)
a) one joint set showing tabular slabs b) three joint sets showing blocky failure c-e) types of failure. After Barton (1978) and Goodman (1989).

The angle of friction of the discontinuity is a property of the materials composing its surfaces. The lithology of the rock, the degree of weathering, and the roughness of the surface or infilling in joints and fractures influence the friction angle and therefore contribute to the strength of the rock mass. Cementation, recrystallization, or infilling may provide cohesion that strengthens a discontinuity, while the presence of clay might weaken it significantly. Fresh igneous rock may have friction angles as high as 55 degrees (Gonzalez de Vallejo and Ferrer, 2011), while unlithified clays may have a friction angle as low as 4 degrees (Coduto, 1999). The presence of water in discontinuities also decreases the normal forces between surfaces, and therefore the friction between them (Gonzalez de Vallejo and Ferrer, 2011).
The occurrence of rockfall is influenced by any factor that may change the stresses and forces on the rock face: the slope geometry, rock lithology, structure, pattern and abundance of discontinuities, precipitation, the presence of surface water, groundwater, or infiltration, the occurrence of freeze-thaw, vegetation, seismic activity, weathering, and loading or unloading of the slope (Pierson and Turner, 2012; Wyllie, 2015). To assess the hazards rock slopes may present and to predict the possibility of rockfall, analyses must carefully take these factors into account.

2.2 Rockfall Hazard Rating Systems and Rock Cuts in New Hampshire

Globally, slope stability hazards are assessed through a combination of reconnaissance and field work, investigation of historical failures, the knowledge and experience of the analysis team, and modern digital mapping and analysis techniques. Studies from high hazard areas around the world combine slope data, geologic properties, land use, climate data, and other variables in geographic information systems (GIS) to identify specific source locations and potential trajectories of slope stability hazards, such as rockfall and landslides (Abdulwahid and Pradhan, 2016; Fanos et al., 2016; Lan et al., 2010). Lack of resources, including data and funding, make these studies uncommon in lower hazard areas, which rely primarily on rockfall hazard rating systems (RHRS). RHRSs use similar data types as geospatial analyses, but rather than spatial analysis of rock sources and paths for individual slopes, the RHRSs compare multiple rock slopes semi-quantitatively to better recognize hazards and to prioritize resources for remediation.

The RHRS in use by NH is based on the original RHRS developed by the Oregon Department of Transportation (ODOT) (Pierson, 1992; Pierson and Van Vickle, 1993). Rock slopes are surveyed and the presence or absence of significant hazards is judged based on the experience of the assessor. If no hazards are identified, the slope is assigned a C, or low hazard,
rating. If more evaluation is needed, the RHRS takes into account the height of the slope, the effectiveness of the catchment ditch, the traffic conditions and geometry of the roadway, the structural geology of the rock slope, the stability of existing joints, the climate, and the history of rockfall at the site. Each component is given a numerical score that increases exponentially with increasing hazard, and the combination of scores is used to assign a hazard rating of A, high hazard, or B, moderate hazard. The scores are relative rather than quantitative; though a higher total score indicates a higher hazard, any specific numerical score is subjective and dependent on the individual interpreting the hazards (Pierson, 1992).

There are approximately 375 rock cuts along roads and highways throughout the state of NH that are tracked in a database maintained by the Engineering Geologist in the NHDOT Bureau of Materials and Research. Each rock cut has been described, photographed, and given a rockfall hazard rating. Rock cuts greater than 8 m (25 ft) in height are included in the database. As of 2018, 11% of the state rock cuts are rated A, 27% are rated B, and the remainder are rated C. C cuts are typically short, have a large distance between the rock cut and the roadway, or are along roads with minimal traffic. B cuts include those that are taller and that may be more susceptible to rockfall, but generally have a ditch with sufficient space between the rock face and the roadway to contain any rockfall (NHDOT, 2018). These include many of the more recently constructed rock cuts created using controlled blasting methods, such as presplitting, designed to leave a smooth, more stable rock face (Wyllie and Mah, 2004). In addition, the most hazardous of these are constructed with a wide ditch at the base containing impact-absorbing gravel, and rockbolts may also be used to stabilize loose blocks. A-rated cuts are often older and were frequently created without the use of controlled blasting techniques, which sometimes left jagged rock faces with overhanging, potentially unstable rock blocks. Many have less than 2 m of space between the rock
slope and the roadway, and they may be very tall (>15 m) and have a high frequency of rockfall. Rockbolts, nets, and barriers may be used to stabilize blocks on these rock cuts or protect against rock fall (NHDOT, 2018). Figure 2.4 shows the locations of rock cuts in New Hampshire, as well as the towns of Londonderry, Woodstock, Durham, Derry, and Hart’s Location, which have rock slopes that were investigated as part of this project.

Figure 2.5 shows examples of representative A, B, and C rated cuts in NH. Figure 2.5a shows rock cut 74 on route 11 in Alton, NH. This cut is 30 m tall and 250 m long, with a 6 m wide gravel ditch that is judged to be of limited effect. It is situated on a curve that limits the decision sight distance of oncoming cars, and the road is a single 5 m lane in each direction, limiting the width available for a driver to use to avoid a hazard. Frequent rockfall has been observed here (NHDOT, 2018). The combination of factors gives this an A-rating. Rockfall hazards are decreased using netting to prevent falling rock from bouncing off the rock face.

Figure 2.5b shows rock cut 385, along the northbound off ramp of I-93 Exit 3 in Windham, NH. This B-rated rock cut was constructed in 2014 and has experienced occasional small rockfalls. It is roughly 18 m tall, 450 m long, and includes a very effective 8 m wide ditch containing impact-absorbing gravel. Though the exit is busier than route 11, the single-direction road width was measured to be 11 m, and there is a longer sight distance. Figure 2.5c shows C-rated cut number 29, along route 89 in Sutton, NH. It is 11 m high and 150 m long and has approximately 4 m between the rock face and the road, with 10 m of travel space in either direction (NHDOT, 2018).

In other states, such as Vermont (VT), the RHRS has been modified to take detailed geologic assessments, kinematic analyses of rock structure, and basic rockfall modeling into account when assigning a hazard rating (Thomas, 2018). These additions supplement the data available for hazard assessment and remediation.
Figure 2.4: Map of rock cuts in New Hampshire and their RHRS ratings. Locations of interest to this thesis are labeled.
Figure 2.5: Representative rock cuts in New Hampshire.
(a) An A-rated rock cut in Alton, NH, (b) a B-rated rock cut in Windham, NH, and (c) a C-rated rock cut in Sutton, NH.
2.3 Experimental Rockfall

The purpose of rockfall hazard ratings is to easily identify which rock faces may present hazards to a roadway and to help prioritize resources when remediating these hazards (Pierson, 1992). In order to lessen rockfall hazards, the rock cut can be designed such that any falling rocks are unlikely to reach the road. Ditches, or catchment areas, are one of the best and simplest ways to keep rocks off roadways (Pierson et al., 2001). Barriers such as fences, netting, and rock sheds can be put in place to stop or slow falling rocks. For these to be designed appropriately to intercept blocks and withstand impacts, the motion of the falling rock must be anticipated, including its energy, velocity, and bounce height (Hess et al., 2010).

Rockfall field experiments, which involve purposely releasing rocks down a slope, have been the method of obtaining actual rockfall data since the 1960s. Duffy and Turner (2012) provide a comprehensive list of rockfall experiments that have been conducted between 1963 and 2009 (Table 2.1) and also discuss the necessary considerations for experimental design. The past experiments documented in the literature were performed either to evaluate the trajectories and runout zones of falling rocks or to obtain the velocities and bounce heights for barrier design. Rockfall experiments even on small scales are inherently dangerous, so experiments are typically conducted either in quarries or on other tests slopes away from transportation corridors, or on real slopes of concern by interrupting traffic. The rocks used are generally large, with weights varying from 70 kg to upwards of 2,000 kg, and the slopes may be upwards of 30 m tall at varying angles. In the experiments described by Duffy and Turner (2012), the number of rocks released vary from as few as three to thousands, in the case of two studies performed in 1994 and 2001 by ODOT. They state that rolling 10-20 rocks is common procedure when the experiments require closing of
a transportation corridor (2012). The data from many of these experiments have been used to guide designs for protective barriers and to validate computer simulations and numerical models.

The first documented rockfall experiments were performed by Ritchie (1963) with the Washington State Highway Commission, in order to better understand rockfall motion and to design ditches and barriers. They performed hundreds of experimental rockfalls around the state of Washington, using quarries in various conditions and rock cuts with “fallout zones” (catchment areas) and with talus slopes. Rock trajectories were recorded using a slow-motion camera and used to make observations on the motion of rocks during a fall. Ritchie (1963) concluded that the size and shape of a rock have little influence on rockfall motion unless it is very oblong, though this has been argued against by later authors (Duffy and Turner, 2012). He also determined that rotational velocity is a very important component of rockfall motion as a method of energy transference and dissipation. He observed that the slope angle and slope height control the motion of rockfall, so that a very high (~30 m) 1H:4V slope might produce a falling rock with significant vertical velocity but little horizontal or rotational motion, leading to smaller runout distances. A rock rolling on a 1H:2V slope, however, increases in vertical, horizontal, and rotational velocity, leading to longer runout distances and higher impacts. The output of these experiments and conclusions were recommendations for the design of catchment ditches with barrier fences based only on the height and angle of the slope, as shown in Figure 2.6. These recommendations have been used as design guides for catchment ditches for more than 50 years, and have since been revised and expanded (Pierson et al, 2001).

In the early 1990s and the early 2000s, ODOT performed large scale rockfall experiments in a specially constructed test quarry on rock cuts with vertical, 1H:4V, 1H:2V, 1H:1.33V, and 1H:1V slopes. They tested heights of 12.2 m, 18.3 m, and 24.4 m and catchment areas with three
### Table 2.1: Summary table of rockfall experiments, taken from Duffy and Turner (2012)

#### Summary of Field Rock-Rolling Experiments Performed Since the 1960s

<table>
<thead>
<tr>
<th>Test Sponsor and Approximate Date</th>
<th>Source Describing Test</th>
<th>Purpose of Test</th>
<th>Number of Rocks Rolled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Washington DOT, 1963</td>
<td>Ritchie 1963</td>
<td>Define rockfall trajectories; design fences and ditches</td>
<td>Hundreds</td>
</tr>
<tr>
<td>City of Lecco, Italy, 1974</td>
<td>Broili 1974</td>
<td>Define rockfall trajectories</td>
<td>10</td>
</tr>
<tr>
<td>North Carolina DOT, 1978</td>
<td>Evans 1989</td>
<td>Define rockfall trajectories</td>
<td>146</td>
</tr>
<tr>
<td>North Carolina DOT, 1984</td>
<td>Wu 1984; Evans 1989</td>
<td>Define rockfall trajectories</td>
<td>Not defined</td>
</tr>
<tr>
<td>Caltrans, 1985</td>
<td>McCauley et al., 1985</td>
<td>Fences, berms, trajectories</td>
<td>223</td>
</tr>
<tr>
<td>Golder Associates, British Columbia, Canada, 1987</td>
<td>Wyllie 1991</td>
<td>Barrier designs</td>
<td>60</td>
</tr>
<tr>
<td>Caltrans, 1987</td>
<td>Duffy 1987</td>
<td>Define rockfall trajectories</td>
<td>12</td>
</tr>
<tr>
<td>University of Arizona, Dept. of Mining and Geological Engineering, Tucson, 1988</td>
<td>Evans 1989</td>
<td>Define rockfall trajectories</td>
<td>50</td>
</tr>
<tr>
<td>Colorado DOT, 1989</td>
<td>Barrett and Pfeiffer 1989</td>
<td>Barrier designs</td>
<td>13</td>
</tr>
<tr>
<td>Caltrans, 1989</td>
<td>Smith and Duffy 1990</td>
<td>Barrier designs</td>
<td>76</td>
</tr>
<tr>
<td>Colorado DOT, 1991</td>
<td>Hearn 1991; Hearn et al., 1992</td>
<td>Barrier designs</td>
<td>70</td>
</tr>
<tr>
<td>Caltrans, 1991</td>
<td>Duffy 1991</td>
<td>Barrier designs</td>
<td>6</td>
</tr>
<tr>
<td>Geobrug Inc, Switzerland, 1991</td>
<td>Duffy 1992</td>
<td>Barrier designs</td>
<td>90</td>
</tr>
<tr>
<td>Geobrug Inc, Switzerland, 1992</td>
<td>Duffy and Haller 1993</td>
<td>Barrier designs</td>
<td>18</td>
</tr>
<tr>
<td>University of the Pacific, Stockton, California, 1993</td>
<td>Kane and Duffy 1993</td>
<td>Barrier designs</td>
<td>24</td>
</tr>
<tr>
<td>Oregon DOT, 1994</td>
<td>Pierson et al. 1994</td>
<td>Define rockfall trajectories</td>
<td>2,790</td>
</tr>
<tr>
<td>ISMES SpA, Bergamo, Italy, and Dept. of Geology, Imperial College of Science, Technology, and Medicine, London, 1992-1995</td>
<td>Azzoni and de Freitas 1995</td>
<td>Define rockfall trajectories</td>
<td>60</td>
</tr>
<tr>
<td>Caltrans, 1995</td>
<td>Beck 1995</td>
<td>Define rockfall trajectories</td>
<td>15</td>
</tr>
<tr>
<td>Caltrans, 1996</td>
<td>Duffy and Hoon 1996a</td>
<td>Barrier designs</td>
<td>16</td>
</tr>
<tr>
<td>Caltrans, 1996</td>
<td>Duffy and Hoon 1996b</td>
<td>Barrier designs</td>
<td>25</td>
</tr>
<tr>
<td>Chung Cheng Institute of Technology, Taiwan, Protec Engineering, Japan, 1998</td>
<td>Hwu and Spang 1997</td>
<td>Barrier designs</td>
<td>Not defined</td>
</tr>
<tr>
<td>Laboratorio di Fisica Terrestre, Lugano-Trevano, Switzerland, 1998</td>
<td>Hoshida and Nomura 1998</td>
<td>Barrier designs</td>
<td>9</td>
</tr>
<tr>
<td>Chama Valley Productions, LLC, Chama, New Mexico, 1998</td>
<td>Andrew et al. 1998</td>
<td>Barrier designs</td>
<td>31</td>
</tr>
<tr>
<td>Caltrans, 1998</td>
<td>Duffy et al. 1998</td>
<td>Barrier designs</td>
<td>56</td>
</tr>
<tr>
<td>Caltrans, 2000</td>
<td>Duffy and Jones 2000</td>
<td>Barrier designs</td>
<td>25</td>
</tr>
<tr>
<td>Oregon DOT, 2001</td>
<td>Pierson et al. 2001</td>
<td>Define rockfall trajectories</td>
<td>11,250</td>
</tr>
<tr>
<td>Colorado DOT, 2004</td>
<td>Arndt et al. 2009</td>
<td>Define rockfall trajectories</td>
<td>10</td>
</tr>
<tr>
<td>Dept. of Civil and Environmental Engineering and Architecture, Università degli Studi di Parma, Italy, 2003</td>
<td>Giani et al. 2004</td>
<td>Define rockfall trajectories</td>
<td>83</td>
</tr>
<tr>
<td>Colorado DOT, 2005</td>
<td>Arndt et al. 2009</td>
<td>Barrier designs</td>
<td>7</td>
</tr>
<tr>
<td>Cemagref Grenoble, St. Martin d'Hères, France, 2005</td>
<td>Dorren, Berger, Le Hir, et al. 2006; Dorren, Berger, and Putters 2006</td>
<td>Define rockfall trajectories; evaluate the influence of trees</td>
<td>202</td>
</tr>
<tr>
<td>Caltrans, 2006</td>
<td>Whitman and Duffy 2006</td>
<td>Define rockfall trajectories</td>
<td>56</td>
</tr>
<tr>
<td>IGOR, Inc., Trento, Italy, 2007</td>
<td>Badger et al. 2008</td>
<td>Barrier designs</td>
<td>3</td>
</tr>
<tr>
<td>Colorado DOT, 2009</td>
<td>Arndt et al. 2009</td>
<td>Barrier designs</td>
<td>10</td>
</tr>
<tr>
<td>Caltrans, 2009</td>
<td>Salisbury et al. 2009</td>
<td>Define rockfall trajectories</td>
<td>70</td>
</tr>
</tbody>
</table>
Figure 2.6: Rockfall and design parameters from Ritchie (1963)
Top: Original ditch design recommendations from Ritchie (1963) (left) and the later design chart based on this (FHWA 1989). Bottom: Rockfall motion and design parameters from Ritchie (1963).

different geometries, and they used a suite of at least 250 rocks per test. Between these two sets of experiments, they rolled upwards of 14,000 rocks. Rock sizes included 100 rocks approximately
0.3 m in diameter, 75 rocks approximately 0.6 m in diameter, and 75 rocks approximately 0.9 m in diameter. For each rock drop, the data obtained were the first impact with the ground from the base of the rock face as well as the furthest distance the rock traveled from the rock face (roll out or runout distance). These experiments were used to build upon the initial design charts of Ritchie (1963) in a published Rockfall Catchment Area Design Guide (Figure 2.7) (Pierson et al., 2001), which also includes all of the rockfall data obtained by these experiments.

Wyllie (2015) discusses an experiment conducted in 2003 by researchers in Ehime, Japan, at a 42 m tall slope comprising a 26 m tall, 44 degree rock face and a 16 m, 35 degree talus slope.
The test rocks included boulders as well as concrete spheres and cubes containing 3-axis accelerometers, and rock motion was captured with high-frame-rate cameras. They show rotational velocity increasing as the rock falls down the steep slope and then varying dependent on the impact angle as it bounces down the talus slope. For all shapes, rotational velocities were found to be between 350 degrees per second (dps) and 1900 dps, with the irregularly-shaped boulders averaging approximately 300 dps slower than the smooth concrete blocks. This is shown in Figure 2.8, which shows measured rotational velocities plotted against the height of the fall (Ushiro et al., 2006; Wyllie, 2015).

In 2009, a team from the California Department of Transportation (Caltrans) hiked to a portion of San Gabriel Canyon Road (State Highway 39), northeast of Los Angeles, that has been closed for decades due to rockfall hazards. They dropped 70 rocks by prying loose existing blocks
weighing 136 to 1360 kg down slopes with angles between 45 and 55 degrees, such as the slope shown in Figure 2.9. They measured the duration of the fall, the impact point, and the runout distance. They also obtained survey data and a 3D scan of the slope using lidar, and they filmed every rock drop from at least 2 angles for 3D trajectory analysis. They found that the slope terrain controlled the rock velocities and trajectories more strongly than the size of the rocks rolled, with little difference between the landing positions of rocks of various sizes. The data are being used to design rockfall mitigation systems for unstable slopes on the closed highway, in order to reopen the road in the future (Markham, 2010; Salisbury and Choi, 2012), but no final results have been published as of early 2018.

In 2018, the Swiss Federal Institute for Forest, Snow, and Landscape Research (WSL Institute) published an extensive dataset detailing results from more than 100 experimental rockfalls with instrumented test rocks of different shapes. They used a 50 m tall grassy and rocky slope with a maximum angle of 42 degrees (Caviezel and Gerber, 2018). Test rocks weighed between 30 and 80 kg and included both natural rocks and artificial concrete blocks (Caviezel et
al., 2018b). The data are available for download online (Caviezel et al., 2018a). The representative measurements of acceleration and rotational velocity they report have maximums ranging from 75 g to 200 g and 2500 dps to 4500 dps, respectively. Figure 2.10 shows rotational velocities from their tests using rocks with compact elongated (a) and compact bladed (b) shapes. Here, it can be observed that the compact bladed rock is primarily rotating around its X axis, while the compact elongated rock rotates around at least 2 axes (Caviezel et al., 2018b).

These experiments were performed for comparison to and calibration of digital rockfall models developed in their 3D modeling software RAMMS (Caviezel et al., 2018b).

![Gyroscope Data](image)

Figure 2.10: Rotational velocity results from Caviezel et al. (2018b)

a) A compact elongated rock, showing rotation around the X and Z axes

b) A compact bladed rock, showing rotation primarily around the X axis.

### 2.4 Rockfall Modeling

Large scale rockfall experiments require time and resources not often available. While ditches are often designed based on empirically-determined criteria (Ritchie, 1963; Pierson et al., 2001), as technologies have advanced, computer-based trajectory models have become a standard tool for rockfall assessment and barrier design (Wyllie, 2015).
Until the early 2000s, modeling rockfall down a slope has been conducted using two dimensional (2D) models of representative slope profiles (Figure 2.11). Programs such as the Colorado Rockfall Simulation Program (CRSP), available from the Colorado Geological Survey, and RocFall from RocScience use the Newtonian laws of motion and acceleration due to gravity to predict the motion and related velocities and energies of falling rock.

Figure 2.11: 2D and 3D trajectory models.
A 2D rockfall trajectory model as part of Geobrugg's barrier design process (left, from Hess et al., 2010), and a 3-D analysis of a spherical falling rock conducted in RAMMS (right, after Arpin and Arndt, 2016).

Three dimensional (3D) rockfall models have been available since the late 1980s (Guzzetti et al. 2002; Lan et al., 2007; Turner and Duffy, 2012b). However, these are designed for and typically applied at larger scales (Guzzetti et al., 2002). Examples of these models include multiple kilometer stretches of railway in Canada (Lan et al., 2007, Lan et al., 2010) and roadway in Malaysia (Fanos et al., 2016), a 20 km² valley in Italy (Guzzetti et al., 2002), and large areas around Christchurch, New Zealand (Geovert, 2012, Heron et al., 2014). These programs use geospatial elevation data, typically digital elevation models (DEMs), to model terrain (Crosta et al., 2015). Many software options exist, such as CRSP-3D from the Federal Highway Administration and
RAMMS from the WSL Institute, but as of 2018 no single 3D modeling software appears to be recognized as an industry standard.

In general, 3D models are considered “more rigorous” than 2D models (Arpin and Arndt, 2016). Because rocks move in 3D space, the slope profiles used in 2D modeling may not accurately capture the actual path of the falling rocks. Wyllie (2015) states that 2D modeled trajectories tend to predict higher bounce heights than are actually observed, leading to over-designed protective systems. Pierson et al. (2001) recognized that 2D modeling may over- or underestimate runout distances. However, as part of a study that included nearly 3,000 experimental rockfalls, they also concluded that 2D simulations are sufficiently comparable to experimental data to be useful as a design tool.

Arpin and Arndt (2010) concluded, in a comparison of 2D and 3D models, that benefits and limitations exist for each model type. As shown in Table 2.2, they compared rockfall velocities of two rock shapes modeled with the 2D program CRSP-2D and the 3D programs CRSP-3D and RAMMS. The average velocities from the two 3D programs are comparable for the spherical shape, while the 2D program predicts slightly faster average velocities. The maximum velocities are similar for the CRSP-2D and 3D programs and much lower than the RAMMS output. The results vary significantly for the block shape, and the CRSP-3D results for the block were excluded because the numbers were deemed unreasonable.

For modeled rockfall energy and bounce height, Arpin and Arndt (2010) found that the average energies and heights were comparable between the CRSP-2D and the 3D RAMMS programs for a spherical shape, but the maximum values were very different, and CRSP-3D results were again excluded due to unreliability. The RAMMS 3D model produced both higher energies and bounce heights than the 2D model for the block shape. The higher maximum values from the
RAMMs output in all of the measured parameters are due to a single modeled trajectory that launched from a 3D feature of the slope. This demonstrates the ability of 3D models to capture slope features that may be missed in a 2D slope profile. Arpin and Arndt (2010) concluded that the 2D results were no less reliable than the 3D results, despite the relative simplicity of the models, and that site-specific model calibrations and modeled rock geometries were the most significant influences on model reliability.

Table 2.2: Rockfall velocities modeled using three modeling programs (from Arpin and Arndt, 2010).

<table>
<thead>
<tr>
<th>Program</th>
<th>Rock</th>
<th>Rocks Passing Analysis Point</th>
<th>Avg. Velocity (ft/s)</th>
<th>Max. Velocity (ft/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRSP-2D</td>
<td>Sphere</td>
<td>96</td>
<td>56.7</td>
<td>17.3</td>
</tr>
<tr>
<td>CRSP-3D</td>
<td>Sphere</td>
<td>79</td>
<td>38.1</td>
<td>11.6</td>
</tr>
<tr>
<td>RAMMS</td>
<td>Sphere</td>
<td>97</td>
<td>41.2</td>
<td>12.6</td>
</tr>
<tr>
<td>CRSP-2D</td>
<td>Block</td>
<td>94</td>
<td>54.3</td>
<td>16.5</td>
</tr>
<tr>
<td>RAMMS</td>
<td>Block</td>
<td>27</td>
<td>81.6</td>
<td>24.9</td>
</tr>
</tbody>
</table>

2D modeling software is readily available, relatively inexpensive or even free (CRSP-2D), and requires significantly less data and software expertise to run than GIS-based models. With calibration using site-specific model parameters, they have been found to be sufficiently accurate for structural design (Turner and Duffy, 2012b). 2D models are still used to calculate rockfall velocities and energies even when 3D modeling is performed (Geovert, 2012, Heron et al., 2014), and programs such as RocFall and CRSP are still commonly in use by state Departments of Transportation and researchers (Kemeny, 2015; Thomas, 2018; Turner and Duffy, 2012b).

Natural rockfall occurs on heterogeneous slopes with complex topography. The assumptions necessary to mathematically model a falling, bouncing, sliding object greatly simplify the system. All modeling methods should ideally be calibrated with observed and experimental data from the area of interest to best represent realistic scenarios. However, this is often not possible, due to the limited accessibility of hazardous slopes and busy transportation pathways,
potentially very large areas of interest, and time and funding constraints. Therefore, assumptions regarding rock and slope properties are often made based on existing experimental data from other researchers at other sites. 2D rockfall modeling requires a representative 2D elevation profile of the slope of interest, information on the slope materials and their ability to absorb energy during impact, and the mass of the rocks to be modeled.

2.5 Surface Elevation Models

Rockfall modeling software uses a digital 2D or 3D representation of the slope of interest. 2D modeling requires a 2D profile or cross-section representative of the slope. These can be as simple as a few points created from data sources such as construction cross-sections drawn by a surveyor, or from known measurements of the slope height and angle (Figure 2.6, Figure 2.12). In many published studies, detailed profiles may be extracted from 3D data sets such as photogrammetry, terrestrial lidar data or laser scanning, or digital elevation models (DEMs) (Dadashzadeh et al., 2014; Heron et al., 2014; Kemeny, 2015; Turner and Duffy, 2012b).

2.5.1 Survey Data and Manual Measurements

Prior to and during any construction project, surveying is conducted to properly site and build the project. For a roadway, survey stations are typically located every 100 ft (30.48 m), and cross-sections of the roadway are developed at each station or half station (Ghilani and Wolf, 2012). Therefore, these cross-sections are available at regular intervals and are expected to be correctly scaled and placed in 2D space. An example is shown in Figure 2.12. However, they are two dimensional and dependent on a limited number of ground control positions that the surveyor can easily access. Therefore, they may neglect irregularities on inaccessible rock slopes, including near-vertical or overhanging rock faces.
2.5.2 Lidar

Light detection and ranging, or lidar, is a remote sensing technique that uses laser pulses to map an area or object of interest. An instrument is either mounted on a stationary base (terrestrial lidar) or placed in an airborne vehicle such as an airplane, helicopter, or drone. The instrument includes a laser scanner, ideally accompanied by a precise global positioning system (GPS) receiver to obtain location data, an inertial measurement unit for orientation, and a precise clock. A lidar unit records the time necessary to emit a pulse of light and receive the reflections (“returns”) off the object or surface, and using the constant speed of light, calculates the distance to the reflector as seen in Figure 2.13. With the position of the scanner known, a 3D map of the object or surface can be generated as a “point cloud” of (X, Y, Z) data points, with each point representing the 3D location that reflected the return. While there must be a direct path between the scanner and its target, lidar is not entirely restricted to classic “line of sight” data such as photography. It does not require specific light conditions, and the laser pulses can penetrate small...
gaps in vegetation well enough to obtain reflections from the ground. Using the timing of the returns, vegetation and other obstacles can be distinguished from the ground surface (GISGeography, 2018).

Terrestrial or ground-based lidar, also called laser scanning, uses a stationary scanner such as the one shown in Figure 2.13. This is the least-expensive form of lidar and the most frequently used for the study of rock slopes. Since terrestrial lidar can output data with millimeter to centimeter resolution, this is the “gold standard” for imaging rock slopes. It is often used for generating slope profiles for modeling, performing structural and stability analysis, or for conducting change detection studies. Only one rock cut in NH has terrestrial lidar available: cut number 4 at Barron Mountain in Woodstock, NH. It was scanned as part of a Pooled Fund Study investigating the use of 3D terrestrial lidar for rock slope assessment (Kemeny, 2015).

Interpreted aerial lidar data is often readily available, though typically the resolution of the data products is much coarser than that possible using a terrestrial laser scanner. Lidar point clouds
comprise millions of points that require interpretation to effectively use. Therefore, one of the most widely used products of aerial lidar are bare-earth digital elevation models (DEM): surfaces interpolated from point clouds from which vegetation and structures have been removed, leaving a model of the ground surface. These are raster data sets, composed of uniformly-sized grid cells given a single elevation value per cell. As recently as 2012, many DEM rasters were restricted to a 30 m by 30 m cell size (30 m resolution). However, projects such as the United States Geological Survey’s (USGS) 3D Elevation Program (3DEP) have been making updated elevation data acquired from lidar freely available. 3DEP intends to acquire 3D lidar data at a resolution of less than 1 m for the entirety of the United States, except Alaska, by 2022 (Carswell, 2015).

While the elevations of original lidar data points are often accurate to within 20 cm (GRANIT, 2017), the limited horizontal resolution means that DEM elevation may be averaged across several meters. However, DEMs provide extensive elevation data, and are one of the most common inputs for 3D rockfall models (Crosta et al., 2015). DEMs are freely available for the majority of NH at horizontal resolutions of 2 m to 0.7 m or less, as seen in Figure 2.14. Using specialty software, DEMs or original lidar point clouds can also be used to create meshes or triangular irregular networks (TINs), types of surface models that can incorporate irregularly spaced points and multiple elevation values at a given (X, Y) location, unlike rasters. These can better model a vertical or overhanging surface than DEMs. A comparison of DEM data, a TIN, and a terrestrial lidar data set from a rock cut in Woodstock, NH is shown in Figure 2.15. Here, the DEM in (a) averages elevations over a larger area than the TIN in (b), leading to a smoother surface. Both of these model a much larger area than the terrestrial lidar in (c) and (d), but show much less detail.
Figure 2.14: Availability of digital elevation models in New Hampshire
Figure 2.15: Differences in data resolution for various surface models. The Barron Mountain rock cut in Woodstock, NH, I-93 north is visible in the foreground in a) and b). a) 1 m digital elevation model b) triangular irregular network from aerial lidar point cloud c) terrestrial lidar point cloud and d) close up of terrestrial lidar detail. Black box on a) and b) shows the approximate location of c). Terrestrial data courtesy of the University of Arizona and NHDOT; DEM/aerial data from NH GRANIT.

2.5.3 Photogrammetry and Structure-from-Motion

Photogrammetry is a long-known technique for developing a 3D representation from overlapping 2D images. A photogrammetry technique called Structure-from-Motion (SfM) uses automatic, iterative feature matching between photographs to develop a 3D model. The process does not require the location of the camera or control points to be known to reconstruct a model, unlike traditional photogrammetry techniques, though this information is required in order to properly scale the model or to map it to the correct geographic location (Westoby et al., 2012). Because photogrammetry relies on images, data acquisition is limited to line-of-sight, and so unlike lidar, this technique cannot “see” underneath vegetation that might hide slope features.
However, basic SfM can be accomplished with nothing more than a camera and freely-available software (freeware) and is therefore much less expensive and easier to obtain than lidar data. Recently unmanned aerial systems (UAS, commonly called drones) have become popular vehicles for obtaining images for SfM.

SfM models are now available for several rock cuts in NH. SfM using aerial images was performed for a section of Interstate 93 (I-93) in Londonderry, NH by GPI and the NHDOT, which captured rock cuts along highway exit 4. However, this was not the primary purpose of the survey and therefore the rock cut data have gaps. In 2017, a drone flight was made by the NHDOT working with the University of Vermont to obtain data for rock cut 110 at Hart’s Location, NH, an A-rated rock cut with the highest hazard rating in the state. Figure 2.16 shows the photogrammetry point cloud created to model this cut. Another A-rated cut in Warner, NH and newly blasted rock cuts along I-93 in Derry have had SfM models created using a digital camera by Neil Olson at the NHDOT. Appendix A presents a methodology for SfM using standard camera pictures and freeware, which was created during January 2018 for the NHDOT and was also used for this thesis work.

Figure 2.16: A SfM point cloud of rock cut 110 at Crawford Notch, Hart's Location, NH. The northbound travel lane in the foreground is approximately 5 m wide and blocked by orange traffic cones.
2.5.4 Data Resolution

Data resolution can make a significant difference in a rockfall model. Crosta et al. (2015) present a comparison of 3D rockfall runout models performed with DEMs of varying resolutions created from aerial lidar data. An example is shown in Figure 2.17. Here, the topography shown by the 2 m resolution DEM leads to the modeled rock trajectories covering a wider geographic area than the smoother 20 m resolution DEM. Rockfall software packages often have tools or parameters to add variation to a low-resolution surface model in order to better simulate true conditions, but as the resolution, and therefore the surface roughness, of the modeled slope increase, these become unnecessary (Crosta et al., 2015). Different data sources have varying resolutions, which may be more or less applicable depending on the project goals. For modeling a large 3D area, the 2 m resolution DEM shown in Figure 2.17 is very good resolution. For a highway scale rock cut, terrestrial lidar is considered ideal, because it can include centimeter-scale slope detail.

![Figure 2.17: A 3D runout model using two data resolutions. After Crosta et al. (2015)](image)
2.6 Smart Rock

Rockfall modeling relies on calculations based on assumed surface and rock parameters. Even data derived from rockfall experiments typically require video analysis and back-calculation of slope properties from field measurements. In the last decade, a number of universities and research groups world-wide, including the University of New Hampshire (UNH), have developed sensors contained in sealed protective containers with the capability of measuring movement of soil or rock particles. These instruments are intended to investigate and monitor soil and rock movement from the interior of a slope failure event. UNH began development of a “Smart Rock” in the 2000s, and continued improvements have produced a small, autonomous instrument with the capability of monitoring the movement of a rock during rockfall (Apostolov, 2016, Gullison, 2013, Harding et al., 2014).

Others have instrumented rocks to measure rockfall parameters. Ushiro et al., (2006) have used 3-axis accelerometers embedded in rocks and concrete blocks to measure and describe rotational velocities and rockfall motion (reported in Wyllie, 2015). Apostolov (2016) includes a thorough discussion of the types of instruments in use at other universities. As of 2018, researchers at the WSL Institute for Snow and Avalanche Research in Switzerland are using a combination of accelerometers and gyroscopes in a device termed “StoneNode” to study the effects of rock shape on rockfall trajectories as well as the deceleration of falling and rolling rocks during impact with a slope. Their purpose is to obtain better calibration data for their 3D modeling software RAMMS. Only preliminary results have been reported, but they discuss the timing of ground impacts and the accelerations and rotational velocities measured. Maximum accelerations reported during impacts range between 34 g and 139 g over time intervals of anywhere from 8 to 75 ms. Rotational velocity values reported vary from 683 dps to 4709 dps, with the observation that these change
with every impact between the rock and the slope. An interesting outcome of this preliminary research, relating to rockfall, is the conclusion reached by the authors that the coefficients of restitution used by most modeling programs overly simplify the complex rock-slope interactions (Caviezel and Gerber, 2018).

UNH’s Smart Rocks (SR) were originally developed with the goal of tracking the position of soil particles during debris flow flume experiments in order to better understand the behavior of soil during mass wasting. The first SR was developed by Harding (2011) and tested by Gullison (2013). The sensors in this instrument included a 3-axis accelerometer, a 3-axis gyroscope, and two pore pressure sensors, in order to collect acceleration, rotation, and pore water pressure data. Data was written to a micro SD card for easy access and processing. The acceleration and rotation data were shown to describe the motion of the SR within a debris flow. However, the signal noise in the sensors and the lack of a fixed reference frame for the SR introduced large error into the calculations of velocity and position of the instrument (Harding, 2011), making accurate location data impossible to obtain. Pore water pressure measurements during motion were also unreliable, due to the fluctuating environment of the SR during flow (Apostolov, 2016; Harding et al., 2014).

The second generation of the SR, developed by Cassidy (2013), was smaller in size than the first. Because measuring position was unsuccessful, the inertial measurement unit originally included in the SR for location measurement was excluded, leaving the accelerometer, pressure sensor, and a temperature sensor. All data was written to a micro SD card.

The third generation SR was developed by Apostolov (2016). It contains a ±16 g 3-axis accelerometer, a ±2000 dps gyroscope, and a digital magnetometer, and like previous models, data is written to a micro SD card. Continued development of this SR has produced a version suited for rockfall experiments, shown inside its protective shell in Figure 2.18. This measures 3D
acceleration at ±400 g and ±16 g and rotational velocity to ±4000 dps (Apostolov, 2016; Apostolov and Benoît, 2017).

![Smart Rock](image)

Figure 2.18: The rockfall Smart Rock, showing the orientation of the internal instrument axes.

### 2.7 Summary

Where roadways cut through rock, rockfall is a concern. Experimental rockfalls and 2D and 3D rockfall modeling are standard methods of assessing rockfall hazards. New Hampshire has approximately 375 rock cuts that are monitored for hazards, and 2D rockfall modeling could be an additional tool alongside the existing RHRS to help recognize hazards and prioritize remediation. Ideal high resolution surface data, such as terrestrial lidar, are scarce in New Hampshire, but lower-resolution DEMs are widely available. These are commonly used for rockfall modeling over large areas, but could be an option for modeling rock cuts in New Hampshire.

Field measurements and high-frame-rate video are standard components of rockfall experiments, but more recently, researchers have begun to instrument the rocks themselves to measure acceleration and rotation from the point of view of the falling rock. The University of New Hampshire has developed a Smart Rock that can be used for measurement of acceleration and rotational velocity during rockfall and validation of rockfall models.
3 ROCKFALL MODELING

Few rock cuts in New Hampshire have high resolution data sets, such as terrestrial lidar or photogrammetry models, to use for rockfall modeling. One objective of this research was to investigate whether lower-resolution digital elevation models (DEMs) might be suitable for basic rockfall modeling, since they are readily available for most of the state as previously shown in Figure 2.14. Two rock cuts with both high resolution data and DEMs were used for 2D rockfall modeling to compare the effects of differing surface models on rockfall runout. Rock cut 64 at I-93 Exit 4 in Londonderry, NH, has surveyed cross-sections, a structure-from-motion (SfM) model created from professional photogrammetry, and a 2 m resolution DEM with which to create slope profiles. Rock cut 4, through the side of Barron Mountain along I-93 North in Woodstock, NH, is the only rock cut in the state that has terrestrial lidar available to compare to a 1 m resolution DEM.

3.1 Rockfall Model Parameters

Rockfall motion is governed by physics. The motion of a falling rock can be any combination of falling, bouncing, rolling, and sliding. A full discussion of the mathematics used to model the motion of a falling rock is not included here, but the reader is referred to Wyllie (2015) and Turner and Duffy (2012a) for comprehensive explanations of rockfall mechanics.

The mass of the falling rock block, the slope geometry, and the material of the slope and rock are extremely important in modeling rockfall. The mass and velocity of the rock define its translational kinetic energy. When a rock impacts the slope, some velocity, and therefore energy, is lost. This loss of velocity and energy is accounted for in 2D modeling software by the
coefficients of restitution and friction assumed for each of the different materials composing the slope (Ashayer, 2007; Wyllie, 2015; Turner and Duffy, 2012a). Coefficients of restitution are ratios of velocity or energy before and after impact, and range in value from 0 to 1. A perfectly elastic surface that absorbs no energy will have a value of 1, and a surface that stops the motion of whatever impacts it will have a value of 0. Coefficients of friction are related to the friction angle of the surface material.

Two analysis methods are commonly used to model rockfall: “lumped mass” and “rigid body” trajectory models. In a lumped mass model, the falling rock is represented as a very small, spherical, dimensionless point. Normal and tangential coefficients of restitution developed based on velocity ratios are used in the analysis, as is the dynamic friction angle \( \varphi \). The normal and tangential coefficients of restitution (\( R_N \) and \( R_T \), respectively) are the ratio of the rebound (final) velocity normal or tangential to the slope (\( v_f \)) to the impact (initial) velocity normal or tangential to the slope (\( v_i \)) (Ashayer, 2007; Wyllie, 2015; Turner and Duffy, 2012a), as shown in Figure 3.1 and equations 1 and 2:

![Figure 3.1: Velocities before and after a rock impacts a slope. After Wyllie (2015).](image-url)
\[ R_N = - \frac{v_{fN}}{v_{iN}} \]  
\[ R_T = \frac{v_{fT}}{v_{iT}} \]  

Equation 1 is negative because the final normal velocity is in the opposite direction of the initial velocity (RocScience, 2017a).

In a rigid body model, the geometry of the falling rock is included in the analysis, and the coefficient of restitution is developed from energy ratios. Total kinetic energy (KE) is calculated using the equation:

\[ KE = \frac{1}{2} (mv^2 + I\omega^2) \]  

where \( m \) is the mass of the rock, \( v \) is velocity, \( I \) is the moment of inertia of the rock, and \( \omega \) is the rotational (angular) velocity. The total energy coefficient of restitution \( (R_E) \) is the ratio of the final \((f)\) to initial \((i)\) total kinetic energies of the falling rock, as shown in equation 4 (Ashayer, 2007, Wyllie, 2015, Turner and Duffy, 2012a):

\[ R_E = \frac{KE_f}{KE_i} = \frac{\frac{1}{2}(mv_f^2 + I\omega_f^2)}{\frac{1}{2}(mv_i^2 + I\omega_i^2)} \]  

This coefficient can be estimated experimentally using ratios of bounce heights off a surface of interest, as shown in equation 5 (Ashayer, 2007; Basson et al., 2013):

\[ R_E = \frac{h_1}{\sqrt{h_0}} \]  

where \( h_0 \) is the initial drop height of the falling object and \( h_1 \) is the rebound bounce height (Figure 3.2).
The dynamic friction coefficient ($\mu$) and rolling friction coefficient ($\mu_r$) are also important parameters in a rigid body rockfall model, describing the frictional forces between a sliding or a rolling object, respectively (Chai et al., 2013; Dadeshzadeh et al., 2014; RocScience, 2017a). $\mu$ is the tangent of the friction angle $\varphi$ (Chai et al., 2013). In the 2D modeling software used in this research, RocFall, $R_T$ is only used in a rigid body model if the option “Use Tangential CRSP Damping” is chosen in the model parameters, which applies a method of incorporating $R_T$ from the Colorado Rockfall Simulation Program (CRSP). Otherwise, both friction coefficients control the loss of energy in the direction tangential to the slope (RocScience, 2017a).

The coefficients of restitution chosen for a rockfall model define the energy absorbed when a rock hits the slope, and therefore its rebound velocity. This affects bounce heights, translational and rotational energies and velocities, and ultimately the calculated rock paths. Therefore, the choice of coefficients of restitution for modeling the slope has very significant effects on the results and is one of the most critical factors in the model. Calibrating models against actual experimental data or site conditions is recommended to ensure more accurate results (Bar et al., 2016; Dadeshzadeh et al., 2014; Turner and Duffy, 2012b), though Bar et al. (2016) note the decreased
use of calibration against field data in more recent trajectory modeling investigations. They do not comment on any implications, positive or negative, of this trend.

A table of published coefficients of restitution, originally developed by Heidenreich (2004) and reprinted by Ashayer (2007) and Turner and Duffy (2012a), is included in Appendix B. A similar table of lumped mass coefficients is available from RocScience.com (RocScience, 2017b). All coefficients used in this research are drawn from these tables, unless stated otherwise. Though the coefficients of restitution used in lumped mass and rigid body analyses are developed differently, work by Ashayer (2007) and Dadeshzadeh et al. (2014) indicate that values of $R_N$ and $R_E$ can be similar. Ashayer (2007) describes $R_E$ and $R_N$ as “comparable.” In a comparison of lumped mass and rigid body modeling, Dadashzadeh et al. (2014) separately calibrated lumped mass and rigid body models against end points and bounce heights from recorded field tests to obtain site-specific restitution coefficients. The normal coefficients of restitution that they derived from back analysis, equivalent to $R_N$ for lumped mass analysis and $R_E$ for rigid body analysis, were the same for both methods and varied only by material type: 0.53 for “clean hard bedrock” and 0.224 for vegetated talus. Their friction parameters $\phi$ and $\mu$ were equivalent between the two analysis methods, where $\mu$ is the tangent of $\phi$, and tangential restitution for talus was decreased by 0.11 in the rigid body model. In Appendix B, the values for $R_E$ tend to be slightly higher than $R_N$ values for similar material; for example, 0.35-0.45 for soft earth instead of $R_N$ values of 0.28-0.32.

Both analysis methods have been proven to provide reasonable results with calibrated models. Lumped mass mechanics are simpler to model and require easier calculations than rigid body mechanics and so have been traditionally used. In their comparison study, Dadashzadeh et al. (2014) found that the shape and size of a rock block significantly affects its bounce heights and
runout length during rockfall, and that particularly with large rocks, the results of rigid body models diverge from those of lumped mass models. A comparison of trajectories from two of their models is shown in Figure 3.3, where it can be seen that the rigid body model (b) produces more bouncing, higher bounce heights, and longer runout distances for this slope, compared to the more uniform trajectories predicted by the lumped mass model in (a) (Dadashzadeh et al., 2014). Rigid body analysis is considered more reliable and more conservative. As computational power has increased, making rigid body calculations easier, rigid body analysis has come into more common use (Ashayer, 2007; Chai et al., 2013; Dadashzadeh et al.; 2014, Turner and Duffy, 2012a).

![Figure 3.3: Trajectories from lumped mass (a) and rigid body (b) rockfall simulations. This shows the effect of shape on rock trajectory. (From Dadashzadeh et al., 2014).](image)

### 3.2 RocFall 6.0 Software

Rock cuts and rockfalls for this project were modeled using RocFall 6.0 from RocScience. The program allows a slope to be modeled using 2D (X, Y) coordinates, where X corresponds to the lateral direction and Y corresponds to the slope elevation. Each section of the slope between these vertices is given material properties comprising coefficients of restitution and coefficients of friction. The exact parameters used in each model differ with the selection of lumped mass or rigid
body mechanics. These coefficients are also typically given a standard deviation and normal distribution bounded by ±3 times the standard deviation. This variability in the coefficients of restitution, coupled with potential variance in the specified rock, is used to produce realistic, variable trajectories. Without variation in the slope or rock material, and the rock initial orientation when using a rigid body model, the mathematically-defined trajectory is identical for all simulations. As rock and soil are not homogeneous, it is realistic to expect variation in the material properties.

Rocks can be designed in RocFall by specifying the density and mass of the rock. These can also be given a statistical distribution if desired. If the rigid body analysis method is used, the shape of the rock is also defined. Default shapes included in the program include polygons with sharp or rounded corners, such as spheres, squares, rectangles, triangles, and ellipses of varying proportions. The actual size of the rock is calculated based on the unit shape and the assigned mass and density. A “seeder,” or starting rock location, is placed on the slope, and one or more rock models are chosen to be dropped from that seeder. A total number of rockfall simulations is assigned to each seeder.

The output used from the RocFall software in this research includes “rock path end points.” This term refers to the ending locations of the rock trajectories, which may include rocks that bounce backward from their impact point. While this is distinct from maximum rock runout, the farthest distance that a rock moves from the base of the rock slope, end points are used as a proxy for runout in this research. The RocFall outputs are histograms giving the number of rocks that end their trajectory within specified intervals on the slope, which are labeled by the interval midpoint. The size of the intervals is defined by the length of the modeled slope data divided by the number of bins chosen by the user. For this research, bins were typically chosen to group rock
path end locations into approximately 1 m intervals. Because of the histogram format, all end path locations presented are estimated.

Other parameters that may be included in rockfall simulations using the RocFall software are variations in slope roughness, damping due to forested slopes or vegetation, and scarring of the slope as a rock falls, which changes the friction coefficients. Though a rock cannot be simulated to break up upon impact in the rockfall software, the coefficients of restitution account for some possible energy loss in this scenario, and the scarring tool could as well. An available option is also a “line seeder” that starts multiple rocks from a distribution of locations, which may be used to simulate the trajectories of a broken rock. This was not used in this research, in order to better compare modeled results to the single rocks used for Smart Rock experiments. Vegetation damping and scarring were excluded from the models in this research under the assumption that the rock cuts modeled are predominantly bare rock faces, and neither are applicable. Slope roughness variation is an important aspect of predictive modeling, however, particularly in 2D, to account for differences in a rockfall path that are not captured in a single 2D profile (Crosta et al., 2015). This was included in two models using DEM profiles to compare to results from the original and higher-resolution slope models.

The slope roughness parameter in RocFall varies the slope profile randomly between data vertices with spacing and amplitude limits defined by the user. In a rigid body model, this tool creates a slightly different slope for each simulated rock. Figure 3.4 shows an example of this variation in a DEM cross-section of a rock cut in Londonderry, NH. The randomized changes add variation below the resolution of the actual data. In this research, the profiles of interest are well characterized by images and high-resolution data and comparisons are made assuming this location is the single rockfall path. Varying slope roughness in a low resolution data set might simulate
some of the irregularity of a higher resolution data set. A second method of introducing slope variation in the RocFall software is to include a standard deviation with the slope coordinates, which was not used in this research.

![Figure 3.4: An example of a slope profile with slope roughness varied from the original slope. The DEM profile from Londonderry, NH Station 912+00 is shown by a thin line. The varied profile is a thicker line offset from the original smooth slope.](image)

### 3.3 Locations and Data Processing

Rock cuts were chosen for preliminary rockfall modeling based on the availability of data with which to develop multiple surface elevation models.

#### 3.3.1 Rock Cut 64, Londonderry, NH

Rock cut 64 is a C-rated cut that forms the highway on-ramp to I-93 at exit 4, as shown in Figure 3.5 (NHDOT, 2018). Multiple surface models are available for this location, but no experimental data exists. Construction plans for NH project number 14633D are available as part of the I-93 Salem-Manchester corridor widening, which include surveyed cross-sections for every survey station in the contract area (NHDOT, 2016). A 2 m resolution DEM is also available for this location from NH GRANIT, the GIS database for NH at [www.granit.unh.edu](http://www.granit.unh.edu) (GRANIT Lidar...
A third source of data is a 3D photogrammetry point cloud and a photomosaic from an aerial survey using an unmanned aerial system (UAS or drone) performed by the company GPI in March, 2017. The point cloud resolution on the rock face is approximately 1 point for every 3 cm. These data were made available to this project by the NHDOT and GPI.

Figure 3.5: Location of rock cut 64 along I-93 exit 4 southbound onramp. Left: the full extent of the UAS data available as an SfM model is shown in red, with the location of interest highlighted. Right: An image of the exit 4 southbound ramps from the UAS photography.

The locations of the survey cross-sections are shown in Figure 3.6. The rock cut of interest forms “walls” around the curving southbound on-ramp of I-93. It is 230 m long and 18 m high. The cross-sections used for this analysis were previously corrected by updated surveyed locations; prior versions had relied on outdated information that differed greatly from the actual slope. The DEM raster dataset was aligned with the construction plans using the software package ArcGIS, and cross-sectional profiles were interpolated from the raster using tools in the software.
The extent of the photogrammetry point cloud (also referred to as “UAS data”) is seen in Figure 3.5. The file was too large for use as received and was separated into sections using the open-source plugin LASTools for ArcGIS. The geotechnical 3D analysis software SplitFX was used to interpolate between the points in the point cloud to create a mesh surface model, as is previously described in section 2.5.2. This formed a 3D model of the surface, from which cross-sections were then extracted to match the locations of the survey station cross-sections of interest. Figure 3.7 shows the original point cloud (a) and the interpolated surface (b) from the Londonderry data. The image looks north across the highway exit at the tallest section of the rock cut. It can be seen that the data on the inside curve of the road, shown at the bottom of the picture, is only partially complete. Gaps in the data appear as light grey areas in both images.

![Figure 3.6: Locations of the survey stations and available cross-sections along the I-93 exit 4 southbound onramp. Cross-sections at stations 912+00 and 913+50 are modeled in this thesis.](image)
All of the cross-sections use local frames of reference in the horizontal (X) direction as opposed to real-world 3D coordinates. The survey data place the local horizontal “0” location at the inside curb of the road. This curb was identified on the cross-sections extracted from the DEM and UAS datasets, and both data sets were shifted to set the curb to the 0 m location. The UAS profile was shifted vertically to the known elevation at the curb to match the accurate elevations of the survey and DEM data sets. The three data sets were graphically compared for seven cross-sections to visualize the difference between standard and high-resolution data.

3.3.2 **Rock Cut 4, Barron Mountain, Woodstock, NH**

The Barron Mountain rock cut is an A-rated rock cut located in the I-93 corridor through Woodstock, New Hampshire, shown in Figure 3.8. The large rock face is 245 m long and 45 m high along the east side of I-93 North in Woodstock, and it failed during construction of the highway in 1972. It was subsequently stabilized by the NHDOT, and the stabilizing reinforcements were reassessed between 2003 and 2005 to confirm their continued effectiveness (Fishman, 2004). This is the only rock cut in NH that has terrestrial lidar data available, which was taken as part of a multi-state study on the use of terrestrial lidar for structural analysis of rock cuts (Kemeny, 2015).
Seven scans were performed in order to encompass the entire rock cut, and the corresponding seven point clouds were received and used as-is, including interpolated mesh surfaces from SplitFX project files. Point cloud 7 is shown in Figure 3.9, which also shows the cross-section modeled as part of this research. This section of the rock cut is shorter than the maximum rock cut height, but was chosen for modeling due to the overhanging rock at this location. A 1 m resolution DEM and the original aerial lidar point cloud were both available from NH GRANIT (GRANIT Lidar Distribution Site, 2017, White Mountain National Forest 2012 data set). Figure 3.10a and (b) show the classified point cloud and the DEM. The red box on this figure indicates the position of point cloud 7.

![Figure 3.8: Location of the Barron Mountain rock cut](image)
a) Reference map of New Hampshire  
b) Topographic map of the study area with 10m contours, with I-93 shown in red and the location of rock cut 4 circled in yellow.

The terrestrial lidar scans were not georeferenced to real world coordinates, so cross-sections were developed on the DEM using ArcGIS and visually matched to the corresponding
location in the high-resolution point clouds. When the aerial lidar point cloud was examined, it was found that many of the points classified as “high noise” fell spatially among the points classified as “ground.” A TIN was created using ArcGIS by interpolation using both sets of points, in order to investigate if the added points might capture more of the variation of the rock slope, and whether a TIN surface would provide a better representation of the near-vertical surfaces on the rock face than the DEM raster. The output surface is shown in Figure 3.10c. Cross-sections from this surface are compared to the other two data sets, but it is expected that the inclusion of noisy points creates error in the surface. This error is not well defined.

Figure 3.9: A terrestrial lidar scan from the Barron Mountain rock cut. The white line indicates the cross-section used to compare rockfall models, corresponding to section 7A from Kemeny (2015). Data courtesy of Dr. Kemeny, University of Arizona.
Figure 3.10: Surface models for Barron Mountain.
a) The classified aerial lidar point cloud showing points representing the ground in brown and grey and vegetation in green. b) The 1 m resolution bare-earth DEM derived from the point cloud. c) The TIN surface derived from the point cloud. Point cloud and DEM data courtesy of NH GRANIT.
3.3.1 Coefficients of Restitution

Because no experimental data are available for either Londonderry or Barron Mountain, coefficients of restitution were chosen for these models from the RocFall defaults and the Table of Coefficients by RocScience (2017b). Though the rock types differ at each location, they were modeled using the RocFall default “bedrock outcrops” set of coefficients. This is the only value programmed by default for rock, and the value of 0.35 provided is similar to other $R_N$ and $R_E$ values reported for outcropping rock, but it is lower than many describing “bedrock” that are between 0.5 and 0.9 (RocScience, 2017b; Turner and Duffy, 2012a). Coefficients approximating “Top soil with vegetation” were chosen from the Coefficients of Restitution table published by RocScience (2017b) to represent the grassy or vegetated catchments beneath the rock cuts. The value of 0.3 is very similar to other published $R_N$ values for talus or soft soil, which range generally from 0.28 to 0.32. The coefficients for asphalt that are included as a program default were used to approximate the road surface (Table 3.1).

<table>
<thead>
<tr>
<th>Color</th>
<th>Name</th>
<th>$R_N$</th>
<th>$R_T$</th>
<th>$\mu$</th>
<th>$\mu_e$</th>
<th>Source Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bedrock outcrops</td>
<td>0.35±0.04</td>
<td>0.85±0.04</td>
<td>0.55±0.04</td>
<td>0.15±0.04</td>
<td>RocScience</td>
<td></td>
</tr>
<tr>
<td>Top soil with vegetation</td>
<td>0.3±0.06</td>
<td>0.8±0.06</td>
<td>0.55</td>
<td>0.1</td>
<td>RocScience</td>
<td></td>
</tr>
<tr>
<td>Asphalt</td>
<td>0.4±0.04</td>
<td>0.9±0.03</td>
<td>0.55±0.04</td>
<td>0.1±0.01</td>
<td>RocScience</td>
<td></td>
</tr>
</tbody>
</table>

*Where coefficients or standard deviations did not accompany the main table entry, values were applied using program defaults.

The tangential coefficient of restitution $R_T$ is included in these models by use of the “Tangential CRSP Damping” feature. Experimentation with preliminary models showed greater agreement between lumped mass models and rigid body models when $R_T$ was applied. Because $R_T$ controls rebound velocity in the direction tangential to the slope, excluding $R_T$ from a rigid body model increases runout distances.
3.4 Rigid Body versus Lumped Mass Analysis: Rock Cut 64

3.4.1 Rock Model

To confirm the choice of computational analysis for use in later models, data from Londonderry, NH were used to examine the difference between lumped mass and rigid body models. Simulation results using a cross-section from the Londonderry UAS data are shown in Figure 3.11 and Figure 3.12, comparing lumped mass simulations to rigid body simulations. Two cases of the rigid body model are shown: the first considers “tangential damping,” or energy loss in the direction tangential to the slope as defined by the coefficient \( R_T \), and the second does not. \( R_N \) and \( \mu \) remain the same. Each case models 100 trajectories of a 50 kg square rock. The choice of 100 trajectories and 50 kg follows modeling performed by Kemeny (2015). The location used for this analysis, a comparison to other surface models, and details of model parameters are explored further in section 3.5.

3.4.2 Results

Rock motion is very different between lumped mass and rigid body analyses. In Figure 3.11, the lumped mass model (a) results in much more uniform trajectories than either of the rigid body models. Figure 3.12 shows that the distribution of end locations for the lumped mass model clusters in the catchment area; nearly 60 percent of simulated rocks stopped within a 3 m interval. Rigid body analysis produces a much more variable distribution of rock path end locations. The rigid body model including \( R_T \) predicts that 80 percent of the rocks will stop more quickly in the catchment area than the lumped mass model. However, in both of these analyses 100 percent of the rocks stopped at or before -8m, before the edge of the pavement. The rigid body model without tangential damping predicts that more than 30 percent of the rocks will reach the roadway. The
abrupt increase in the cumulative rocks stopped at 2 m in Figure 3.12 is an artifact of the slope limit imposed on the model; the trajectories in theory continue.

### Figure 3.11: Trajectories modeled using different analysis methods.

#### 3.4.3 Summary

The lumped mass model and the rigid body model accounting for $R_T$ produce similar runout distances for both surface models, despite varying distributions. Lumped mass modeling treats all modeled rocks as spheres with no actual size, but observation of failed blocks from multiple rock cuts in the field suggest that rocks falling from cuts are often blocks or slabs (Figure 2.2). A rigid body analysis that models a block is therefore more likely to simulate realistic rock motion, and so rigid body modeling including $R_T$ was performed for the remainder of the models described in this research work.
3.5 Surface Model Comparison

3.5.1 Rock Cut 64, Londonderry, NH

Two survey stations, 912+00 and 913+50, were chosen for rockfall modeling. In these locations the rock cut has an overhanging or vertical face, providing a test of how variations in the surface model used might affect rockfall simulations on a non-uniform slope. Cross-sections from the construction plans (surveyed data), the DEM, and the UAS photogrammetry data were compared for each station. 100 50 kg rocks were simulated for each profile. The rock density was left at the program default of 2700 kg/m$^3$ and the shape was set to a polygon square.

The western side of the rock cut at station 912+00 is shown in Figure 3.13. Profiles from each of the three surface models available for this station are compared in Figure 3.14. The rock cut at this location is 11 m high on the western side. These elevation profiles in general align, though some variation exists where features are uneven on the face of the rock slope. The overhang...
seen in Figure 3.13 is located at -17 m in Figure 3.14. This feature is below the resolution of the DEM or the survey cross-section, but can be seen in the UAS data (red). However, the photogrammetry model was developed from datasets acquired looking down from above, and therefore, it also does not accurately model the overhang visible in pictures. Instead, it is depicted as a near-vertical face.

Figure 3.13: Station 912+00, western side of the road.

Figure 3.14: Elevation profiles from different surface models at station 912+00.
The seeder location for all surface models was set to an elevation of 111 m, approximately 9 m above the road. Because of the differences in slope between models, this corresponded to a slightly different horizontal location in each simulation.

The profile output from the photogrammetry data had to be simplified before use in RocFall. The program requires that all points in the slope profile be a minimum of 0.001 length units apart; because the photogrammetry profile data was developed from an irregular interpolated mesh surface, the exported vertices did not all meet this requirement. Also, on this slope and others when using data with a high number of vertices, many simulated trajectories would end because the simulation time reached a preset maximum, because of “invalid intersections” between the shape and the slope, or because the inbuilt variation in the rock simulation started the rock at an invalid location, such as outside the limits of the slope data or crossing the slope boundary in a physically impossible manner. Ultimately, the slope was simplified to use 20 percent of the original points using a preset tool in RocFall. This was successful in preventing simulated rock trajectories from stopping for reasons other than reaching a calculated end point or reaching the far end of the model location, while maintaining the shape of the original data. A comparison of the original and simplified slope is shown in Figure 3.15. A similar effect might be possible by increasing the cell size of the interpolated surface mesh on the original 3D model, which would keep the resolution constant for all cross-sections extracted from the data set, but may obscure small surface features.

After initial models were created with the DEM data set, surface roughness variation was implemented using the default settings in RocFall. This was applied only to the rock face, with a variation spacing of 1 m and a maximum amplitude of ±0.6 m, which defines the variation from the original surface model. Due to the higher resolution of the photogrammetry data and its more
realistic slope model, the slope roughness parameter was not applied to this model, as it would introduce unrealistic variation.

Figure 3.15: Original and simplified slope data for Sta. 912+00.

Figure 3.16 and Figure 3.17 show simulated trajectories and rock path end locations for the three surface models at Station 912+00. Figure 3.18 summarizes the average and maximum ending locations for all models, overlain on the photogrammetry slope profile. Averages in Figure 3.18 do not include simulated rocks that remained on the rock face. Observation of the trajectories in Figure 3.16 shows that the surface model has a large influence on the motion of the rock as it moves down the slope. In the DEM-based rockfall model run without any surface variation, the rock block slides or rolls down most of the rock slope, bounces at the bottom, and tumbles down the catchment area, with approximately 4 percent of the rocks landing on the pavement. In the simulation using the survey slope, the rock block slides down the rock slope, bounces slightly at the bottom, and is contained within the catchment area. Using the more variable profile from the
photogrammetry (UAS) data, the rock is near or in free fall down part of the rock slope, bounces several times, and may land anywhere in the catchment area, with approximately 7 percent of the rocks reaching the roadway.

![Figure 3.16](image)

Figure 3.16: Trajectories of a 50 kg square rock modeled for Sta. 912+00 using different slope models. The overlapping thick brown line in the DEM profile with variable roughness shows all profile changes that were used for all trajectories.

When surface roughness and therefore the slope profile was allowed to vary in the DEM-based rockfall model, rock motion became much closer to that seen in the simulations with the photogrammetry cross-section. The rock bounces down the slope in variable paths, rather than sliding. The “Roughness Varied” trajectory image in Figure 3.16 shows all variations used for all models, which appear as overlapping thick lines on the rock slope. Figure 3.4 previously presented an individual trajectory on a single “roughened” slope profile.

Despite the wider distribution of rock runout from the UAS data model, the cumulative distributions from all slope models are all similar, as can be seen in Figure 3.17. Most rocks end
Figure 3.17: Comparison of rock end points for different slope models for station 912+00. Histograms and cumulative percentages of rock runout for each slope model. End points are estimated within ±0.5 m.

Figure 3.18: Average and maximum rock path ending locations, Station 912+00, Londonderry. Rock path end locations are estimated within ±0.5 m.

between -11 m and -6 m, and all four predict that at least 90 percent of the rocks will be stopped before reaching the roadway. From Figure 3.18, it is clear that the average stopping location for
the simulations varies within approximately 2 m for all models, allowing for error due to the rock end point estimation used. The maximum rock end points of the models using photogrammetry and DEM cross-sections are the same, though the maximum end point of the roughened DEM profile falls shorter, and the model using survey data does not predict that rocks will reach the roadway. Though the simulated rock motion is very different between the models with varying resolution, the predicted rockfall runout from the UAS and DEM rockfall models is similar.

An image of the rock face at Station 913+50 from Google Earth is depicted in Figure 3.19. At this 18 m high location, a large vertical or slightly overhanging face of the rock cut is clearly visible on the northern side of the road; the rock here may have been removed during blasting. This part of the rock face is easily seen in the UAS data at approximately -25 m in Figure 3.20. Here, the DEM as expected smooths the slope, but generally aligns with the UAS data above and below the vertical face. The survey cross-section is very different from the other two models; the toe of the rock slope is nearly 6 m south of the base of the vertical face estimated from the UAS data. On the southern side of the slope, all three data sets align, though the UAS data is truncated near the base of the slope.

It is likely that the discrepancy in the survey cross-section at this location is due to old data incorporated into the project plans. The southern side of this cross-section was updated by NHDOT surveyors when it was recognized that the existing cross-sections did not fully depict the actual slope. The original cross-section is a dashed blue line on Figure 3.20; the corrected profile is in light blue. Though the corrected southern profile nicely aligns with the other data sets, the northern side of the rock cut was not changed and does not accurately reflect the actual slope.
Figure 3.19: Station 913+50, northern side of the road.

Figure 3.20: Elevation profiles from different surface models at Station 913+50.
Figure 3.21 and Figure 3.22 depict the simulated trajectories and the runout distances for the three surface models for Station 913+50. Figure 3.23 summarizes the average and maximum rock runout for each model; averages in this figure do not include rocks that remained on the rock face. Like Station 912+00, the simulated 50 kg square block moves very differently down the slope in each model. On the DEM and survey profiles, the block slides or rolls until it bounces at the bottom of the slope. In the UAS data, however, the accurate representation of the vertical face sends the simulated rock into free fall to the base of the cut, where it then bounces and rolls. Surface roughness was not varied for this location, because the substantial difference between the DEM and photogrammetry models could not be represented by the surface roughness tool in RocFall without adding unrealistic variation to the data.

![Figure 3.21: Trajectory models of a 50 kg rock on three elevation models at Station 913+50](image)
There is a highly varied spread of runout locations between the three surface models. Using the DEM profile, more than 30 percent of the rocks remain on the slope, held in place by friction, which can be seen in Figure 3.22. Another 40 percent of rocks stop moving between -16 m and -13 m, and all of the rocks have stopped before -9 m. The photogrammetry model predicts that the simulated rocks stop throughout the area between the rock and the roadway. The average rock end point location predicted by both the DEM and photogrammetry is -15 m.

![Figure 3.22: Histograms and cumulative percentages of rock runout for each slope model for Station 913+50. End points are estimated within ±0.5 m.](image)

The end locations from the survey data profile are more clustered: 80 percent of rocks stop between -12 m and -8 m. This is also a longer average runout distance than predicted by the other two models, which is clearest in the comparison in Figure 3.23. This can be explained by the work done by Ritchie (1963), discussed in section 2.3. The rockfall model using the DEM cross-section predicts sliding or rolling down a steep slope, while the photogrammetry model predicts free fall down a vertical rock face. In both cases, most of the rock momentum is in the vertical direction. The survey data models a lower slope angle, which increases the horizontal velocity of the modeled
rocks compared to the other surface models. This leads to comparatively longer runout distances. The runout using the DEM cross-section is logically also lower than that in the photogrammetry model, because the rock is subjected to friction while it is contact with the rock face.

Despite the differences in predicted rock path end locations, in all three of these models rocks were entirely prevented from reaching the roadway because of the distance between the base of the rock and the edge of the pavement.

![Graph showing average and maximum rock ending location at Station 913+50](image)

Figure 3.23: Average and maximum rock path ending locations, Station 913+50, Londonderry
End points are estimated within ±0.5 m.

3.5.2 **Rock Cut 4, Barron Mountain, Woodstock, NH**

The cross-section chosen from rock cut 4 on Barron Mountain was section 7A from Kemeny (2015) and was shown in Figure 3.9. This location is approximately 10 m high; it is not the tallest area of the rock cut, but it was chosen because of the overhang captured by the cross-section. The presence of the overhang, as in the cross-sections used from Londonderry, allows comparison of models built using the terrestrial lidar data that accurately captures the overhanging rock and the DEM, which does not. The TIN surface at this location was also compared.
Figure 3.24 compares the cross-sections at location 7A. Notably, the terrestrial lidar data did not capture the area below the rock cut, possibly due to the scanner orientation. In order to model this, the ditch from the TIN surface was recreated for the lidar profile. The terrestrial lidar cross-section shown is simplified in the same manner as the Londonderry profiles, comprising 20 percent of the original vertex points, but it remains true to the original profile as seen in Figure 3.25. The cross-section from the DEM is, as expected, smoother relative to the lidar data. At 8 m on the cross-section, the DEM overestimates the height of the rock face by almost 2 m and the angle by approximately 10 degrees compared to the lidar. It does not show the overhanging portion of rock. To determine if some of this difference could be accounted for by surface roughness variation, roughness was allowed to vary for the rock slope for one model using a DEM-based cross-section, using the 1 m spacing, ±0.6 m amplitude default settings from RocFall. An example
profile is shown in Figure 3.26. Note that all slope variation used in all trajectories is shown in the trajectory summary figure in Figure 3.27, but each simulated rock used a different slope profile. The apparently regular spacing of the slope variation in Figure 3.27 is a result of the 1 m slope roughness spacing coinciding with the 1 m resolution of the DEM cross-section vertices.

![Original vs Simplified Data, Barron Mountain](image)

**Figure 3.25:** Comparison of the original and simplified cross-sections, Barron Mountain

![Example of a DEM profile with surface roughness variation applied. Dimensions in meters.](image)

**Figure 3.26:** Example of a DEM profile with surface roughness variation applied. Dimensions in meters.
The TIN profile is closely related to the DEM, as it should be; the source data for these surfaces is the same. The TIN surface, which is built from individual data points rather than the 1 m by 1 m cells of the DEM, is able to capture smaller changes in slope than the DEM. However, the difference between the surface heights at approximately 3 m on Figure 3.24 could be due to either noise from the point cloud or the difference in interpolation methods between surfaces.

![Figure 3.27: Trajectories of a 50 kg rock from Barron Mountain section 7A.](image)

Figure 3.27 and Figure 3.28 show the modeling results from Barron Mountain. Figure 3.29 summarizes the average and maximum runout distances. 100 50 kg square rock blocks were dropped from 8 m above the low point of the ditch in each model. The zero location for these models was manually set to the base of the rock face. In all models, the rock is in freefall for a portion of the rock face, bounces off the bottom of the slope, and bounces and rolls through the catchment, as seen in Figure 3.27. All models predict that 6 percent of rocks or less will reach the
road (Figure 3.28). The unaltered DEM cross-section and the terrestrial lidar predict approximately 35 percent of the rocks will remain stuck at the seeder location because of friction between the rock and the slope. The rockfall model using a DEM profile with a variable slope predicts that 20 percent will remain on the slope, possibly due to friction or the rock becoming caught in a dip in the slope. The TIN model predicts 35 percent of the rocks will remain at the lowest point of the ditch. The average runout distances from all models are within 4.5±0.6 m from the base of the slope.

Figure 3.28: Modeled rock runout from Barron Mountain 7A. Rock end locations are estimated within ±0.5 m.
3.5.3 Summary

Though the material parameters in the rockfall models presented are not calibrated to site-specific conditions, they are useful comparisons between DEMs and higher-resolution photogrammetry and terrestrial lidar data. The behavior of rockfall models with respect to variations in the slope material parameters is examined in Chapter 5. These models show that rock motion differed greatly between slope models with different resolutions, but average and maximum runout distances were very similar. With cross-sections from the 1 m and 2 m DEMs, surveyed points, and a TIN model, simulated rocks tended to slide down the rock slope unless surface roughness was varied to create a near-vertical slope or launch point that started the rock falling, bouncing, or rolling. When more detail was available in the slope model, such as in the cross-sections from photogrammetry or terrestrial lidar, rock motion was more variable.
Despite the differences in rock motion and the distribution of rock path end locations shown by these models, all of the models from a given location were in general agreement as to whether rocks might reach the roadway. At survey station 912+00, three of four models predicted some rocks might reach the road. At station 913+50, all models predicted that the rocks would be fully contained by the catchment area. For Barron Mountain, all three models predicted that 6 percent or fewer rocks would reach the road.

Conclusions that can be drawn from these comparison models include:

- Predicted rock motion differs greatly between models with low and high resolution.
- Allowing the slope profile to vary using built-in software tools simulates more realistic rock motion.
- The average rock runout distances from rockfall models using surface profiles from 1 m or 2 m DEMs and high-resolution photogrammetry or terrestrial lidar agreed within approximately 2 m for each of the three models. Maximum runout distances agreed within 2 m for Londonderry station 912+00 and Barron Mountain and within 5 m for station 913+50.
- DEM-based cross-sections may be a viable alternative to higher-resolution data in order to estimate runout distances from rock cuts using 2D rockfall models.
4 EXPERIMENTAL ROCKFALLS

A limited number of rockfall experiments were performed to test the application of the new high-g Smart Rock (SR), updated by Apostolov (2018), for direct measurement of acceleration and rotation during rockfall that could be used for model calibration. These measurements, along with video taken of each test and measured rock runout, formed the basis for a preliminary evaluation of the validity of different slope model and restitution coefficient inputs for rockfall models.

4.1 Smart Rock

As previously discussed, the rockfall-specific SR contains a ±400 g 3-axis accelerometer, a ±16 g accelerometer, and a ±4000 dps high-rate gyroscope (Figure 4.1). For the current research, the ±16 g accelerometer is limited purposely to ±8 g in order to decrease noise in the acceleration signal; this can be changed to ±2 g, ±4 g, or ±16 g as desired. Data are acquired at a frequency of 500Hz, which was previously determined to be sufficient for these dynamic experiments (Apostolov and Benoît, 2017), and the data are written to a micro SD card. The current outputs of this SR are measurements of 3D acceleration and rotational velocity, and future versions of the rockfall SR are expected to contain an altimeter in order to measure altitude changes (Apostolov, 2016; Apostolov and Benoît, 2017). Unlike previous versions, which were protected by an aluminum casing, the rockfall SR is contained inside a 2.54 cm diameter, 4.2 cm long custom 3D printed plastic shell, as shown in Figure 4.1. The mass of the instrument and shell is 22.5 g.
For rockfall experiments, the SR is secured inside a natural stone, which is dropped or rolled off the slope of interest. The rock is prepared by drilling a hole with a 2.54 cm (1 in.) outer diameter core bit to a depth of at least 7.5 cm, in order to accommodate both the SR and the seal. Ideally, the SR should be positioned at the center of mass of the rock. A 2.54 cm diameter expandable rubber plug was used to seal the SR inside the rock. The drilling procedure is shown in Figure 4.2.

The current rockfall SR model is a prototype. For use, the instrument is started and kept stationary during its auto-calibration, which is indicated by colored LEDs. It is oriented battery-down during this process in order to properly calibrate the 3D axes of the gyroscope and accelerometer (Apostolov, 2016; Apostolov and Benoît, 2017). This orientation is marked on the SR shell. A button is pressed to begin data acquisition, and the instrument is sealed inside its shell. Because the SR is gathering data continuously after it is turned on, the signal may be very noisy as the SR is closed and the instrument and rock are moved.

Figure 4.1: Smart Rock sensor and shell
In order to distinguish the experiment from other motion, three to five initiation taps were performed before each test. Each sharp tap creates a spike in the data as a rapid deceleration and change in rotational velocity. These were used to easily identify the start of each test and to sync SR data with video data files.

The SR is charged using a standard micro-USB cable. When the SR was being used for multiple tests in the field, where battery life was a potential concern, it was charged in the field using a 5200 mAh portable USB charger.

SR data were plotted and analyzed using Matlab. The analysis code was adapted from Apostolov (2016) and converted for use with the rockfall SR. The SR outputs data as a comma separated file containing data columns from the high-g accelerometer, the low-g accelerometer, the gyroscope, and time in milliseconds. The Matlab code normalizes the time and converts it to seconds, then plots all the axes of acceleration and rotational velocity against time. The user is able
to choose a time period of interest, and the program will then write all data in the chosen time interval, including resultant accelerations and rotational velocity, to a new Microsoft Excel file with the time beginning at zero seconds. A second Matlab code was used to plot the data for the time interval. The high- and low-g acceleration signals were combined into a single resultant acceleration plot using the data values of the low g resultant acceleration when the signal was below 8 g but substituting the resultant data from the ±400 g accelerometer when the signal exceeded 8 g.

The dual accelerometers are necessary to capture the full range of accelerations the SR may experience during rockfall. Acceleration on the SR can exceed 8 g or 16 g very easily; in a basic drop test shown in Figure 4.3, the SR experienced 90 g on impact when it was dropped from 15 cm onto a pad of paper. The ±400 g accelerometer captures the high accelerations produced by impact from a fall or a bounce, but accelerations below ±2 g are obscured by noise. The ±16 g accelerometer is used to measure low accelerations. Low accelerations are important to data interpretation: the accelerometer reads 1 g when the SR is at rest and 0 g when the instrument is in free fall, with no outside forces acting on it.

Because accelerometers can incur damage when their limits are too often exceeded (Ghayoomi, 2018), if the rockfall SR is used frequently and experiencing high impacts, the accelerometers in the SR should be assessed against known values to determine if the signal is correct. There was no indication of this occurring in the current research.

In the test of the rockfall SR shown in Figure 4.3, initiation taps were performed but are not shown, so images A through H show the SR as it was held, dropped, hit the ground, and bounced several times before coming to rest. The letters on the acceleration and rotational velocity graphs indicate the corresponding measured signals for each stage of motion of the SR shown in
the figure. At point A in Figure 4.3 the Z acceleration reads 1 g, as the SR was held at rest. In free fall, at B and D, the acceleration was 0 g, shown on the low-g accelerometer.

When the SR was dropped, it rotated as it fell with a resultant rotational velocity of 360 dps (B). The green line indicates that the majority of the rotation was around the Y axis of the SR, which can be observed as the SR moves from a horizontal position at A to a near vertical position at C. When the SR hit the surface at C, it experienced 90 g deceleration, before rebounding and rotating in the opposite direction around the Y axis (D) before hitting again at E with less acceleration and bouncing a few more times (F, G), then rolling around the X axis (H) before coming to a stop.

The motion of the capsule is captured by the SR instruments. Each time the SR bounces, it experiences 0 g acceleration while unsupported in the air. All three rotational velocity signals are shown on the graphs to indicate around which axis the capsule was rotating, as well as the resultant. The highest g force experienced by the instrument was its first moment of impact at C, and the resultant rotational velocity reached its maximum value of 800 dps when the SR fell fully onto its side for the final time (G).

The SR measurements can be confirmed with video analysis. An estimate of rotation around the Y axis from analysis of the video between points G and H shows a change of approximately 26 degrees over 33.3 ms, which results in a calculated rotational velocity of 780 dps. This is extremely good agreement with the SR measurements, which read the Y direction rotation reaching peak values of 778.5 dps and 780.2 dps just after 0.4 s on the graph in Figure 4.3.
Figure 4.3: Results of a drop test with the redesigned "rockfall" Smart Rock. 
Left: The progression of the falling SR. Black arrows indicate the direction of motion. 
Right: acceleration and rotational velocity measured by the SR.
4.2 Rocks

The natural rocks used for experimental rockfalls with the SR were chosen based on durability and size such that they could be easily transported by hand or hoisted to the top of a slope. They also had to survive multiple falls with little damage.

The rocks used are a 5.3 kg sub-angular metamorphic rock and a 10.8 kg angular, blocky diorite, both shown in Figure 4.4. The characteristics of each rock are provided in Table 4.1. Holes were drilled in the test rocks as described previously. Though placement of the SR at the centroid of the rock shape is ideal, due to the constraints of the drill, the hole in the larger rock had to be offset. The rocks were measured and the density was determined using volume and mass measurements of the core piece removed during drilling. Orange spray paint was applied to increase the visibility of the rocks on video, and the centroid of each rock was marked for later use in video analysis, which is shown in black on Figure 4.4. The mass moments of inertia were estimated for each axis of the two rocks, which are given in Table 4.2. These are oriented with respect to the orientation of the SR within each test rock, which is shown in Figure 4.5. After Caviezel et al. (2018b), these rocks were plotted on a Sneed and Folk (1958) classification diagram to classify their shape, in order to better compare results to the literature. The results are shown in Figure 4.6.

![Figure 4.4: Rocks used for Smart Rock experiments and experimental rockfalls. Left: the 5.3 kg metamorphic rock used for the majority of experimental falls. Right: the 10.8 kg diorite block. The scale is 15 cm wide.](image-url)
Table 4.1: Characteristics of rocks used for experimental rockfalls.
The Smart Rock (X, Y, Z) axes correspond to the height, width, and length measurements, respectively.

<table>
<thead>
<tr>
<th>Rock</th>
<th>L (cm)</th>
<th>W (cm)</th>
<th>H (cm)</th>
<th>Mass (kg)</th>
<th>Density (kg/m³)</th>
<th>Shape</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20</td>
<td>12</td>
<td>12</td>
<td>5.30</td>
<td>2660</td>
<td>Compact</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Elongated</td>
</tr>
<tr>
<td>2</td>
<td>20.3</td>
<td>17</td>
<td>12.5</td>
<td>10.83</td>
<td>2770</td>
<td>Compact</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Bladed</td>
</tr>
</tbody>
</table>

Table 4.2: Estimated mass moments of inertia (I) for each test rock

<table>
<thead>
<tr>
<th>Rock</th>
<th>Mass Moment of Inertia (kg·m²)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>I_{XX}</td>
</tr>
<tr>
<td>1</td>
<td>0.024</td>
</tr>
<tr>
<td>2</td>
<td>0.063</td>
</tr>
</tbody>
</table>

Figure 4.5: Orientation of the SR when inside rock 1 (left) and rock 2 (right).

Figure 4.6: Sneed and Folk (1958) particle shape classification diagram.
4.3 Video

Video footage was captured for each of the SR test rockfalls for documentation and motion analysis. Though most rockfall experiments capture rock motion using at least four cameras (Duffy and Turner 2012), only one camera was used for the preliminary testing reported here. During initial testing, it was determined that the field of view from the single camera could cover the majority of the motion of interest as the test rock moved down the exposed rock face. The camera used was an iPhone SE using 1040p high definition video recording at 120 frames per second (fps), which was chosen based on availability and the ability to acquire high-frame-rate footage. The camera was placed perpendicular to the rockfall path.

Basic semi-automated video processing was performed in order to estimate the trajectory and translational velocity of the rock during experimental rockfalls at a test location in Durham, NH. Processing was conducted using the iOS application VideoPhysics by Vernier. This application assumes that the videos are from a stationary camera facing perpendicular to 2D motion and shooting at an iPhone’s standard frame rate of 30 fps. A video is loaded and 2D axes and a scale are assigned to the image. The object of interest, here the falling rock, is manually identified as a point in each frame of the video or a subset of frames. The point chosen was the centroid of the rock. Using the location of the rock, the scale defined by the user, and the frame rate of the video, the software outputs tables and plots of the position and velocity of the rock over time. Data were exported from VideoPhysics to the Vernier Graphical Analysis application and from there were saved as .xlsx or .csv files for use in Microsoft Excel.

The actual frame rate used, 120 fps or greater, had both benefits and drawbacks for video processing using this software. At high velocities, the high frame rate allowed the moment of impact with the slope to be identified, and, in some cases, clear rotation of the rock to be observed.
instead of blurred motion. At low velocities, it was difficult to distinguish movement of the rock in each frame, and assigning rock locations to each video frame became unreliable. Therefore, the rock was identified in every frame where movement could be easily distinguished and around a point of impact, and identified every 5 to 10 frames when the rock was stationary between the initializing blows and when it was moving very slowly. The time and velocity data were manually corrected after export to account for the difference between the actual frame rate and the assumed frame rate of 30 fps.

4.4 Locations

Preliminary testing of the SR function, camera setup, and rockfall procedure was performed at a 2 m high exposed rock face outside Kingsbury Hall on the UNH campus. The majority of tests were performed on an exposed bedrock slope in College Woods near the UNH campus. This was chosen for the presence of an exposed rock face sufficient to simulate the motion of a rock falling from a rock cut, its accessibility for multiple days of experiments, and the lack of hazards to roads, pedestrians, and research personnel.

In April and May, 2018, the NHDOT Bureau of Materials and Research provided access to two rock cuts while they were undergoing hand scaling to remove loose rock. The first site was on I-93 in Derry. This rock cut was newly blasted and the catchment ditch was not yet constructed at the time of testing. The second site was at rock cut 110 in Hart’s Location, NH, which has an A hazard rating with the highest numerical hazard score of all rock cuts in New Hampshire (NHDOT, 2018).
4.4.1 College Woods, Durham, NH

Following a series of experiments near Kingsbury Hall on a 2 m high outcrop, a natural rock slope was selected in the nearby College Woods, in Durham, NH. The rock slope is exposed in the side of a hill offset from a hiking path; the location is shown in Figure 4.7. Roughly 4 m of intact, weathered diorite slopes towards the northeast at an angle of approximately 52 degrees. The slope transitions to topsoil covered with forest debris, becoming shallower and extending for approximately 19 m, as shown in Figure 4.8. The total vertical change of the test slope is roughly 6.3 m.

Figure 4.7: The location of the experimental slope used in Durham, NH. Data courtesy of UNH GIS.
Figure 4.8: The rock slope in College Woods used for SR rockfall experiments. 

a) View of the slope from the camera. b) Angled view of the slope, showing slope markers. c) View from the end of the slope. d) Sketch showing measured points used to manually model the slope, with the locations of the slope markers shown in red. The red and white pole is marked in 1 ft vertical intervals; the red line in (c) shows location of the pole (not to scale).
It was not possible to get a reliable GPS signal under the tree cover, so the slope was measured manually using a compass and a measuring tape. It was referenced to a local “zero” location, which was marked by a red and white range pole at the approximate base of the hard rock slope. Another point of interest was marked with a yellow X on the rock face, horizontally offset 1.68 m (5.5 ft) from the pole. The drop point of the rock at the top of the slope was at an (X, Z) location of (-3.43 m, 3.56 m) from the base of the pole. The video camera was set up 6.5 m from the range pole facing perpendicular to the rockfall path. The camera field of view captured the drop location to the range pole, showing all of the exposed rock slope. It did not cover the lower portion of the slope beyond the range pole, which acts as the rockfall runout zone (Figure 4.8).

Caltrans recommends that a minimum of 20 rocks are dropped during rockfall experiments to obtain sufficient data (Duffy and Turner, 2012). A total of 45 rock drops were conducted at this location for measurement of rock runout. 15 of these recorded the rock motion using the redesigned rockfall SR. For all tests, slow motion video was obtained of the initial part of the rockfall while the rock fell on the exposed rock slope, and the final runout distance of the rock was measured relative to the designated zero point. Video data were only analyzed for the 15 falls with SR data.

The 15 SR trials included trials 1 through 10 with the 5 kg, compact elongated rock 1 (T1-T10) and trials 11 through 15 (T11-T15) with the 11 kg, compact bladed rock 2. These were performed in four sets of three to five falls each, in order to minimize the time spent inserting and removing the SR from the natural rock. For each set of test falls, the SR was calibrated, data collection was started, and the SR was sealed inside the test rock. The video recording was started and the rock was manually carried to the top of the slope. The rock was tapped five times on the ground to signal the start of the test. The rock was then held stationary for approximately five seconds to create another recognizable signal in the SR data, then released to fall down the slope.
Once the rock came to rest, the video recording was stopped, and the rock runout distance was recorded with respect to the range pole marking the “zero” reference point. Any necessary additional notes were made regarding alternatives in the rock path, such as during T4, when the rock hit a tree and bounced sideways. The rock was then carried up the slope and the next trial was conducted. At the end of each set, the plug was removed from the rock, and the SR was removed and data acquisition was stopped.

Figure 4.5 shows the orientation of the SR when placed inside each rock. The rocks were released in the same orientation each time, in order to ensure that the rock actually fell. Both test rocks, if placed on their long side against the rock, typically remained in that position without falling or sliding. Therefore, both rocks were released from the “upright” position with the Z axis down, i.e.: by standing the rock on the shortest side to raise the center of gravity, so that, when placed on the sloping surface, they fell down the slope without a need for an additional force to overcome friction. There was no starting velocity not resulting from gravity. This was later accounted for during computer simulation of these experiments.

4.4.2 Derry, NH

New rock cuts are being constructed as part of the reconstruction of I-93. Test drops of the SR at a new rock cut south of Exit 4 in Derry, NH were made possible by Krystle Pelham with the NHDOT, during hand scaling of the rock cut in April, 2018 (Figure 4.9). The rock cut at this location was blasted using presplitting, leaving a rock face with an approximately 70 degree slope. The cut is a roughly 15 m tall gneiss. This cut is offset from the prior location of rock cut 65, a C-rated cut that was removed during the highway reconstruction. The majority of the exposure is freshly broken, but the top 2 to 3 m appear to be moderately to severely weathered and may be a separate rock type, seen at the top of the image in Figure 4.9. No ditch had yet been constructed,
and hand scaling of the cut was in progress during SR testing. A small talus slope with a 4 m wide, 0.5 m deep rock-lined ditch separated the cut from leveled ground where the new roadway is under construction. The drop location had not yet been hand scaled.

The test rocks were dropped in this location by scalers with rope access to the top of the slope. Rock runout was determined based on the location relative to the ditch. Seven experimental rockfalls were conducted at this site: three with the 5 kg rock and four with the 11 kg rock. All three tests with the 5 kg rock and one with the 11 kg rock obtained SR data. The SR was inserted into the test rocks at the bottom of the slope and hauled up the rock face by the scalers using a rope and a bag. Video was captured perpendicular to the rock path and facing the rock path using hand-held cell phone cameras.
4.4.3 Crawford Notch, Hart’s Location, NH

Rock cut 110 is 270 m long along Route 302, at the far northern end of Crawford Notch State Park in Hart’s Location, NH. It is an A-rated rock cut that presents a relatively high hazard to the roadway. The rock face is up to 29 m high and in some places has as little as 1 m between the rock and the edge of pavement. No catchment ditch exists. The roadway has no shoulder, and each travel lane is approximately 5 m wide. The rock cut was created using production blasting, leaving a very jagged rock face with significant amounts of overhanging rock. An image from a digital 3D model of the rock slope showing the two test locations is shown in Figure 4.10. Two large fallen blocks up to 2 m wide can be observed in the center and towards the right of Figure 4.10, which shows the rock cut as it was in July 2017. These blocks are evidence of past rockfall, though both of these fell from low on the slope and did not reach the road.

Figure 4.10: Experiment locations at rock cut 110, Crawford Notch
In July 2017, the NHDOT in conjunction with the University of Vermont flew a drone to capture images of the rock slope and create a 3D model using SfM, shown in Figure 4.10 and previously in Figure 2.16. The data were used for a structural and stability analysis of the rock cut and are planned for use in change detection studies in the future. This data set is also available to UNH for use in modeling rockfall.

Four test rockfalls were conducted on rock cut 110 while hand scaling was being performed in May 2018, and SR data were obtained for two of these. All tests were performed with the 11 kg compact bladed block, rock 2. The SR was started and calibrated on the ground, and the scalers hauled the rock up the rock face in a bag. They gave the rock initiation taps, then released it to roll down the slope. The SR was restarted and individual data files acquired for each individual test. Video footage was taken using hand-held cell phone cameras. The primary videos for each test were taken from in front of the fall location behind a concrete barrier for safety. Traffic was stopped during each rockfall. The ending location of the SR relative to the rock face was measured for each test.

Two tests were performed at each of the two locations shown in Figure 4.10. Location 1 is 19 m high, and location 2 is 29 m high. Both locations have irregular features with the potential to launch rocks away from the slope, and location 2 particularly has significant overhanging rock.

Figure 4.10 shows the test locations as they were when the 3D photogrammetry point cloud was developed in July 2017. Figure 4.11 shows the test rock mid-fall at each location in May, 2018, which were performed during hand scaling of the rock cut. A large amount of vegetation was cut back and removed from the rock face alongside the scaling, exposing rock that was hidden by trees in the 2017 data. Figure 4.11a shows the test rock just after it was launched into the air.
from a rock ledge as it rolled down the slope. In Figure 4.11b, the test rock has rolled down the upper slope and fallen off of an overhanging rock block.

Figure 4.11: Rockfall tests at Crawford Notch, rock cut 110.  
a) Location 1: as it fell, the rock was launched from a ledge on the rock face.  b) Location 2: the rock is in free fall off of an overhanging ledge. The falling rocks are indicated by the red arrows. The scalers who released the rocks are at the top of the slope wearing yellow.
4.5 Rockfall Results: College Woods, Durham, NH

The data obtained from the College Woods experiments include video analysis, SR acceleration and rotational velocity, and rock runout distances.

4.5.1 VideoPhysics

Figure 4.12 demonstrates a trajectory analysis from the VideoPhysics software from trial 7 with the 5 kg rock. The red dots on the image show the path taken by the rock while it bounced and rolled down the slope. At the top of the slope, offset dots mark the location of the rock during the initiation taps.

![Figure 4.12: Trajectory analysis for College Woods trial 7. The red dots mark the location of the rock centroid during each frame. A dotted white line marks the location of the rock slope under the trajectory of the test rock.](image)

The positions of the test rock on the slope determined by the semi-automated video analysis are approximate due to limitations of the camera placement and its field of view. These data were shifted to keep the trajectories consistent with the chosen spatial reference system, which did not
affect the timing or shape of the trajectory data. The video data were correlated to the SR signal by designating the time of impact of the first initiation tap to be the start time of zero seconds, which was visible in both data sets.

Adjusted trajectories of the 15 trials are shown in Figure 4.13, overlain on an approximation of the slope in black. The error in the position estimates causes the trajectories to often overlay the slope where they should plot above it and slightly flattens the bounce heights relative to the slope shown, but it can be observed that the rock rarely bounced more than approximately 0.5 m from the slope. The velocities calculated by VideoPhysics were not used for subsequent analyses due to the uncertainties in the position calculations. The trajectories were used for comparison to other data sets and to correlate the timing of the rockfall with the horizontal location on the slope. The vertical component of the trajectory is plotted with the SR results in section 4.5.3.

![Figure 4.13: Adjusted trajectories of the falling rocks in College Woods from video analysis. Inset shows closer view of trajectories.](image)

89
4.5.2 Runout Distances

For all 45 rockfall trials on the College Woods slope, with and without successful SR data, the runout distance traveled by the rock was measured as the farthest location that the rock traveled from the marked zero point at the base of the bare rock slope. The number of rocks landing in every 1 m interval down the slope is shown as a histogram in Figure 4.14. The average distance for all trials was 8.4 m, and the maximum distance was 15.2 m. Despite far fewer trials with rock 2, the 11 kg compact bladed block, it consistently ran out farther than the majority of the trials with rock 1, the 5 kg compact elongated rock. 18 percent of the rock 1 trials ran out further than 10 m from the base of the rock slope, while all of the rock 2 trials traveled beyond 10 m.

The RocFall software outputs rock path end locations as histogram bins measured horizontally along the slope. In order to use the measured runout distances for comparison to computer simulations, they were corrected using the measured slope angles to determine the total horizontal and vertical distances traveled as the rock fell. The horizontal distances are presented in Figure 4.15.

Table 4.3: Summary of experimental runout results for both test rocks. Runout numbers are measured along the slope, as in Figure 4.14.

<table>
<thead>
<tr>
<th></th>
<th>Number of Trials</th>
<th>Runout (meters from rock face)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Maximum</td>
</tr>
<tr>
<td>Rock 1</td>
<td>40</td>
<td>13.6</td>
</tr>
<tr>
<td>Rock 2</td>
<td>5</td>
<td>15.2</td>
</tr>
</tbody>
</table>
Figure 4.14: Measured runout distances on the College Woods slope.

Figure 4.15: Rock runout distances for College Woods projected to the horizontal plane.
### 4.5.3 Smart Rock Results

Maximum accelerations and average and maximum rotational velocities are presented in Table 4.4 and Table 4.5. The 10 trials with the 5 kg rock, shown in Table 4.4, and the five trials with the 11 kg rock, in Table 4.5, are separated to examine the effects of rock size and shape on the results. On average, the lighter rock rotated faster than the 11 kg block, and also experienced a wider range of accelerations and rotational velocities. For its 10 trials, the 5 kg rock experienced maximum accelerations per trial ranging from 45 g to 362 g, with an average of 167 g. On average, the maximum acceleration the 11 kg rock experienced in an individual trial was 220 g, with a range from 104 g to 372 g. The higher average g force experienced by the larger rock is logical due to the increased mass of the rock. The larger moments of inertia of this rock, shown in Table 4.2, explain the comparative rotational velocities: the 11 kg rock on average rotated more slowly than the 5 kg rock 1, reached lower maximum rotational velocities, and was more consistent from trial to trial. The mean and standard deviation for the average resultant rotational velocity was 928±48 dps for the 11 kg rock compared to 1017±154 dps for the 5 kg rock.

<table>
<thead>
<tr>
<th>Trial</th>
<th>Maximum Resultant Acceleration (g)</th>
<th>Average Resultant Rotational Velocity (dps)</th>
<th>Maximum Resultant Rotational Velocity (dps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>T1</td>
<td>45</td>
<td>1157</td>
<td>3194</td>
</tr>
<tr>
<td>T2</td>
<td>94</td>
<td>1198</td>
<td>2619</td>
</tr>
<tr>
<td>T3</td>
<td>150</td>
<td>964</td>
<td>2878</td>
</tr>
<tr>
<td>T4</td>
<td>195</td>
<td>895</td>
<td>3377</td>
</tr>
<tr>
<td>T5</td>
<td>154</td>
<td>1341</td>
<td>3088</td>
</tr>
<tr>
<td>T6</td>
<td>110</td>
<td>869</td>
<td>2596</td>
</tr>
<tr>
<td>T7</td>
<td>256</td>
<td>871</td>
<td>2006</td>
</tr>
<tr>
<td>T8</td>
<td>241</td>
<td>1017</td>
<td>2632</td>
</tr>
<tr>
<td>T9</td>
<td>67</td>
<td>896</td>
<td>2193</td>
</tr>
<tr>
<td>T10</td>
<td>362</td>
<td>960</td>
<td>3088</td>
</tr>
<tr>
<td>Average</td>
<td>167</td>
<td>1017</td>
<td>2767</td>
</tr>
<tr>
<td>Standard Deviation</td>
<td>93</td>
<td>154</td>
<td>418</td>
</tr>
</tbody>
</table>
Table 4.5: Smart Rock data summary for the 11kg rock trials in College Woods.

<table>
<thead>
<tr>
<th>Trial</th>
<th>Maximum Resultant Acceleration (g)</th>
<th>Average Resultant Rotational Velocity (dps)</th>
<th>Maximum Resultant Rotational Velocity (dps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>T11</td>
<td>203</td>
<td>988</td>
<td>2069</td>
</tr>
<tr>
<td>T12</td>
<td>123</td>
<td>921</td>
<td>2113</td>
</tr>
<tr>
<td>T13</td>
<td>104</td>
<td>899</td>
<td>2495</td>
</tr>
<tr>
<td>T14</td>
<td>299</td>
<td>868</td>
<td>2241</td>
</tr>
<tr>
<td>T15</td>
<td>372</td>
<td>962</td>
<td>2152</td>
</tr>
<tr>
<td>Average</td>
<td>220</td>
<td>928</td>
<td>2214</td>
</tr>
<tr>
<td>Standard Deviation</td>
<td>114</td>
<td>48</td>
<td>170</td>
</tr>
</tbody>
</table>

Figure 4.16 and Figure 4.17 provide examples of the SR data outputs for T7, using the 5 kg, compact elongated rock 1, and T15, using the 11 kg, compact bladed rock 2. Resultant acceleration and all rotational velocity data are presented versus time. Graphs for all other trials are available in Appendix D.

Though the maximum accelerations experienced during these two rockfalls are 256 g and 372 g, respectively, the graphs have been truncated at 90 g to better show the low g range and allow interpretation of the rock motion. The acceleration peaks when the rock decelerates upon impact with the surface and is zero when the rock is in free fall. In free fall, the resultant rotational velocity is constant, as there are no significant forces acting upon the rock to change its rotation.

The maximum accelerations experienced by these trials can be used to calculate the approximate force experienced by the rock at impact using Newton’s second law of motion:

\[ F = m \times a \]  \hspace{1cm} (6)

where F is force, m is mass, and a is acceleration in meters per second. Using equation 6 and the masses of the experimental rocks, T7 and T15 experienced approximate maximum forces of 13 kN and 39 kN, respectively. Because the SR coordinate system is local to the instrument, its results do not include information on direction, so therefore, these forces are estimates based on the maximum resultant acceleration experienced, and the direction of the force is not known.
Superimposed on the acceleration data for both trials is the Z position (height) of the rock relative to the marked zero location on the slope, which was output from the video analysis. This line is dashed between the end of the available video data and the final runout location of the rock to indicate the lack of data in the runout zone. The black dots on the graphs represent the points in time at which the rock passed the physical markers on the slope at -1.68 m (on the rock face) and 0 m (the range pole).

Figure 4.16: SR acceleration and rotational velocity for T7 with the compact elongated, 5 kg rock, College Woods
For T7, shown in Figure 4.16, between 0 and 0.5 s the rotational velocity indicates that rotation was increasing around the X axis of the SR, and the rock experienced a few small collisions against the rock surface as it slid, shown as small peaks in the acceleration data. This was the rotation of the rock from an upright position as it fell forward and began to slide down the slope, and this occurred in every experimental trial. This toppling motion was smoother in T15; the heavier, blocky rock only experienced a significant hit against the surface at 0.6 s, when the
rotation finished and the rock began its slide. Little forward or downward motion occurred until the rock completed this topple. In T7, the rock bounced down the rock face between 0.5 and 1.6 s, which is indicated by high acceleration peaks as the rock hit the surface with force. These bounces can be seen as small changes in the vertical height of the rock from the video data, in blue, which correspond to peaks in the acceleration. Between these, acceleration dropped to zero, indicating that the rock was in the air. At approximately 1 s, the rock launched from an irregularity in the slope and went into free fall until it hit the slope at the location of the -1.68 m slope marker. This increased the rotational velocity dramatically, which could be due to the angle at which it impacted the slope. At 1.6 s, the rock reached the base of the bare rock slope. It continued bouncing past the zero point, but at 2.5 s following a high acceleration peak, the accelerations decreased down the slope though the rotational velocity remained near 1500 dps. This corresponds to the rock rolling down the soil-covered runout zone; because it is not spherical, acceleration peaks were experienced as it contacted and rebounded from the slope. As expected, rotational velocity remained constant when the rock was in the air between bounces and changed when it hit. The rock slowed and stopped approximately 6 s after being dropped; it traveled 6.92 m past the zero marker in this trial.

Rock 2, the heavier block, experienced less bouncing and more rolling, which can be seen in Figure 4.17. Like T7, in T15 the rock toppled forward and began to slide, before launching off the slope irregularity at approximately 1 s. The block hit the rock slope hard twice before impacting the soil slope at the zero point and beginning to roll. For this trial, after sliding started the rotational velocity increased with every bounce until just after 3 s, after which it decreased with each impact as it rolled. It is clear from the rotational velocity that the rock was rotating almost exclusively around the X axis of the instrument. This stabilization around the X axis occurred during all
College Woods experiments with the compact bladed rock as the rock rolled down the runout zone. For trials with the smaller rock, rotation occurred in all three directions, roughly equally for T7 as seen in Figure 4.16. At its maximum in T15, the rotation was approximately 2000 dps for nearly one second. The rock in T15 ran out 15.22 m past the zero marker in approximately 8 s.

Observations of all SR data (Appendix D) show that the smaller rock typically stopped in shorter time periods, corresponding to the shorter runouts. The larger rock generally experienced slower and more consistent rotation as well as longer runouts.

Bounce heights for these trials were not systematically measured. However, it can be seen in the trajectory graphs (Figure 4.12, Figure 4.13, Appendix C) that most bounces of the test rock off the rock slope and the soil at its base were less than 0.5 m from the slope surface. This observation is used for comparison to modeled results in later analyses.

4.6 Rockfall Results: Derry, NH

The data obtained from experiments at the Derry location include rock runout and acceleration and rotational velocity from the SR. Video analysis included confirmation of rock end locations as well as observation of rock behavior and motion after impact with the ground.

4.6.1 Video Observations

Video recordings were used to observe the trajectory of the rocks during the experimental rockfalls. During each trial, the rocks fell from the top of the slope and bounced once or twice from the rock face, continuing a downward trajectory without rebounding upwards. The first impact with the ground occurred on the side of the ditch closest to the rock cut in six out of the seven drops, as is shown in Figure 4.18. In most trials, the rocks did not rebound significantly after impact with the ground; they instead “rolled” in short-trajectory bounces close to the surface,
though some moved with enough energy to continue up the far side of the ditch and out of it. The highest bounce height after impact with the ground at the base of the rock cut was less than 1 m from the surface.

![Figure 4.18: First impact of the SR with the ground in Derry](image)

### 4.6.2 Runout Distances

The runout distances for four tests with the SR at the Derry rock cut are provided in Table 4.6. All values are referenced to the base of the rock cut, where the rock talus forming the ditch intersected with the slope. The end location of each trial was recorded approximately in the field and checked with analysis of video recordings.

<table>
<thead>
<tr>
<th>Trial</th>
<th>Rock</th>
<th>Approx. End Location (m)</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5kg</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>5kg</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>5kg</td>
<td>5.4</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>11kg</td>
<td>3.5</td>
<td>No SR data</td>
</tr>
<tr>
<td>5</td>
<td>11kg</td>
<td>3.5</td>
<td>No SR data</td>
</tr>
<tr>
<td>6</td>
<td>11kg</td>
<td>8</td>
<td>No SR data</td>
</tr>
<tr>
<td>7</td>
<td>11kg</td>
<td>4.2</td>
<td></td>
</tr>
</tbody>
</table>
Of the seven total tests, four were entirely contained within the rock-lined ditch at the base of the cut, two ran out more than a meter beyond it, and the last stopped closely outside the edge of the ditch. The averages of these approximate runout distances were 4.5 m and 4.8 m for the 5 kg and 11 kg rocks, respectively. Given potential error in the distance estimation, the difference in the runout behavior of the two rocks was negligible.

### 4.6.3 Smart Rock Results

Table 4.7 presents the maximum accelerations and average and maximum rotational velocities for the four SR trials in Derry, NH. As in the College Woods experiments, the one test with the 11 kg rock experienced a higher maximum acceleration than the three trials with the 5 kg rock. It also experienced slower rotation than the average of the 5 kg trials, again agreeing with the College Woods data.

<table>
<thead>
<tr>
<th>Trial</th>
<th>Rock</th>
<th>Maximum Resultant Acceleration (g)</th>
<th>Average Resultant Rotational Velocity (dps)</th>
<th>Maximum Resultant Rotational Velocity (dps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5kg</td>
<td>355</td>
<td>853</td>
<td>2671</td>
</tr>
<tr>
<td>2</td>
<td>5kg</td>
<td>299</td>
<td>1528</td>
<td>3823</td>
</tr>
<tr>
<td>3</td>
<td>5kg</td>
<td>397*</td>
<td>1390</td>
<td>4989*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Average (Trials 1-3)</td>
<td>350</td>
<td>1257</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Standard Deviation (T1-3)</td>
<td>49</td>
<td>357</td>
</tr>
<tr>
<td>7</td>
<td>11kg</td>
<td>430*</td>
<td>883</td>
<td>3325</td>
</tr>
</tbody>
</table>

*Approximate number. An individual data axis recorded data at the capacity of the accelerometer or gyroscope.

Graphical results for trials 2 and 7 are presented in Figure 4.19 and Figure 4.20, respectively. Data from trials 1 and 3 are presented in Appendix D. The Derry rock cut was much steeper than the test slope in College Woods at approximately 70 degrees, and the rocks were in free fall for much of each trial. During trial 2 with the 5 kg, compact elongated rock, shown in Figure 4.19, the rock slid at around 0.5 s before falling from the top of the rock cut. It impacted a ledge on the slope at 0.9 s, producing a g-force of 299 g and greatly increasing the rotation of the
rock from 388 dps to 2675 dps. The rock then glanced off the slope a second time just after 1.5 s, which is suggested by a double peak in the acceleration that has a maximum of 113 g, before hitting the ground and experiencing 294 g during deceleration. The rock bounced again several times before stopping at the far edge of the rock-lined ditch at the bottom of the slope. During free fall as well as during bouncing after impact, the rock was rotating around all three axes, which can
be seen by approximately equal rotational velocities around the X and Y axes between 1.5 s and 2.5 s and slightly lower but still variable rotational velocities around the Z axis.

Trial 1, also with the 5 kg rock, experienced a higher maximum acceleration upon impact with the ground but much slower rotation throughout its fall (Appendix D). Trial 3, with the same rock, rotated much faster after it struck the ground and exceeded the ±4000 dps limit of the SR gyroscope.

Trial 2 experienced its maximum acceleration at its first bounce off the slope; the other two trials with the 5 kg rock experience maximum acceleration upon impact with the ground. These accelerations correspond to approximate impact forces of 18 kN, 15 kN, and 21 kN, respectively. Though again, the direction of these forces is not known from the SR data and so these cannot be corrected for the effect of gravity, these indicate the approximate magnitude of the forces any barrier on the slope may have to withstand. At the top of the slope for Trial 2, prior to going into free fall, the maximum acceleration the rock experienced was 20.9 g, corresponding to an approximate force of 1 kN.

Trial 7, with the larger 11 kg, compact bladed block, was also in free fall for most of the trial, between approximately 2.2 s and 4.7 s as shown in Figure 4.20. The rock was dropped at approximately 1.2 s and rotated and slid until it fell off of the rock cut at 2.2 s. It impacted the slope at approximately 2.8 s and 3.4 s, then hit the ground at 4.7 s with a g force that reached or exceeded the 400 g capacity of the instrument, corresponding to an approximate force of 46 kN. It bounced several times and landed outside of the ditch. As in all of the experiments at this location, the rotational velocity was highest during the bounce after the first impact with the ground. In free fall with the 11 kg compact bladed rock, rotation primarily occurred around the Z axis, which has the smallest moment of inertia. This can be seen in Figure 4.20 by the consistently negative values
of the Z rotational velocity in blue, while the X and Y axes, in red and green, respectively, alternate around zero, indicating a change in rotational direction or “wobble” around these axes.

Figure 4.20: SR results for Derry Trial 7, using the 11 kg rock.
4.7 Rockfall Results: Crawford Notch, Hart’s Location, NH

The data obtained from experiments at rock cut 110 in Crawford Notch, Hart’s Location include the ending location of each experimental rock drop and acceleration and rotational velocity from the SR from two trials.

4.7.1 Runout Distances

The rock end locations for all four trials at Crawford Notch are given in Table 4.8. All four tests were conducted using the 11 kg, compact bladed rock 2. Because the full trajectory was obscured by barriers, it is not known for all tests if these are true runout values, meaning the farthest points reached by the rock, or if the rocks bounced back towards the slope from their point of impact. Both tests from location 1 are known to have bounced back from their farthest measurement.

<table>
<thead>
<tr>
<th>Trial</th>
<th>Rock</th>
<th>Drop Location</th>
<th>End Location (m)</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>11kg</td>
<td>1</td>
<td>0</td>
<td>Stopped at the base of the rock cut.</td>
</tr>
<tr>
<td>2</td>
<td>11kg</td>
<td>1</td>
<td>5.8</td>
<td>Bounced off centerline barrier. No SR data.</td>
</tr>
<tr>
<td>3</td>
<td>11kg</td>
<td>2</td>
<td>4.7</td>
<td>Impacted and damaged road. No SR data.</td>
</tr>
<tr>
<td>4</td>
<td>11kg</td>
<td>2</td>
<td>4.0</td>
<td>Stopped directly on curb.</td>
</tr>
</tbody>
</table>

Of the four tests, trial 1 stopped at the base of the rock face, trials 2 and 3 entered the roadway, and trial 4 stopped directly on the curb. The impact location of all trials was obscured by the barrier in place to protect the travel lane, and it is not known if trials 1 and 4 impacted the roadway at all prior to reaching their final end point. Trial 3 left visible damage where it impacted the pavement, and the test rock lost fragments; after the four trials, rock 2 had lost approximately 9 percent of its initial mass.
4.7.2 Smart Rock Results

Two successful tests of the SR were run at the Crawford Notch location. The data are summarized in Table 4.9. Both the average and maximum rotational velocities are consistent with values experienced by this rock at the College Woods and Derry locations. Maximum accelerations are estimates only, as the acceleration exceeded the 400 g limit of the high-g accelerometer upon impact with the ground in both trials.

Table 4.9: Smart Rock data summary for experimental trials at Crawford Notch

<table>
<thead>
<tr>
<th>Trial</th>
<th>Maximum Resultant Acceleration (g)</th>
<th>Average Resultant Rotational Velocity (dps)</th>
<th>Maximum Resultant Rotational Velocity (dps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>410*</td>
<td>831</td>
<td>3318</td>
</tr>
<tr>
<td>2</td>
<td>621*</td>
<td>951</td>
<td>2049</td>
</tr>
<tr>
<td>Average</td>
<td>515*</td>
<td>891</td>
<td>2683</td>
</tr>
</tbody>
</table>

*Approximate number. An individual data axis recorded data at the capacity of the accelerometer.

The data are presented graphically in Figure 4.21 and Figure 4.22. Unlike previous data sets, all X, Y, Z acceleration data are shown for these tests, because the low-g accelerometer failed upon impact with the ground at 5.4 s in trial 1. Therefore, the acceleration signal at low g values is incorrect after this point in trial 1, which also affects the resultant acceleration. Recalibration of the instrument for the subsequent trials appears to have fixed the issue, and the data for trial 4 appear normal. The resultant acceleration is shown as a dotted line in the uppermost acceleration plot.

As was seen in College Woods and Derry with this rock, most of the rotation of the rock appears to be around a single axis in one direction. In trial 1 (Figure 4.11a, Figure 4.21), the rock bounced down the slope, moving with less than 1000 dps and changing the rotational velocity with each bounce. Between 1 s and 2.7 s, the rock was rolling and bouncing. The maximum acceleration the rock experienced on the upper slope was 81.4 g, corresponding to an approximate force of 9 kN. At 2.7 s it went into free fall, and at 3.5 s it bounced off a ledge and was launched up and out,
which was observed on the video. After approximately one second of free fall, during which it was rotating around the Z axis at approximately 2000 dps, the rock glanced off the slope then fell the remainder of the way, experiencing at least 400 g deceleration and a force of approximately 44 kN upon impact with the ground. The rotational velocity data confirm that the rock moved after impact; the abrupt change in the direction of spin upon impact seen in the individual axis velocities indicate that it likely bounced backwards from its point of impact, towards the slope.

In trial 4, shown in Figure 4.22, the rock bounced and rolled down the upper portion of the slope between 0 and 3.8 s. The rotation data confirm that it was primarily rotating around the X axis, which has the highest mass moment of inertia. The highest acceleration it experienced on the upper slope was 91.5 g, corresponding to an approximate force of 10 kN. At 3.8 seconds, it fell from the overhanging rock, again experiencing a resultant rotational velocity of approximately 2000 dps, primarily due to 1500 dps rotation around the Z axis, which has the smallest moment of inertia. It hit the ground at approximately 5.8 s with a resultant acceleration of at least 600 g and a force of approximately 66 kN; again, the accelerometer exceeded its limit. The point of first impact was not observed, but the data confirm that the rock continued moving after impact.
Figure 4.21: SR data for Crawford Notch location 1, trial 1.
The top graph shows data from the ±400 g accelerometer, the center graph shows the ±8 g accelerometer, and the bottom graph shows rotational velocity.
4.8 Summary and Discussion

Translational and rotational velocities are very important for energy and impact analyses, as they are major influences on kinetic energy (equation 3, section 3.1) (Ashayer, 2007; Wyllie, 2015; Turner and Duffy, 2012a). Acceleration can be used to calculate the force at which a rock impacts a surface or a barrier (Nelson and Snowden, 2010). Being able to take direct measurements...
of rock motion can be very useful for estimating the effect a falling rock will have and for properly designing protection measures. Though the forces estimated are not corrected for the influence of gravity due to the lack of a known spatial reference system, the calculations can be used to inform models or to design a barrier for the worst-case scenario. Also, the large difference in accelerations and forces at the top of the Derry and Crawford Notch slopes compared to the forces with which the rock hit the ground could provide information on where it might be best to place a barrier, or the type of barrier that should be used.

Because of the uncertainty in the reference frame of the video analyses at the College Woods location, affecting the calculated position and velocity data, the velocities output from VideoPhysics were not used further in this research. However, the trajectory information from the video analysis was used to confirm the interpretation of rock motion from the SR data. The initiation taps performed at the beginning of each SR trial were used to correlate the two data sets, and the video trajectories nicely align with the SR data. This can be seen by the correlation of the vertical trajectory from the videos with the SR data in the College Woods results presented in Figure 4.16 and Figure 4.17. Where the videos show an impact between the rock and the slope, the SR recorded a spike in acceleration and a change in rotational velocity.

Rockfall runout and rotational velocity were the data of interest for this study, to use for calibration and comparison to modeled rockfall simulations. As discussed in Chapter 2, the rotational velocities measured by Ushiro et al. (2006) ranged from 350 dps to 1900 dps (Wyllie, 2015), while the researchers from the WSL Institute for Snow and Avalanche Research found maximum rotations between 2500 dps and 4500 dps (Caviezel and Gerber, 2018; Caviezel et al., 2018b). The results of the current research align closely with the results from the WSL Institute, despite the difference in the experimental terrain and slope heights, and are typically higher than
the numbers reported by Ushiro et al. (2006). Table 4.10 presents a summary of range of maximum rotational velocities measured at each location; in College Woods, the slowest test rock had a maximum rotation of 2006 dps, and the fastest experienced 3377 dps. Both of these were trials using rock 1, the 5 kg compact elongated rock. In Derry, as well, the trials with rock 1 experienced both the slowest and fastest rotation, while the one trial with the 11 kg compact bladed rock (rock 2) had a maximum rotational velocity of 3325 dps. Both tests at Crawford Notch used rock 2.

<table>
<thead>
<tr>
<th>Number of Trials</th>
<th>Low</th>
<th>High</th>
<th>Average</th>
</tr>
</thead>
<tbody>
<tr>
<td>College Woods</td>
<td>15</td>
<td>2006</td>
<td>3377</td>
</tr>
<tr>
<td>Derry</td>
<td>4</td>
<td>2671</td>
<td>4989*</td>
</tr>
<tr>
<td>Crawford Notch</td>
<td>2</td>
<td>2049</td>
<td>3318</td>
</tr>
</tbody>
</table>

*The SR rotation exceeded the 4000 dps capacity of the gyroscope around the Y axis.

The differences in the SR output for the two different rock shapes also agrees with results reported by Caviezel et al. (2018b). Rock 1, with a compact elongated shape, tended to rotate around multiple axes during falling and rolling. The one example reported for this rock shape by Caviezel et al. (2018b) experienced rotation between 1500 dps and 2000 dps during the fastest part of the fall, with a maximum of approximately 2200 dps, and similarly experienced significant rotation around the X and Z axes.

Rock 2, a compact bladed block, stabilized to rotate primarily around a single axis in every trial regardless of experimental location. Caviezel et al. (2018b) noted that their rocks stabilized into rotation around the “largest axis of inertia” in all of the rock shapes they tested, unless the rocks were “heavily elongated.” However, in the current study, the stabilization axis varied. In College Woods, the rock rotated around the X axis, which for this rock has the highest mass moment of inertia. This is seen in Figure 4.17 and Appendix D T11-T14. In Derry and Crawford
Notch, it stabilized around the Z axis, with the lowest moment of inertia, which can be seen in Figure 4.20, Figure 4.21, and Figure 4.22.

This appears to be a function of the type of motion the rock experienced moving down the slope. Rotation around the X axis, with the largest moment of inertia, occurred when the rock was rolling and frequently impacting the slope. This occurred in College Woods, which, like the test slope used by the WSL Institute, has a relatively gentle slope that causes the rock to roll rather than fall. Rotation around the Z axis, with the smallest moment of inertia, occurred while the rock was in free fall from the steeper slopes in Derry and Crawford Notch. This is most easily seen in Figure 4.22: the rotation axis changed from X to Z at 3.8 s, when the rock motion changed from rolling and bouncing down the upper slope to free fall.

Though the magnitudes are comparable to published values, the raw SR measurements from the 11 kg rock may not be fully accurate in describing rock motion. The SR was offset from the center of mass inside the natural rock, and this eccentricity will have affected the acceleration and rotational data. This is not explored here.

The runout distances measured for the College Woods slope were greater than originally expected. The runout area was covered in soft forest debris, leaves, and topsoil, and it is theorized that this would absorb energy and slow the relatively small rocks used for these experiments. The SR data shows, however, that even when “rolling” down the soil-covered runout zone, the rocks are in reality moving with a series of bounces, as evidenced by the regular, low-value acceleration peaks that occur each time the rock contacts the slope (Figure 4.16, Figure 4.17, Appendix D). Caviezel and Gerber (2018) found that rocks during their experiments were only in contact with the ground for 6 to 14 percent of the total rockfall time. Visual estimates of the current data in general appear to agree with this, though precise times of contact with the ground have not been
determined for these data. Average runout for College Woods was 8 m from the base of the bare rock face, and the compact bladed, 11 kg rock 2 routinely traveled farther than the compact elongated, 5 kg rock 1. The lack of contact with the soil is thought to be the reason for the relatively long travel distances.

As in experimental rockfalls performed by previous researchers, video recording and measurement of rock runout provide significant information about expected rock behavior during fall. The addition of the rockfall Smart Rock instrument during this research shows:

- Acceleration and rotational velocity data can be used to describe rock motion during rockfall.
- Maximum accelerations averaged around 200 g on a 4 m tall, 52 degree slope, but approached or exceeded 400 g after free fall from taller slopes.
- Rotational velocities averaged between approximately 2500 dps and 3700 dps for all locations, and the larger rock rotated more slowly.
- Acceleration, rotational velocity, and rock behavior results generally agree with similarly-instrumented rocks from Caviezel et al. (2018b).
5 MODELING EXPERIMENTAL ROCKFALLS

Comparisons of results from computational models developed for the three Smart Rock (SR) test locations and experimental results are presented in this chapter. Multiple coefficients of restitution were used to investigate the effect on runout, using a cross-section for the College Woods location derived from structure-from-motion (SfM) photogrammetry. The SfM model and experimental results were then compared to simulations using different representations of the slope: a manually constructed profile and two digital elevation models (DEMs) of differing resolutions.

For the Derry and Crawford Notch locations only photogrammetry data exist with which to model the surface. Profiles from these models were used to simulate rockfalls from each location to compare with experimental data from the SR.

5.1 College Woods, Durham, NH

5.1.1 Surface Models

Cross-sectional profiles were extracted from four surface models to represent the College Woods slope. These profiles are compared in Figure 5.1.

Because of the tree canopy, GPS measurements were unreliable, so the slope was measured manually; angles and heights were measured using a compass with a clinometer and a measuring tape. A local frame of reference was developed using a marked range pole as the “zero” location from which distances to other stationary markers were measured.
A second slope model was developed using the SfM methodology (described in Appendix A). Two SfM point clouds, representing the upper and lower parts of the slope, respectively, were created using the freeware software VisualSFM (Wu, 2007; Wu 2011; Wu et al., 2011) and spatially referenced using CloudCompare (CloudCompare, 2018) and SplitFX (SplitFX, 2016). The upper slope point cloud was oriented and scaled using the reference coordinates from the manual slope measurements. The lower slope point cloud was oriented relative to the upper slope using features that appeared in both data sets. The two point clouds were merged to create the single cloud shown in Figure 5.2. The upper slope point cloud is visible as brightly colored data in the right side of the figure. The lower slope, comprising the runout zone of the rockfall path in the left half of the image, is less suited for SfM 3D reconstruction techniques and has much sparser data. This is because it has few distinctive features, such as the rock face in the upper slope, for the software to recognize for image matching.

Table 5.1 indicates the error in reference measurements between measurements made in the field and the same locations measured on the model. These locations are shown as white lines on Figure 5.2. A traffic cone is placed at 10 m in the local reference frame shown in Figure 5.1. The error in the measurement of the cone, at the far left of Figure 5.2, as well as the slight tilt to
the trees at this location, are indications of inaccuracy between the point cloud and reality. Corrections for this were attempted during creation of the point cloud by the addition of supplemental images, and during spatial referencing of the cloud by careful selection of points used for alignment, but the error in the current model shown in Figure 5.2 and Table 5.1 could not be reduced further. Because the error is less than 10 cm in all measurements, it was assumed acceptable for these models relative to the approximately 22 m long slope.

![Figure 5.2: SfM model of College Woods](image)
The white dotted line shows the approximate rockfall path and the location of the cross-section extracted from the model. A 0.5 m tall orange traffic cone is visible in the runout zone at the left side of the image.

| Field measurements compared to digital measurements on the College Woods SfM model |
|-----------------------------------------|---------|-----------------|-------------|---------|
| Cone height (m) | Modeled (m) | Percent Difference | Difference (cm) |
| Cone height | 0.46 | 0.40 | 12.7% | 5.82 |
| 0.9 m on Range Pole | 0.91 | 0.93 | -1.7% | -1.59 |
| X to Range Pole | 1.69 | 1.69 | 0.2% | 0.35 |
| Pole to Pole | 1.69 | 1.61 | 4.9% | 8.30 |
| Pole to Tree Base | 6.40 | 6.37 | 0.5% | 3.00 |
The errors presented in Table 5.1 are unlikely to have major impacts on the results of the rockfall model. The nearly 10 degree difference between the angle of the measured slope and the SfM-derived profile at 15 m in Figure 5.1 could be influenced by several causes, such as this spatial error inherent in the point cloud, or inconsistencies between the path measured on the slope versus the cross-section extracted from the model. The most likely effect to the rockfall model is slightly shortened rock runout compared to the steeper measured profile. However, since this change in slope brings the SfM cross-section into better agreement with the two DEMs used in the runout zone, it is possible that this could be realistic, as discussed later in this section.

SplitFX was used to interpolate a mesh of the combined point cloud, which creates a model of the surface as presented in Figure 5.3. A cross-section was then extracted from this surface along the general rockfall path, which is approximated as dotted white lines in Figure 5.2 and Figure 5.3. The cross-section is shown in red on Figure 5.1.
The third and fourth cross-sections used to model the slope were interpolated from two DEMs. A DEM with 2 m resolution was available from the 2011 Coastal New Hampshire lidar data set from NH GRANIT (NH GRANIT, 2017). Since the steepest part of the slope is only approximately 4 m wide horizontally, this resolution only provides a maximum of two data points on the rock face. A 1 m resolution DEM of the area was also available from the UNH CAD/DMS/GIS group, which provided a more detailed surface model. The two surfaces are compared in Figure 5.4. Subtle variations in elevation can be distinguished in the 1 m DEM (Figure 5.4a), while the lower resolution of the 2 m DEM gives it a highly pixelated appearance (Figure 5.4b). 2D cross-sections were extracted from these surfaces using ArcGIS along the black line shown in the figure. The location of the range pole on the slope was recognized in the cross-sections by the change in the slope angle at which the pole was placed, as seen in Figure 5.2, and the data were laterally and vertically shifted to place this at the local coordinate (0,0).

![Comparison of the two digital elevation models for College Woods. The black line shows the location of the slope used for experiments.](image)

Large differences can be seen in the modeled profiles in Figure 5.1. The data extracted from the SfM model (red) is the most detailed and is able to show variation in the rock face that
the other profiles miss. Though the SfM profile differs slightly from the manually-measured angles, the angle of the steep rock face and the runout zone at the base of the slope agree within 6 degrees.

The 1 m DEM cross-section (green) displays a shape similar to that measured in the field and seen in the SfM, particularly the changes in slope between 0 m and 8 m. Much of this profile is less steep than was measured in the field. The 2 m DEM (blue) is smoothed compared to any of the other models and does not capture the steep upper portion of the slope. Both DEMs, which were developed separately from two different data sets, agree in the runout area of the slope, between 0 m and 20 m. The difference between these models and the manual measurements and SfM may come from both averaging due to DEM data resolution as well as from potential errors in the field measurements. The field measurements were derived from distances and angles measured on average slopes and were restricted to locations on the rock slope that were accessible on foot. Therefore, these may over- or under-predict the total slope. Since the SfM data were referenced to the coordinate system defined in the field, any error in the field measurements will also be propagated in the SfM data.

As the cross-section that most closely matched the details and variation of the rock face observed in the field, the SfM surface model was chosen for calibration using the measured rock runout distances.

5.1.2 Modeled Rocks

In order to model the rocks used for experimental trials, two simulated rocks were created in the RocFall program. Rock 1, the 5 kg compact elongated rock, was modeled as a polygon square, because it has equal dimensions on two sides (Table 4.1). A custom shape approximating the lengthwise cross-section of rock 1 was also tried in preliminary models, but attempts to recreate
the measured runout distances with this shape were unsuccessful. The mass and density were assigned to be 5.3 kg and 2660 kg/m$^3$. Rock 2, the compact bladed rock, was modeled as a polygon rectangle with the dimensional ratio of 5:6 and a mass and density of 10.8 kg and 2770 kg/m$^3$. These can be seen in simulated trajectories in Figure 5.5.

Trials with rock 2 comprised only 11 percent of the experimental trials in College Woods. The number of computer simulations for each rock was chosen to be approximately proportional to the experimental trials. A seeder was placed for each rock type at the same location on the slope, and 200 trajectories were modeled for rock 1 and 20 were modeled for rock 2.

![Figure 5.5: Examples of modeled rocks 1 (a) and 2 (b).](image)

**5.1.3 Coefficients of Restitution**

The interaction between the rock and the slope is a critical factor in determining the energy of the rock at any point along the slope and its ultimate runout. 2D rockfall models use coefficients of restitution to control the changes in energy and velocity that occur during this interaction. The coefficient of restitution chosen for a rockfall model defines the energy absorbed when a rock hits the slope, and therefore its rebound velocity and energy, bounce height, and rotational velocity, all
of which affect the rock runout distance. In modeling, these are often taken from published tables or back calculated from experimental results. To better understand how model results using traditional methods compare to actual rockfall tests, four sets of coefficients of restitution were compared using the SfM surface model. The coefficients used were:

1) Default coefficient values from the RocFall program

2) $R_E$, $\mu$, and $\mu_r$ values drawn from the published table in Turner and Duffy (2012a) and Ashayer (2007), which is included in Appendix B

3) Experimentally measured $R_E$ values for the rock slope and soil slope

4) Modified $R_E$, $\mu$, and $\mu_r$ values for the soil slope

<table>
<thead>
<tr>
<th>Color</th>
<th>Name</th>
<th>$R_N$</th>
<th>$\mu$</th>
<th>$\mu_r$</th>
<th>Source Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bedrock outcrops</td>
<td>0.35±0.04</td>
<td>0.55±0.04</td>
<td>0.15±0.04</td>
<td>RocScience</td>
<td></td>
</tr>
<tr>
<td>Talus Cover</td>
<td>0.32±0.04</td>
<td>0.55±0.04</td>
<td>0.3±0.04</td>
<td>RocScience</td>
<td></td>
</tr>
<tr>
<td>Asphalt</td>
<td>0.40±0.04</td>
<td>0.55±0.04</td>
<td>0.1±0.01</td>
<td>RocScience</td>
<td></td>
</tr>
</tbody>
</table>

1) Table 5.2 shows the default coefficients of restitution and friction and their standard deviations from RocFall that were used in this work. The dynamic friction value of 0.55 is equivalent to a friction angle of 29 degrees, which is close to the 30 degree friction angle which is often assumed for smooth joints (Goodman, 1989). There is no difference between the default values in the RocFall program when using Lumped Mass or Rigid Body analysis method. These values appear in the RocScience Coefficient of Restitution table (RocScience, 2017) as values of the normal coefficient of restitution $R_N$. The “Bedrock Outcrops” $R_N$ is similar to other values listed as boulder fields or outcrops. It is, however, lower than other reported $R_N$ values for rock
which range from approximately 0.47 to 0.53. Turner and Duffy (2012a) (Appendix B) report $R_N$ values for rock varying from 0.2 to 0.9 and values of 0.7 to 0.9 for $R_E$.

The $R_N$ value for “Talus Cover” is similar to many other reported values for soil, talus, and vegetated soil slopes, which range from 0.25 to 0.33. Only two unique values for “asphalt” or “road” are given in either table: 0.4 as used, and an $R_E$ value of 0.75 published by Azzoni et al. (1995) and reported by Turner and Duffy (2012a). Very few values of the coefficients of friction (dynamic $\mu$ and rolling $\mu_r$) are given in these tables; those in Table 5.2 are the RocFall program defaults.

2) Table 5.3 presents the $R_E$, $\mu$, and $\mu_r$ values drawn from the published table in Turner and Duffy (2012a) and their original sources. These have much higher $R_E$ and $\mu_r$ values than the RocFall program defaults, indicating that the surfaces absorb much less energy.

<table>
<thead>
<tr>
<th>Description</th>
<th>$R_E$</th>
<th>Source</th>
<th>$\mu$</th>
<th>Source</th>
<th>$\mu_r$</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Earth with grass and some vegetation</td>
<td>0.55±0.04</td>
<td>Azzoni et al. (1995)</td>
<td>0.50±0.04</td>
<td>Descouedres &amp; Zimmermann (1987)</td>
<td>0.6±0.02</td>
<td>Azzoni et al. (1995)</td>
</tr>
<tr>
<td>Rock (Limestone)</td>
<td>0.85±0.04</td>
<td>Azzoni et al., (1995)</td>
<td>0.50±0.04</td>
<td>Descouedres &amp; Zimmermann (1987)</td>
<td>0.4±0.02</td>
<td>Azzoni et al. (1995)</td>
</tr>
</tbody>
</table>

The 0.55 value chosen for vegetated earth is higher than many $R_N$ values given for soil or vegetated talus, which are generally around 0.3. The 0.85 value for rock was chosen as a middle value in the range of 0.75 to 0.9 given by Azzoni et al (1995). It is comparable to a few rock values of $R_N$ and another energy coefficient that neglects rotational velocity ($R_e$ in Appendix B). These also fall between 0.7 and 0.9, as seen in Appendix B (Ashayer, 2007; Turner and Duffy, 2012a). However, 0.85 is higher than many published values for rock of approximately 0.5. The values used for $\mu$ and $\mu_r$ are some of the few published in the coefficient table (Appendix B). The $\mu_r$ values are higher.
than the default values in RocFall. The standard deviations used are the default values from RocFall.

3) R_E values were experimentally determined for the rock slope and soil slope using the methodology described in section 3.1 and used in combination with μ and μ_r values drawn from the table published in the literature (Turner and Duffy, 2012a; Appendix B). Figure 5.6 shows one trial performed for the determination of R_E. A flat area of exposed rock (obscured from the camera view in Figure 5.6) and a flat area of soil on the College Woods experimental slope were used to perform drop tests of two rocks. Ashayer (2007) recommends using circular or curved objects when performing this experiment, so the rocks used were the 5 kg rock 1, which has a rounded base, and a small, rounded basalt cobble (rock 3, not otherwise used for experimental rockfalls). The heights for each test were measured to the approximate center of mass of the rock and were obtained from slow-motion video analysis with VideoPhysics, calibrated against the scale included in each video. The data for all tests are provided in Appendix E.

Four tests with rock 1 and three with rock 3 were averaged to obtain a coefficient of 0.31±0.02 for the soil slope, which is lower than the value used from the table of coefficients. It is comparable to the “talus cover” default setting in the RocFall program and the similar “soil” values from RocScience discussed previously.

Three tests with each rock were averaged to obtain a coefficient of 0.46±0.13 for the rock face, which is lower than the “rock slopes” estimate chosen from the table of coefficients but higher than the RocFall program default. This is comparable to many of the reported R_N values reported for rock by RocScience.
4) Values of $R_E$, $\mu$, and $\mu_r$ were modified from the experimentally estimated values by trial and error in the RocFall program, following a methodology used by Dadashzadeh et al. (2014). The coefficients of restitution and friction of the slope material were manually changed for a simulation using the SfM slope model to recreate the corrected rock runout locations measured experimentally (Figure 4.15). The runout distances for both experimental rocks were used together, rather than modeling both individually; this was accounted for by the proportional number of rocks modeled from each seeder. It was not possible to simulate the ending locations with the slope model exactly as it was output from the 3D model, because the large number of points composing the cross-section interfered with the trajectory simulation and artificially stopped the modeled rock by exceeding the time or computational limits set in the program, skewing the results. Therefore, the cross-section was simplified to use only 20 percent of the original points, which kept the shape of the slope but smoothed out small irregularities in the profile, as shown in Figure 5.1.

Experimentation with both the rock and the soil coefficients of restitution and friction indicated that for the College Woods slope, the slope soil had a much stronger influence on the runout distance than the actual rock face. Therefore, the rock coefficients were not modified, and
were a combination of the experimentally determined value of $R_E$ and values from the literature of $\mu$ and $\mu_r$.

The experimentally measured value of $R_E = 0.31$ for the soil was increased to 0.36. The value of $\mu$ was decreased to 0.31, much lower than 0.55 used by RocScience. This is equivalent to a friction angle of 17 degrees, which is much lower than values typically reported in the literature and is likely unrealistic (Goodman, 1989). While these brought the endpoint locations into general agreement with the experimental data, the modeled behavior of the rock during the fall is inconsistent with what was observed in the field. Though bounce heights were not recorded during the experimental rockfalls, the bouncing of the rock to heights greater than a meter was not observed in the field. On a few occasions, the rock hit an obstruction and bounced significantly, such as during Trial 4 when it bounced off of a tree root, but otherwise some of the bounce heights suggested by the model are not realistic for this slope. The lower coefficient of friction also caused the simulated rocks to slide at times, rather than rolling as was observed experimentally, supporting the conclusion that this is not a realistic value.

Table 5.4 summarizes all of the coefficients used for the four comparison models. Unlike the models presented in Chapter 3, the “tangential damping” feature in RocFall that takes $R_T$ into account was not used for any of these models. The modeled runout results fell short of the experimental runout, and the inclusion of $R_T$ greatly increased this disparity. Though $R_T$ was included by others such as Dadashzadeh et al. (2014) in their comparison of analysis methods, it is not necessary for rigid body analysis (Ashayer, 2007). $R_T$ was not used in these models to attempt better agreement with the experimental data.
Table 5.4: All coefficients used for modeling the College Woods slope.

<table>
<thead>
<tr>
<th>Coefficients</th>
<th>Rock</th>
<th>Soil</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>( R_E )</td>
<td>( \mu )</td>
</tr>
<tr>
<td>Default</td>
<td>0.35</td>
<td>0.55</td>
</tr>
<tr>
<td>Literature</td>
<td>0.85</td>
<td>0.5</td>
</tr>
<tr>
<td>Experimental</td>
<td>0.46</td>
<td>0.5</td>
</tr>
<tr>
<td>Modified</td>
<td>0.46</td>
<td>0.5</td>
</tr>
</tbody>
</table>

5.1.4 Results

220 total rocks were simulated in each rockfall model, as described previously. For comparison between different simulations and to experimental results, the trajectories from each simulation are displayed on each modeled slope. Trajectory end points representing rock runout are displayed in histograms and summarized to show the average and maximum stopping points for each model. In each simulation, a significant portion of the rocks remained at the seeder location: approximately 30 percent for each of the models using the SfM-derived slope, up to 50 percent for the slope from the 1 m resolution DEM, and 100 percent of simulations for the 2 m resolution DEM cross-section. This behavior is realistic; in the experimental trials, friction held the rocks in place unless they were oriented upright to force them to fall. However, for direct comparison to the experimental results that did not incorporate stationary rocks, the rocks that remained on the slope were removed from the histograms. The exception to this are the results of the 2 m DEM rockfall model, because all of the modeled rocks were essentially stationary. Results are displayed as percentages of the number of rocks in each model that fell down the slope.

The RocFall program can calculate bounce heights, energies, and velocities for all simulated trajectories. The average rotational velocities were output along the length of the slope for all College Woods models and are compared to SR results from the rockfall experiments.
5.1.4.1 Comparison of Coefficients of Restitution – Trajectories and Runout

Figure 5.7 presents the trajectories for each set of coefficients of restitution used for modeling. The trajectories presented in Figure 5.7 vary between models. Figure 5.7a shows the trajectories from the rockfall experiments determined through video analysis. Due to the limited field of view of the camera, only the trajectory down the rock face was recorded. Using default coefficients of restitution (Figure 5.7b) predicted that the rocks will remain close to the slope, with some sliding on the upper rock slope and low bouncing and rolling down the soil slope. The higher $R_E$ values from the table of coefficients of restitution (Turner and Duffy, 2012a) used for the rock and soil in (c) caused higher bounces off the rock and significantly higher bounces off the soil. Multiple trajectories are modeled to have bounce heights of up to 2 m down the length of the soil-covered runout zone.

The model using experimentally derived $R_E$ values (d) predicts trajectories similar to those from the case with default coefficients, which remain low and close to the slope. However, bouncing and rolling takes the rocks further down the runout zone than the model with default coefficients. Where the $R_E$ and $\mu$ coefficients were modified in an attempt to model the observed runout in (e), rocks do roll out farther than with default or experimentally derived coefficients, but the bounce heights increase to more than 1 m for a few trajectories, and sliding begins to occur. The flattened ends of several trajectories show this at approximately 8.5 m and 14 m; because each trajectory follows the center of mass of the rock, the uniform height of the line suggests that the rectangular blocks are not rolling.

On Figure 5.8, the end point locations from each modeled trajectory, representing runout values, are displayed as the midpoint values of histogram bins that are 0.98 m wide. These are summarized in Figure 5.9, which shows the average and maximum runout locations ($\pm 0.5$ m) that
Figure 5.7: Trajectories modeled using varied coefficients of restitution. Red paths represent rock 1, and green paths represent rock 2.
were predicted with each set of coefficients of restitution. These graphs show that the runout from the model using coefficients from the literature (Table 5.3), in black, agrees most closely with the experimental results (red). This is despite attempts to measure the coefficients (green) and modify them by back calibration (yellow). All of the models predicted the rocks to stop sooner on the slope than was experimentally measured. This could be influenced by the slope angles that are slightly shallower than measured. In all models, the rock ending locations are distributed through the runout zone.

Both the RocFall default values and a combination of the measured $R_E$ and $\mu$ and $\mu_r$ drawn from the literature predicted that the rocks would stop at a shorter distance than was measured in the field. Modification of the soil $R_E$, $\mu$, and $\mu_r$ values did bring the modeled runout closer to the experimental measurements. In the experiments, 27 percent of the rockfall experiments rolled out past 10 m, which were not accounted for in these two models.
Figure 5.9: Average and maximum rock path ending locations, College Woods comparison of coefficients. End paths are estimated to ±0.5m.

Despite the relatively close agreement in calculated runout distances between the coefficients taken from the literature and the actual measured runouts, the trajectories displayed in Figure 5.7c, using the restitution coefficients from the literature, are significantly different than what was observed in the field. The trajectories predicted for both rocks show bounce heights in the runout zone, which is composed of soft soil, of up to 2 m. Observations in the field confirm that these results are unrealistic, as demonstrated in the trajectories on the upper portion of the slope presented in Figure 5.7a and Appendix C. During field tests, the test rocks remained close to the slope for most of the runout zone unless they hit an obstacle. The few high bounce heights in Figure 5.7e, using modified coefficients, may be reasonable given that this was observed in at least one field test (T4).

Another inconsistency with field observations is that in all modeled simulations, the smaller 5 kg rock, shown in red on Figure 5.7, runs out farther than the larger 11 kg rock 2. The
opposite occurred in the field: the average runout for rock 2 was 72 percent longer than the average runout for rock 1, which is clearly seen in Figure 4.14 and Figure 4.15.

5.1.4.2 Comparison of Coefficients of Restitution – Rotational Velocity

Figure 5.10 compares the rotational velocities modeled along the slope for each of the simulations using the SfM surface model and varying the coefficients of restitution. Note that the coefficients of restitution used for the slope between -4.0 m and -0.6 m are identical for the models with experimentally determined (“measured”) and “modified” coefficients. In black and grey are the average, maximum, and minimum experimental data output from the Smart Rock (SR) for the approximate horizontal location. The experimental data, which contain no inherent location information, were placed at their approximate horizontal locations based on correlations between the recorded SR time, the time from video analysis and the known locations of markers on the slope, and interpolation to the known ending location of the rock. Data points were chosen every 10 cm along the slope. The colored lines showing model output begin at the drop location of all of the rocks (±0.5 m). The SfM slope profile is shown on the graph for reference.

All of the RocFall simulations approximately fit the experimental data when the rock is falling down the steep rock face, between -4.0 m and 0 m. All of these also poorly fit the experimental data at the end of the slope between approximately 6 m and 16 m, because the RocFall output averages the trajectories of the simulated rocks that pass a given location. It is therefore affected by the few fast-moving rocks that ran out toward or kept moving past the end of the slope where the slower-moving rocks have stopped and are no longer accounted for. This effect was seen in all models in this study, and a possible correction is explored further in section 5.3 for a model from Crawford Notch, where the discrepancy is very pronounced. The model using restitution coefficients from the literature has rotational velocities that remain high and then
increase at 14 m because several quickly-rotating trajectories continued moving past the edge of the model (Figure 5.7c). It overestimates the average rotational velocities, particularly for the runout zone of the slope. This correlates with the excessive bounce heights seen in the trajectories in Figure 5.7 and suggests that the $R_E$ value used for the soil slope is too high, leading to an overestimation of the energy retained by the rock upon impact.

The simulation using the experimentally measured $R_E$ values predicts average rotational velocities in the higher range of what was measured for the soil slope, but in general it agrees with the SR data. The simulation using the modified coefficients underestimates the average SR data, particularly at the fastest area of the slope just after 0 m. However, this predicts reasonable values for a longer section of the slope, possibly because the average runout distance was closer to the runouts measured in the field.
Figure 5.10: Comparison of measured and modeled rotational velocity with changing coefficients of restitution, College Woods
5.1.4.3 Comparison of Slope Models – Trajectories and Runout

Figure 5.11 presents the trajectories output from multiple surface models used to represent the slope. All models used the “modified” coefficients of restitution from the analyses described in section 5.1.3.

Figure 5.11a represents the SfM model examined in section 5.1.4.1, which shows the rocks bouncing and rolling down the slope. The trajectories shown in Figure 5.11b-d, showing the cross-sections from the manual measurements, 1 m resolution DEM, and 2 m resolution DEM respectively, lay along the slope. Note that the location of the rock-soil boundary shifts slightly between models due to the position of the vertices that define each slope, which limit where the slope type may be changed. In the models using the manually defined slope (b) and the 1 m resolution DEM (c), the rocks slid down the slope with little rotation, which can be observed by the smooth, flat trajectories. In all models, again the simulated 5 kg rock 1 traveled farther than the 11 kg rock 2. The lack of motion of the rocks on the 2 m resolution DEM rockfall model is shown by the lack of red or green lines on Figure 5.11d. The 2 m DEM results indicate that the modeled rocks did not move far from the starting location.

Clearly from Figure 5.11, the SfM slope model produces results that most closely represent what was observed in the field. As the coefficients of restitution used were identical and the slope angles were similar for three of the four cross-sections, the difference in slope roughness represented in each model can explain the large discrepancy between trajectories. Even the simplified SfM cross-section has many more vertices than the other profiles, as can be seen by the points along each line in Figure 5.1. This gives this slope model much more variation and greatly influences the simulated rock trajectories.
Figure 5.11: Trajectories modeled on differing surface models. Seeder locations are represented by blue crosses. Red paths represent rock 1, and green paths represent rock 2.
In an attempt to better simulate rock motion, the surface roughness variation feature of the RocFall software was applied to the cross-sections from both the manual and 1 m DEM surface models, as shown in Figure 5.12. The cross-section from the 2 m DEM was excluded, because preliminary investigation indicated that the simulations would again remain stationary. Figure 5.12a shows a single trajectory on the manual slope with a roughened slope profile. Figure 5.12b and (c) show all trajectories and slope profiles used for the manual and 1 m DEM cross-sections, respectively. For both models, a spacing of 0.5 m was used between variations with maximum amplitudes of $\pm 0.3$ m from the original slope surface. Both spacing and amplitude were decreased from the RocFall default values to avoid unrealistic slope variations.

Including slope roughness variation in the simulation produced much more variance in the rock trajectories as well as rock motion that was more similar to the rock behavior in the field tests. The runout results of the unaltered manual slope model and the roughened model are compared in Figure 5.13: the runout from the original, smooth slope cluster around 9 m, while the runout from the trajectories on the variable, rough profiles are distributed throughout the runout zone, though most stop more quickly on the slope. The average end location of the experimental results was approximately 8 m; here, the runout from the original slope was closer to the experimental average, but the rock motion and the distribution of end locations is more realistic when the slope has more variation.

The rockfall models using the manual and 1 m DEM cross-sections with variable roughness are used in Figure 5.14, which presents the runout distributions from the four varying slope models, and Figure 5.15, which summarizes the results.
Figure 5.12: Example of slope roughness variation applied to manual and 1 m DEM profiles.
Figure 5.13: Comparison of runout results for College Woods with and without added slope roughness

Figure 5.14: Modeled rockfall runout using varying surface models, College Woods

The histogram bin representing the seeder location is marked with a black cross. End paths are estimated to ±1 m except for the 2 m DEM, which is offset due to model limitations. Rocks stuck on the slope are excluded except for the 2 m DEM.
Figure 5.15: Average and maximum rock end path locations, College Woods slope model comparison

End paths are estimated to ±1 m except for the 2 m DEM, which is offset due to model limitations. Except for the 2m DEM, averages do not include rocks stuck on the slope.

The rock path end point locations displayed for the Figure 5.14 histogram and the averages in Figure 5.15 are approximate to ±1 m, except for the 2 m DEM. The output from the RocFall program bases the histogram bin widths on the length of the modeled slope, so while histogram bins were chosen to remain approximately the same for each slope, the values varied slightly with the changes in the amount of available data. The values chosen for display represent the results from the field experiments and the SfM models. By 8.5 m the discrepancy in bin sizes adds 0.5 m to the location of the manual slope runout, so the “8.5 m” bin represents the rocks that stopped between 8.5 and 9.5 m on the manual slope model. The results for the 2 m DEM slope were most greatly affected by the bin size discrepancy at the beginning of the slope, which ultimately placed this data on the graph at a bin value slightly before the actual seeder location, which is shown as a black cross on Figure 5.14.
The cross-section from the SfM model (yellow on Figure 5.14 and Figure 5.15) agreed most closely with the experimental results (red). The runout results from the 1 m DEM (black) cluster within 2.5 m of the zero point, much shorter than the measured runout values, despite the additional variation to the cross-section created by the slope roughness tool. The results from the manual slope (green) are distributed across the runout zone, but the average just after 5 m is short of the experimental results that peak between 4.6-8.5 m and 12.4 m. Rocks simulated on the slope from the 2 m DEM did not move far from the seeder location.

5.1.4.4 Comparison of Slope Models – Rotational Velocity

Figure 5.16 compares the rotational velocities simulated by varying the rock slope model to those measured in the field using the SR. The SR data are approximately placed at their horizontal locations as previously described for Figure 5.10. The results for the manual and 1 m DEM slopes shown here come from models using variable surface roughness. The original unvaried slope model results are excluded, as the rotational velocities produced were below 200 dps for most of the slope, much lower than the measured values. The 2 m DEM data are excluded from this graph entirely due to lack of data. The SfM slope profile is shown on the graph for reference.

The average rotational velocities from the SfM model underestimate the SR data at the fastest part of the slope, as previously discussed, but fall within the measured range of values. The average results from the manual cross-section are lower than both the SfM-based model and the experimental average, but they are within the measured data range for most of the slope. This correlates with the shorter runout distances predicted by the manual model, shown in Figure 5.15. As in Figure 5.10, the modeled results overestimate the rotational velocity at the end of the slope due to the decreasing number of simulations included in the average, which causes a large
Figure 5.16: Comparison of measured and modeled rotational velocity with changing surface models, College Woods
difference in the data trend towards the end of the runout zone. All of the experimental data showed that the rotation of the rock slowed as it moved through the runout zone; the modeled data is skewed by a few fast-moving simulations, causing a misleading increase in rotational velocity at the far end of the slope.

The average rotational velocities from the 1 m DEM slope, even with the slope roughness varied to mimic higher resolution data, are not close to the experimental rotational velocities. The trajectories from this model stop much earlier than the real rocks, as seen in Figure 5.15. The correlation of the abrupt decrease in rotational velocity after the change from rock to soil suggests this is due to the soil surface model; in Figure 5.12c, the variations in the soil surface caused by the roughness tool exceed the bounce heights of the rocks, creating obstructions that slowed or stopped the simulated rock motion. This surface model has a lower slope than the SfM or manual models, so that the falling rock begins with less energy; this may be a contributor to the differences in trajectories and rotational velocities seen between the slope models.

5.1.5 Summary from College Woods

Comparing computer simulations to measured experimental data clearly shows that the detailed surface model created using SfM methodology most closely simulates experimental observations for the slope in College Woods. The progression from a SfM cross-section to a manually-measured slope and 1 m resolution DEM to a 2 m DEM shows progressively worse fit between the model and the experimental results as the data resolution gets larger. Further work with slope roughness variation, adjustment of the coefficients of restitution, and potentially different rock shapes in the rigid body model might possibly bring the manual slope and the 1 m DEM into better agreement with the measured data.
The choice of slope representation had the largest effect on the model. Variance of the coefficients of restitution changed the average runout, but all models using the SfM-derived cross-section approximated the motion of the rocks seen in the field. The manual model was able to approximate realistic rock motion when the RocFall slope roughness variability tool was used, but did not accurately represent measured runout. The general tendency of all models was to underestimate the runout distances, particularly for the heavier rock. Changing the modeled rock shape is a potential way of increasing the accuracy for this rock; however, in agreement with the results of Caviezel et al. (2018b) the SR data show that the rock tends to rotate around the side with the largest moment of inertia, so the rectangular shape currently modeled is more accurate to reality than would be a square or circular shape.

Results from the model using coefficients chosen from the literature most closely align with the measured runout values. Though it overestimates rotational velocities in the runout zone, the discrepancy between the modeled average and the highest measured values is less than 500 dps for much of the lower slope. However, the trajectories overestimate bounce heights, which agrees with observations about the limitations of 2D rockfall models by Wyllie (2015).

The underestimation of runout and overestimation of bounce height agree with the conclusions of other authors regarding problems with output from 2D models (Pierson et al., 2001; Wyllie, 2015). Even with calibration to field data, error exists in the models. However, the SfM model, derived using cell phone pictures and a manually-measured spatial reference frame, is used here to output results quite similar to those measured in the field. Using the default coefficients in RocFall underestimated total average runout by 4 m, which is approximately 26 percent of the maximum measured runout. However, the average rotational velocities predicted fall within the measured range, as seen in Figure 5.10. Choosing values more specific to the surface material from
the tables of coefficients published in the literature produced runout values very similar to those measured. Choosing an $R_E$ value for the soil slope that is closer to the many published values of $R_N$ around 0.3 might decrease the overestimation of rotational velocity that is seen in this model. These two models show that simulations using a slope model produced with readily-available equipment and software and restitution coefficients from the literature are able to output results approximating those measured during field experiments.

5.2 Derry, NH

5.2.1 Surface Model

Figure 5.17 shows a 3D point cloud created for the new Derry rock cut using SfM. The rock cut is roughly 15 m tall with a slope angle of approximately 70 degrees. The images and known control points for model orientation were provided by Neil Olson at the NHDOT, and the model was developed using the procedure described in Appendix A. A mesh surface was interpolated using SplitFX and a cross-section extracted for rockfall modeling, which is shown on Figure 5.17 as a white line. Because this profile only shows half of the rock-lined ditch below the rock cut, the full ditch was approximated in the cross-section by mirroring the existing profile and confirming the dimensions against field measurements. The local zero location from which rock runout was measured was set to the base of the rock face.

Two sets of coefficients of restitution were used to develop two RocFall simulations of the Derry rock cut, which are listed in Table 5.5. $R_N$ and $R_E$ were used interchangeably, as previously discussed. The first set of coefficients is drawn from the default values in RocFall as well as the table of coefficients from RocScience. As discussed earlier, the “bedrock outcrops” $R_N$ value is
relatively low for rock, but the “talus cover” and “soft soil” values, 0.32 and 0.3, respectively, are typical of coefficients reported for these materials.

The second set of coefficients is taken from the table published in Turner and Duffy (2012a) and included in Appendix B. They were chosen based solely on their description in the table to match the materials present at the test slope. The rock $R_E$ value is the same as was used for College Woods, and relatively high but within the reported range for rock. The 0.62 and 0.6 values for “coarse angular debris” and a “flat surface of artificially compacted ground” are much higher than the default values for talus and soft soil, meaning less energy is absorbed. These values were reported as $R_E$ by Azzoni et al. (1995) and are accompanied by the rolling friction ($\mu_r$) coefficients used here as well. These are also significantly higher than the default values. This is not expected to have a large impact on the model, as the rectangular and square blocks “roll” in a series of bounces rather than maintaining contact with the surface, where $\mu_r$ would come into effect.
For the model of the rock cut in Derry, there were too few experimental trials to attempt calibration of the model against the experimental runout. 50 trajectories of each of the simulated rocks 1 and 2, as previously described, were dropped from the same location on the simulated slope.

### 5.2.2 Results

RocFall models showing a single cross-section with a ledge that forms a launch point are presented in Figure 5.18. The ending locations of these trajectories are shown in Figure 5.19, accompanied by the end locations measured from the rockfall experiments at this location approximated in red. Bins for the histograms used here are 0.52 m wide. For this slope, the default coefficients of restitution available in RocFall better approximate the rock motion observed in the field than the values chosen from the table of coefficients. The model using default coefficients, Figure 5.18a, predicts that most rocks will first impact the ground in the ditch before 2.5 m and will remain relatively close to the ground during runout. The rock path end locations from this model, shown in Figure 5.19a, calculate that roughly 50 percent of the simulations will continue more than 2 m past the ditch. The second model, using restitution coefficients from the literature,
predicts bounce heights up to 5 m high, which can be seen in Figure 5.18b. More than 60 percent of rocks in this model continue farther than 2 m past the ditch, shown by the high histogram bar at 6 m on Figure 5.19.

In comparison, five of the seven experimental trials were contained to within 0.2 m of the ditch. Only one trial, representing 14 percent of the data, continued more than 2 m past the far end of the ditch. Video recordings show that when the test rocks bounced from the rock face, they continued a downward trajectory and first impacted the ground before the lowest point of the ditch. The rocks did not rebound significantly after impact with the ground; most remained close to the surface. The highest bounce after ground impact was less than 1 m. This rock motion is more closely represented by model (a) using default coefficients of restitution, which predicts trajectories that remain close to the slope, compared to the very high bounce heights from model (b). In both computational models, rocks were more likely to stop before or run out further than the experimental rock end points, which are shown in red on Figure 5.19b.

Figure 5.20 presents the rotational velocity data output from the experimental trials with the SR compared to average values from the computational models. This graph shows all four trials using the SR, with time from the SR used as a proxy for the position of the test rock on the slope because no location data are available for the experimental trials. Despite the differences in the rock movement observed on video and the modeled trajectories, the predicted average rotational velocities during free fall are close to what is observed using the SR.
Figure 5.18: Trajectory simulations for the Derry rock cut.
a) Using default coefficients of restitution (see Table 5.5). b) Using coefficients reported in the literature (Table 5.5, Turner and Duffy, 2012a, Appendix B). Red trajectories represent the 5 kg simulated square rock 1, and green trajectories represent the 11 kg simulated rectangular rock 2.
Figure 5.19: Output from RocFall showing rock ending locations for Derry simulations.

a) Using default coefficients of restitution.  
b) Using coefficients reported in the literature (Ashayer, 2007, Appendix B). Red lines approximate the measured experimental SR end points for all trials.
Free fall can be identified in all of the data sets in Figure 5.20 where the rotational velocity is constant. The modeled data, because it is averaged from 100 simulations, does not show peaks in rotational velocity representing impacts with the slope. These are visible in the SR data accompanied by a shift in the rotational velocity. The average rotational velocities predicted by both models in free fall, from approximately -5 m to -1 m, are between 1750 dps and 2000 dps. The SR trial with the 11 kg rock is very similar at about 1750 dps during free fall between 1 s and 3 s. Other measured velocities in free fall range from 1000 dps to nearly 3000 dps, indicating that the predicted 2000 dps average is very reasonable.

After impact with the ground, the SR measured increased rotation in all trials, up to or exceeding 4000 dps, as the rock bounced. The averaging applied to the modeled data mutes any extremes that might have occurred in individual simulated trials, but there is an increase visible in Figure 5.20 once the rock impacts the ground, and the rotation gradually climbs to 3000 dps. However, though 3000 dps is comparable to measured rotations immediately after ground impact, after the first bounce off the ground the SR recorded a decreasing trend in rotational velocity in all four trials. The increasing rotational velocity suggested by the models is a result of the large number of simulations that ran out past the edge of the model; rocks that were rotating more slowly appear to have stopped closer to the rock cut, so the average rotational velocity increased as the number of simulated trajectories averaged decreased. While it is possible that between 2 m and 6 m a few rocks might reach the rotational velocities predicted by the model, based on the experimental data from the SR, it is unlikely that many would do so. The sharp drop in modeled average rotational velocity at approximately 6 m indicates the edge of the modeled data and corresponds with the large number of rocks “ending” at this location in Figure 5.19.
Figure 5.20: Comparison of average modeled values to measured rotational velocities, Derry
5.3 Crawford Notch, Hart’s Location, NH

5.3.1 Surface Model

The photogrammetry model of rock cut 110 at Crawford Notch from the NHDOT was used to model the slope for rockfall simulations. The rock cut at this location is up to 29 m tall with a variable slope, in some places overhanging the roadway. A mesh surface was interpolated for the 3D point cloud in SplitFX and cross-sections were extracted for use in RocFall. Figure 5.21 shows the locations of both cross-sections used to model the two Crawford Notch experimental drop locations.

For comparison to the experimental results obtained using rock 2, the 11 kg compact bladed rock, 50 trajectories were calculated for each experimental location using the rectangular simulation of rock 2 described previously. Due to tree cover in the photogrammetry model that no longer existed when the SR rocks were dropped, the cross-section used for location 2 is shorter than the actual slope and does not depict the drop point used for field experiments. Unlike previous models discussed, which had rocks start with zero velocity at the surface of the slope, to simulate that the rock was in motion when it reached the start of the modeled data, the rock starting location in the location 2 model was placed 0.75 m above the surface. It was given an initial velocity of 1 m/s in the horizontal direction and -1 m/s in the vertical direction.

Default coefficients of restitution, as described in section 5.1.3, were used to model the bedrock slope and asphalt roadway at both Crawford Notch locations.
5.3.2 Results

Figure 5.22 and Figure 5.23 show the modeled trajectories for each of the two experimental locations, with the measured rock ending points shown in red on each figure. With only two experimental rockfalls per location, it is not possible to draw definite conclusions from these figures, but in both cases, modeled results do predict that some simulations will land in the same approximate locations as the experimental trials. At location 1, one of the experimental rockfalls was observed to bounce off the barrier placed on the center line of the road, at approximately 7 m from the base of the slope. This suggests that without the barrier, it would have traveled farther. Therefore, the modeled prediction from both locations that many rocks will travel across the roadway cannot be discounted.
Figure 5.22: Trajectory model and rock path end points for Crawford Notch location 1.
SR rock end points are shown in red.
Figure 5.23: Trajectory model and rock path end points for Crawford Notch location 2. SR rock end points are shown in red.
Based on video from the Crawford Notch experimental trials, some of the bounce heights predicted by both models are probably high. The bounce after the rock hit the roadway was visible over the approximately 1 m tall concrete barrier on the road in only one trial. It is therefore unlikely that many rocks would reach heights of 2.5 m after impact, as predicted by the computational models. This suggests that the energy coefficient of restitution in use for asphalt in the simulation may be too high. Some modeled trajectories predicted that the rocks would remain closer to the ground surface, which is more reasonable based on the field experiments. In one field test, the test rock actually penetrated the asphalt, which is not accounted for in the computational model.

Figure 5.24 and Figure 5.25 present average rotational velocity data for each simulated location from Crawford Notch compared to the measured rotations for the one successful SR test at each location. Time is used as a proxy for horizontal location on the slope for the SR data. Though the time and location data cannot be inferred to overlap exactly as depicted, in Figure 5.24 the average rotational velocities correlate well with the measured SR data. In free fall at location 1, the SR experienced rotational velocities of approximately 400 dps, 2000 dps, and 3400 dps. Based on these numbers, the average modeled values between 1000 dps and 2000 dps during the time the simulated rocks are in free fall, between approximately -4 m and 4 m, appear reasonable.

In Figure 5.25, showing the measured and modeled rotational velocity results from location 2, the data again correlate well while the rock is on or falling from the slope. On this plot, the average result from RocFall is shown as a solid red line. The impact of the rock with the ground is labeled for both the SR data and the simulated results. Here, the averaged model data show the impact more clearly than at location 1, because the rock trajectories are less variable, as seen in Figure 5.23. Both the measured and modeled data show rotational velocities increasing from 0 to 1500 dps when the rock is rolling down the slope, then reaching 2000 dps in free fall.
Figure 5.24: Comparison of averaged modeled versus measured rotational velocity, location 1 Crawford Notch
Figure 5.25: Comparison of average modeled versus measured rotational velocity, location 2, Crawford Notch

The data sharply diverge on impact with the ground; the SR shows that the rock experienced a large decrease in rotational velocity after impact, which continued in a decreasing
trend until the rock stopped moving. The modeled data predict a large increase in rotational velocity after impact with the ground, until the average exceeds 4000 dps. Like previous models, this is due to the decreasing number of trajectories accounted for in the average allowing a few quickly-rotating rocks that travel this distance to increase the average rotational velocity. To attempt to correct for this, the dashed red line shows the average if all rock trajectories, including those that do not reach the location, are included in the calculation. The standard RocFall output, as has been shown in all models in this research, averages only those rocks that pass the location of interest. At 2 m, 43 out of the 50 simulated rocks are included in the average; some having stopped on the upper portion of the slope. At approximately 10 m, only 20 rocks are included in the average by the RocFall software. By including the results of all 50 simulations, the dashed line on Figure 5.25 may provide a more realistic view of the rotational velocity of a rock at any one location, though it is a less conservative approach. The rotational velocities in this plot are lower than the standard model output because of the inclusion of the “zero velocity” trajectories. This also does not show the rock behavior such as free fall as the other two data sets do, due to the smaller number of data points used to create it. However, the calculated average rotational velocities remain in general agreement with the measured SR data from the single experimental trajectory. Because it is expected that some rocks would continue to run out farther than was observed in the experiment, the rotational velocities after the impact with the ground remain high, but the decreasing trend observed in the corrected data is more realistic, compared against experimental observations, than the increase seen in the standard model output.

The accuracy of the predicted rock path end locations in these models cannot be determined from the available data, except to say that they do not disagree with the few available experimental tests. Though basic models were run with default coefficients of restitution, the rotational
velocities predicted in general agree with measured SR data. As in College Woods and Derry, the
accuracy of the modeled rotational velocities from the standard RocFall model output after the
simulated rock reaches the bottom of the slope are in doubt. The model predicts much faster
velocities than were observed, but given the limited experimental data, it may be possible for some
rocks. A manual correction of the data to include rotational velocities from all simulated rock
trajectories, including those no longer moving at a given horizontal location, shows somewhat
better agreement with the experimental data and provides a more realistic view of potential rock
motion.

5.4 Summary

2D rockfall models were created for the rock slopes in Durham, Derry, and Hart’s Location,
NH that were used for Smart Rock experiments. The results of the computational models were
compared to experimental data in order to determine if readily-available digital data, such as
photogrammetry point clouds and digital elevation models, could be used to accurately simulate
rockfalls. The effects of using coefficients of restitution from multiple readily-available sources
were also investigated. Experimental data used for calibration and comparison included measured
rock runout, approximate observed trajectory bounce heights, and the measured rotational velocity
of the test rocks. From these models and comparisons, it is shown that:

- Photogrammetry models created with readily-available resources that represent the shape
  and roughness of the slope of interest simulate rockfalls with realistic motion of the rock.
- Models created using the default coefficients of restitution in the RocFall program can
  predict realistic rock motion and rotation, as seen in models of all three locations when
compared to field observations. However, in College Woods the predicted runout using default coefficients was shorter than the field tests.

- The coefficients of restitution chosen from the table reported by Turner and Duffy (2012a) predicted runout similar to the experimental data in College Woods but unrealistically high bounce heights in College Woods and Derry.

- When rock motion is realistic in a rockfall model, even with unrealistic bounce heights, the average predicted rotational velocities approximate those measured by the Smart Rock.

- On the scale of the College Woods slope, the available digital elevation models have resolution too low for use in rockfall modeling.

The average rotational velocities output from the RocFall models in all locations deviated from the experimental data at the end of the slope. This is a limitation of the standard RocFall model output; the average value takes into account only those simulated trajectories that pass a given location. While this provides an indication of the velocities that a rock passing this location may have, it gives a misleading idea of the probability of its occurrence. Based on the observed experimental data from all three locations, the probability of rocks reaching the modeled rotational velocities in the run out zone is likely to be small. As shown in Figure 5.25, a manual correction can be applied by extracting data from the model at points along the slope and recalculating the average to include all trajectories, including those that have stopped prior to reaching a given point. This should be applied with care, however. The standard RocFall output can be used to provide a prediction of the worst-case and most conservative scenario, particularly if maximum values are used instead of averages. By manually averaging in the “zero velocity” trajectories, a more realistic trend is shown, but this provides less conservative numbers.
6 SUMMARY AND CONCLUSIONS

6.1 Summary

The objectives for this research were to investigate the use of readily-available digital data, including digital elevation models and a simple photogrammetry methodology, for use in modeling rockfall from rock cuts and to demonstrate the functionality of a Smart Rock for rockfall analysis.

To achieve this objective, this research examined:

- How variations in surface model resolution and roughness from readily-available digital data impacted the simulated rock runout from a rock cut.
- How acceleration and rotational velocity measurements from a falling Smart Rock can be used to characterize the motion of the rock.
- How rock runout and rotational velocity predicted by 2D rockfall models using common choices for coefficients of restitution compared to measured rockfall data.
- How the variations in surface model resolution and roughness from readily-available digital data affected the simulated rock runout and rotational velocity in comparison to measured rockfall data.

Rockfall models created using digital data sets of varying resolutions were compared to each other for existing rock cuts in Londonderry and Woodstock, New Hampshire. Four slope models representing a natural rock slope in Durham, New Hampshire were also compared to experimental rockfall data that used a Smart Rock to measure acceleration and rotational velocity. Smart Rock data were obtained from experimental rockfalls in Derry and Hart’s Location, New Hampshire and used to characterize the rock motion during fall, and then compared to basic rockfall models. Video recordings, measured rock runout, and Smart Rock data were obtained for
each experimental location for analysis and comparison to the Durham, Derry, and Hart’s Location rockfall simulations. The coefficients of restitution used to model the rock slopes were varied for two models, to compare the effects of common choices of coefficients to experimental data.

### 6.2 Conclusions

The following conclusions can be made or confirmed with this research:

*Comparing high-resolution and lower-resolution surface models in computational rockfall simulations produced variable results:*

- The similarity of the average and maximum runout results from high- and low-resolution models in Londonderry and Woodstock, NH suggest that DEMs could be used for modeling of rock cuts of similar size to these.
- For small slopes, such as College Woods, with topography that is smaller than the resolution of available DEMs, the DEMs are insufficient for rockfall modeling.
- Slope profiles from basic SfM photogrammetry surface models were successfully used to model rockfall in College Woods and Derry, NH.
- Predicted rock motion during fall differs greatly between models with low and high resolution.

*Tests of the rockfall Smart Rock were successful:*

- The rockfall Smart Rock, placed inside a real rock, accurately records the acceleration and rotational velocity of the falling rock.
- Acceleration and rotational velocity from a Smart Rock can be used to describe the motion of a rock throughout its fall down a slope.
- A Smart Rock can be used to verify modeled rock motion and rotational velocity.
Variations in model parameters and slope model resolution often output runout and rotational velocity results comparable to experimentally-measured data:

- When used with a slope model that accurately represents the real slope, coefficients of restitution carefully chosen from the literature to represent the slope materials can be used to model rock runout with reasonable precision.
- If rock motion in a 2D rockfall model is realistic to what is expected in the field, including falling, bouncing, and rolling to approximately correct runout distances, the predicted rotational velocities will also likely be realistic.
- Accurately recreating rock runout may cause unrealistically high rock bounce heights.
- Choosing coefficients of restitution from the literature based solely on the description of the material resulted in unrealistically high bounce heights but reasonable rotational velocities.

The computer simulations in this study suffered from the limitations of 2D modeling software, such as overestimation of bounce heights and underestimation of rock runout, similar to those described by Pierson et al. (2001) and Wyllie (2012). Experimental rockfalls using the SR can help to better predict the motion and energy of a falling rock. The accelerations and rotational velocities measured by the SR can be used to determine the force and energy with which a rock would hit a protective barrier. Using SR data to validate rockfall simulations would allow better understanding of rockfall hazards.

### 6.3 Future Work

Future endeavors using the SR should involve modifications of the SR and the experimental setup to allow the use of the altimeter included in the instrument, which should allow
measurement of the vertical component of velocity. Also useful will be robust video analysis of experimental rockfalls to determine translational velocities and trajectory bounce heights, which will allow full calibration of rockfall models using translational velocity, rotational velocity, and bounce height.

With high-resolution surface data available in the form of photogrammetry models or the sub-meter resolution DEMs expected for much of NH in the next five years (Carswell, 2015), 3D rockfall modeling may become possible for rock cuts. The SR could be used to ensure accurate models for dangerous slopes. Further investigation of slope roughness parameters and coefficients of restitution could bring even lower-resolution data into agreement with measured SR data.
LIST OF REFERENCES


SplitFX 64 (version 2.4.3.3) [Computer Software]. (2016). Split Engineering.


APPENDIX A. CREATING A POINT CLOUD USING STRUCTURE FROM MOTION FREEWARE

The following document detailing a methodology for creating a three dimensional point cloud using structure-from-motion techniques was written for the New Hampshire Department of Transportation, Bureau of Materials and Research, during an internship in January, 2018. It is used here with permission.

Acknowledgements
Much thanks to Neil Olson for notes, comments, and consultations.
CREATING A POINT CLOUD USING STRUCTURE FROM MOTION FREeware

Introduction

The goal of this document is to describe methods for creating and georeferencing a point cloud of an object or area of interest using freely available software or software available to the New Hampshire Department of Transportation (NHDOT). This is written assuming the application is digitizing a rock cut exposure for structural analysis and change detection. However, the methods described may be applied to any three dimensional object for which pictures can be obtained.

Structure from Motion (SfM) is a photogrammetry technique that uses overlapping 2D pictures to model 3D objects. There are many references discussing SfM, including the documentation of the software used below, related references, online blogs, and published literature. Johnson and Salisbury (2015) gives a good introduction to SfM. References used to create this document are presented at the end.

Software

Listed below are the software packages discussed in this document, their sources, and notes on installation and use. Wikipedia lists many more photogrammetry packages, both licensed and free, here: https://en.wikipedia.org/wiki/Comparison_of_photogrammetry_software
<table>
<thead>
<tr>
<th>Software</th>
<th>Website</th>
<th>Installation</th>
<th>Notes</th>
<th>Free?</th>
</tr>
</thead>
<tbody>
<tr>
<td>VisualSFM</td>
<td><a href="http://ccwu.me/vsfm">http://ccwu.me/vsfm</a></td>
<td>Download from website. Standalone executable needs no installation. Requires PMVS/CMVS file <code>cmvs.exe</code>, <code>pmvs2.exe</code>, and <code>genOption.exe</code> placed in the same folder as VisualSFM.exe for dense reconstruction.</td>
<td>Very easy to use. Matches photos and generates a point cloud.</td>
<td>Yes</td>
</tr>
<tr>
<td>PMVS/CMVS</td>
<td><a href="http://www.di.ens.fr/cmvs/">http://www.di.ens.fr/cmvs/</a></td>
<td>Download from website. Three executable files must be placed in the same folder as the accompanying SfM software. Files needed: <code>cmvs.exe</code>, <code>pmvs2.exe</code>, <code>genOption.exe</code>.</td>
<td>Used for dense point cloud reconstruction. DOT website filters may restrict access to the download website.</td>
<td>Yes</td>
</tr>
<tr>
<td>SfM_Georef</td>
<td><a href="http://www.lancaster.ac.uk/staff/james/software/sfm_georef.htm">http://www.lancaster.ac.uk/staff/james/software/sfm_georef.htm</a></td>
<td>Download from website, along with required Matlab runtime library. Sfm_georef.exe requires no install; Matlab runtime library requires admin privileges for installation. See website for required runtime version.</td>
<td>Used for georeferencing SfM data.</td>
<td>Yes</td>
</tr>
<tr>
<td>CloudCompare</td>
<td><a href="http://cloudcompare.org/">http://cloudcompare.org/</a></td>
<td>Download from website; .exe file requires admin privileges for installation.</td>
<td>Used for georeferencing, analyzing, and comparing point clouds.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Help/Documentation:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SplitFX</td>
<td><a href="https://www.spliting.com/products/split-fx-software/">https://www.spliting.com/products/split-fx-software/</a></td>
<td>Download requires admin privileges for installation. License code or dongle required to run the software.</td>
<td>Used for analyzing point clouds.</td>
<td>No</td>
</tr>
</tbody>
</table>
Software References

The creators of the freeware software packages request that the following citations be referenced in publications when they are used.

VisualSFM

Changchang Wu, 2011. Sameer Agarwal, Brian Curless, and Steven M. Seitz, "Multicore Bundle Adjustment", CVPR
Furukawa, Y., Ponce, J. (2010). Accurate, dense, and robust multiview stereopsis. IEEE Transactions on Pattern Analysis and Machine Intelligence, 32(8), 1434-1441. DOI: 10.1109/CVPR.2010.5539802

CloudCompare

(replace X and YYYY with the appropriate version).

For the “Facets” plugin in CloudCompare (automatic modeling of planar surfaces):

For the “Compass” tool in CloudCompare (manual picking of planes and traces for structural data):

SfM_Georef

Photography

All photogrammetry relies on overlapping photos to generate a 3D model. Falkingham (2013), Hesse (2013), and Schoenberger (2017) are three references that discuss requirements and tips for taking pictures. See References.

Before Taking Photos

- Ensure space is available on the camera memory card for a large number of photos: dozens to hundreds depending on the size of the area/object of interest.
- Avoid:
  - Times of day that will produce deep shadows on the area of interest
  - Large or multiple reflective surfaces (ice, wet surfaces, glass windows)
    - Large contrasts in light and shadow or large reflective surfaces may create problems during image matching and model construction.
  - Smooth areas and objects. Texture on objects is required to match points between images; surfaces without texture will not work.
- Set up a minimum of 3 targets with known locations that will be easily identified in the images. These will be your control points. See Tips on choosing control points
  - Targets should be spaced out around the area of interest- don’t cluster them.
  - Vary X, Y, and Z between targets as much as possible. A linear arrangement of targets will not provide reference points for all areas of the model, so the model orientation (tilt, yaw, or roll) may be incorrect, even if it is georeferenced to a correct general location.
  - Using a target shape with an easily-identified center may make georeferencing easier.
- Include several objects of known size or scale when taking pictures for quality control and scaling.
- Measurements to take:
  - GPS coordinates, including elevation, of all target locations/control points
    - Check the measurements before you leave! Do they make sense?
    - If possible, manually measure the height of the targets above the ground for later reference. Experience indicates GPS elevations may be inaccurate and their usefulness may be influenced by the units used.
    - Do not rely on cell phone GPS for locations. Testing shows that cell phone location quality varies widely.
  - Dimensions of objects of known size, for scale
  - For quality control and model checks:
    - Orientation of rock cut relative to north and to the road
    - Height, length, and slope of rock cut
    - Slope of ground in front of rock cut or dimensions of ditch
  - If rockfall/runout analyses are to be conducted for a rock cut:
- Distance to road
- Dimensions of ditch
- Ground cover (vegetation and density, gravel, dirt, etc)
- Observations of slope material and roughness

**Taking Photos**

- Note the type of camera.
  - Maintain the same focal length throughout (ie: use the same camera).
  - Wide angles cover more but also add distortion to the images. This may interfere with model creation.
  - Reasonable models with acceptable error have been developed using smart phones.
- Ensure GPS location tagging of photos is turned on.
  - On an iphone: Settings->Privacy->Location Services (ON)-> Camera.
- Use similar lighting for all photos.
- Overlap all photos; up to 80 or 90% if possible.
- **All features must appear in a minimum of 3 images**, preferably more.
- **All control points/targets must be easily visible in at least 3 images**, preferably more.
- Take a picture or panorama for reference that shows the area as a whole, including the control points. Annotate this afterwards if necessary to clearly label the locations of each control point.
- Take a step or two between photos; don’t remain in the same spot. Take pictures from multiple angles and multiple distances, instead of a single straight line of photos. The different viewpoints are what allows SfM software to create a 3D model.
- Keep the camera as still as possible for each image to minimize blur.
- Take pictures that include the ditch/ground in front of the base of the cut. Make sure they overlap enough with the rock cut to be matched to the rest of the model.
- Too few pictures or not enough overlap between images will create gaps in the model. More pictures are better than too few, but processing time will increase with the number of pictures.

**Control Points**
Ground control points, or feature with known locations, are required in order to put a point cloud in a real-world frame of reference. Any combination of targets/control points for which the locations are known in real coordinates can be used to georeference a point cloud, as long as they can be seen in at least three images each and in the point cloud itself.

**Tips on choosing control points**

- Bright spray-painted numbers on a rock cut work well.
- Vary the height and location of targets, so they are not all in a line. A 3Dimensional arrangement of targets allows for better georeferencing during data processing. (See Georeferencing).
- Targets should be large enough to be seen easily in images and for the SfM software to add them into the point cloud.
- Squares, crosses, spheres, or similar shapes with clearly defined centroids make picking the same location on the target in multiple images easier.
- If no pre-planned targets are used, any distinctive and identifiable feature on the rock cut can be used, as long as the X, Y, Z location can be recorded for later use.
- Permanent or semi-permanent targets, such as spray-painted numbers, a distinctive, stable rock feature, or a street sign might allow easier georeferencing for change detection in the future.

**Processing control point data**

- The coordinate system of the control point GPS coordinates must be known.
- Use a program such as ArcGIS or QGIS to project the points to the desired coordinate system, if applicable (such as NAD 1983 (2011) New Hampshire State Plane Feet).
- Ensure X, Y, Z coordinates use the same system of measurement (meters or feet). Z coordinates (elevation) often must be converted separately.
- Create a text or csv file listing the control points and their locations.
For use in CloudCompare, use any ascii file or ArcGIS shape file. (Ascii files were used for this document; shapefiles have not been tested here).

For use in SfM_Georef, use a formatted tab or space delimited txt file.
- column format for control points: x, y, z, descriptor
- no tabs or spaces allowed in data entries

For use in SplitFX, use any ascii file.

- Alternately, camera positions may be used in SfM_Georef.
  - This option has not yet been used successfully by NHDOT. GPS outputs from phones/cameras may not be accurate enough to describe camera positions.
  - The images must be geotagged.
  - Using ArcGIS (Data Management -> Photos), geolocate the photos to points.
    - Project the points to the desired coordinate system.
    - Add fields, and use Calculate Geometry to add X, Y, Z information.
    - Export the table to a tab or space delimited txt file.

- Format the txt file as: cam_x, cam_y, cam_z, descriptor.

Creating a Point Cloud

VisualSFM

The program is intuitive and easy to use. The directions given on the website provide a basic work flow. Documentation and FAQs are here: [http://ccwu.me/vsfm/doc.html#faq](http://ccwu.me/vsfm/doc.html#faq). The output from this software using the workflow below will be a densified (detailed) point cloud of the object of interest. It will have an internally consistent scale, but will not be referenced to real-world coordinates or scale and cannot be used for real measurements or structural analysis until it is georeferenced.

- Make sure cmvs.exe, genOption.exe, and pmvs2.exe exist in the same folder as the VisualSFM.exe and accompanying files.

- Run the executable.
• File-> Open+ Multi Images ( )
  o Open images using CTRL or SHIFT to select those of interest.
  o It may take a minute or two for the images to load, particularly if there are many.

• SfM-> Pairwise Matching -> Compute Missing Match ( )
  o Wait. The log will detail what is happening; this may take anywhere from 5 min to 45
    min or more, depending on the number of pictures and the processing power of the
    computer.
  o Pressing X while in the main window will update the running time at the bottom of
    the window.
• Save the project using SfM->Save NView Match.
• SfM-> Reconstruct Sparse ( )
  o This should take seconds to minutes. Keep an eye on the log for errors.
  o When this completes, the sparse reconstruction should show a basic point cloud with
    the locations of the cameras. The point cloud should resemble the area of interest
    when viewed from a distance/zoomed out.
  o **Note:** If the pictures do not overlap sufficiently, the sparse reconstruction may create
    multiple models. It will say this in the log. Models can be scrolled through with the
UP/DOWN arrows, or displayed together by turning off View -> Show Single Model. A bad model can be deleted using SfM -> Delete Selected Model.

- SfM -> Reconstruct Dense (⌘) -> follow prompts
  - This will return an error if the PMVS/CMVS files are not available.
  - Wait. This will take a while unless something goes wrong. May take >45 minutes. If it finishes in <1 min, check the log for error messages.
  - Use View -> Dense 3D points to view the dense point cloud.

- The dense reconstruction should automatically save an .nvm file, folder, and .ply file. Make sure these exist before closing the software. Use SfM -> Save NView Match to save.

<Figure A5: Sparse (left) and dense (right) point cloud showing a rock cut. The sparse reconstruction shows the images used to create the model and their orientations.>

Georeferencing

Georeferencing places a data set into real-world coordinates in order to obtain an accurate scale and to plot the object on a map. Three software options are presented below. Use whatever software and process is easiest with your dataset and meets the goals of the project.

Preliminary results suggest that both CloudCompare and SfM_Georef produce similar outputs. Both programs accurately move a point cloud to the correct spatial coordinates, however, the orientation of the point cloud relative to north and “up” is not accurate (i.e. it’s tilted), due to a lack of spatially varied control points. For a rock cut on Route 93 in New Hampshire, the primary difference between the results from the two programs is the tilt of the georeferenced dataset. The outputs agree with each other within a few degrees. Methods of correcting the orientation are discussed in Correcting the Point Cloud Orientation.

CloudCompare is easy to use and allows a relatively quick output by picking out the control points on the 3D point cloud, but the targets must be visible in the point cloud.

SfM_Georef requires slightly more data preparation and more time to process, as the user must manually search the photos. It provides more control over where control points are located in the model than CloudCompare by working off of the original image files. If the targets are not easily visible in the point cloud, use SfM_Georef to identify them in the photos.
SplitFX uses a theoretically simple process, but is somewhat “finicky” and is limited to only three control points. In a process similar to CloudCompare, control points are marked on the 3D point cloud. Coordinates must be manually entered.

**In CloudCompare**

- Open the Control Point ascii file you created from the field data in CloudCompare.
  - Use the resulting pop up window to designate the appropriate columns as X, Y, Z, and any relevant scalar field.
  - If it asks to rescale, click yes. The program does this to improve accuracy and it should not impact the final result, but pay attention to corresponding options later.
    - Multiple files with real coordinates used for the same project should be in the same units and rescaled using the same adjustment.
- Open the .ply file output from VisualSFM for the dense point cloud. This is the named .ply file outside of the dense point cloud .nvm.cmvs folder.

![CloudCompare interface, showing the scale difference between georeferenced control points (white dots) and an ungeoreferenced point cloud (small yellow rectangle)](image)

- Adjust point sizes in one or both clouds so they are visible. Clouds can be adjusted individually in the properties menu on the left side of the screen.
- Use CTRL to highlight both point clouds in the content list, then use Tools->Registration->Align (Point Pairs Picking) (🔧)
  - Set the point cloud as “Aligned” and the control points as “Reference”.

- In the Point Pairs Picking dialog:
o Make sure “adjust scale” is checked. This allows your point cloud to be resized to match the reference points.

o If you know which control points correlate to each target image in the point cloud:
  ▪ Click each control point to add them to the point list. **Pay attention to the order.**
  ▪ Zoom into the point cloud, find the first target, and click a point within it. Repeat for the remaining targets in the same order as the control point list.

o If you are unsure which plotted control point matches each target:
  ▪ Click the pencil beside “show reference cloud” and enter points manually, paying attention to the point label. **If CC shifted your data but you are entering unshifted (normal) values, make sure the check box is clicked.**
  ▪ Zoom into the point cloud, find the first target, and click a point within it. Repeat for the remaining targets in the same order as the control point list.

o Click “Align” to view the transformation.

   o Click the check mark to get out of the align dialog.

   • Transform properties can be exported from the program.
   • Sizes of known objects, height of the point cloud, and other size references can be checked by drawing a polyline on the cloud (using ) to estimate the length.
   • Save the transformed point cloud in the desired file format (highlight the point cloud, File- >Save).

Figure A7: Defining control points (left) and locating targets in the point cloud (right)
In SfM_Georef

This software gives more control over where the target locations are identified, because it works off the images instead of the point cloud.

- Make sure the correct Matlab Runtime Environment is installed (requires admin privileges). See the Readme included with the software download for instructions.
- Run the sfm_georef executable file.

- File->Import SfM Project File. Open the .nvm file from VisualSfM for the dense point cloud.
File->Import Control Data
  o Control data text files must be formatted as described in Control Points
  o If you are using camera positions instead of control points, **rearrange the list of images** in the camera location text file to match the order they were read by sfm_georef before importing.

If using camera positions, skip to calculating the transform
If using control points, each point must be manually identified in multiple images
  o Go through the image files manually and identify pictures where each control point target is visible. A spreadsheet is helpful.
  o Under Points(SfM), click New Point
  o Under the image list, highlight all images showing one of the control points. They will open. A minimum of 3 images per point is required.
  o Zoom in on each image and click the target location. Pick the same location on the target in each image to minimize residuals. Ideally, residuals will be ~1 pixel.
    ▪ Picks can be adjusted by revisiting the image, highlighting the appropriate point number, and clicking the new location
  o Repeat for each control point
  o Under Control Data, ensure the link number for each control point corresponds to the correct location identified on the images (ie: that link/Control Point 1 actually corresponds to the first point picked on the images).

Figure A10: Identifying control points in SfM_Georef
• Calculate Transform
  o This will calculate residuals and pop up a 3D plot.
• Save: File->Save SfM_Georef project as…
• File->Export->PMVS2 .ply files
  o Make sure “Merge multiple .ply files” is checked
  o When prompted to open files:
    ▪ Navigate into the .nvm.cmvs folder for the dense point cloud originally opened.
    ▪ Follow the folder tree to ….nvm.cmvs\00\models
    ▪ Select all option-000X.ply files (ie: option-0000.ply, option-0001.ply, etc)
    ▪ Click open
  o Create a file name for the output .ply file
  o Wait. The messages window should show it reading the option-000X.ply files and writing a new one, but it may take several moments.
    ▪ If a “Reading: [Filename]” message comes up, but nothing follows it after several minutes, it is likely that the export failed. No other error may be reported.
    ▪ High RMS errors (>~7000) may be a cause of failure. This may be why using camera locations has so far been unsuccessful.
    ▪ Opening the wrong initial .ply file will cause the export to fail. The named .ply file exported by VisualSFM, which exists outside of the .nvm.cmvs folder, will not work for this process.

In SplitFX

SplitFX was created to work with terrestrial lidar data, and several of its processes for georeferencing assume that a single laser scanner was used. Georeferencing SfM point clouds is possible, but a maximum of only 3 control points can be used. Other software is recommended for georeferencing. **NOTE: Only use this method if the data are to be analyzed in SplitFX.**

SplitFX does not export color data, so the point cloud cannot be exported intact.

• Open the software.
• Open a point cloud.
  o Point clouds must be in ascii format or SplitFX’s proprietary .fx format to be imported.
  o If “Specify format of ascii file” is chosen for import format, ascii columns can be designated as X,Y,Z,R,G,B, Intensity.
  o Tip: If RGB values are available and specified but the point cloud appears in grayscale, go to Point Cloud-> Colors and change point colors from “Intensity lookup table” to “Encoded grayscale or color.”
• Under Region-> Properties AND Point Cloud-> Cloud Properties change the units if needed. The default is meters.
• Insert->Marker
  o Name the marker.
  o Check the box “Use this marker for aligning point clouds.”
  o “Use the mouse to digitize one or more locations”-> Ok.
  o Find the target in the point cloud, zoom in close so individual points are visible, and click a point in the target.
  o Move the cloud to check that the marker is actually where you want it (it probably won’t be).
    ▪ Change the mouse to selection mode ( ), select the marker, then change the mouse mode back so the cloud is movable.
    ▪ Drag the marker until it is in the correct position.
  o Repeat for the remaining 1-2 control points.

![Figure A11: Inserting a marker in SplitFX](image)

• Select all markers.
• Orientation-> Three markers…
  o The number used depends on how many control points are in use.
  o If 3 markers are present but the “three marker” option is not available, ensure that all markers are selected.
• Enter the real-world coordinates of each marker. Select OK.
• A pop up will provide the error associated with the transformation. Click Yes to apply it.
• File->Save Region As…
• File-> Export Cloud Data…
  o Use the dialog to choose what will be exported. Color information will not be saved with points.
Correcting the Point Cloud Orientation

If the point cloud remains tilted relative to the real-world position, this can be manually fixed in CloudCompare or Split-FX. To do this, a reference data set is needed, such as an aerial lidar digital elevation model (DEM) or point cloud (available for download for NH from...
lidar.unh.edu) or known control points scattered all over the rock cut, including the top. Because the methods below are manual, the error introduced is not quantified.

In CloudCompare

This method uses the same tool that is used for Georeferencing In CloudCompare.

- Import the georeferenced SfM point cloud.
- Import a reference data set of the area, such as an aerial lidar point cloud. It should include correctly-positioned reference points overlapping with the rock cut.
  - An aerial lidar point cloud should resemble the rock cut with less detail.
- If the SfM point cloud was properly georeferenced, it should overlay the reference data set at the correct XY position. If not, fix the georeferencing.
- Highlight both data sets in the DB tree. Go to Tools->Registration->Align (point pairs picking)
  - Unclick “Adjust Scale” to prevent the point cloud changing size.
- Find a point in the reference data set that can be identified or estimated on the SfM point cloud. Click the point in the reference data set, and click the corresponding point in the point cloud. Repeat for 3 or 4 points at minimum, scattered around the point cloud.
  - Because the aerial lidar does not include actual control points and is a lower resolution than a SfM point cloud, finding corresponding points may require some guesswork.
  - Horizontal surfaces, including roads, are more likely to be represented in aerial data.
- Click “align” to view the transformation. The SfM point cloud should move. If the alignment appears correct, click the check box to close. If not, click reset to try again or the X to close without changing the point cloud.
  - This process can be repeated to try to better the alignment
  - The differences in resolution and uncertainty in point picking here mean that the RMS error given by the program is not trustworthy. The “Fine Registration” option does not work for the same reason- the point clouds are not similar enough.
- Use Plugins->Compass to measure distances and the orientation of faces in the point cloud for a quality check and error estimation, if the real sizes/orientations are known.

In SplitFX

This is an “eyeball” method with a lot of error involved, but it’s the quickest way of fixing tilt if the orientation of the point cloud relative to north is known. **NOTE: Only use this method if orientation is not critical and the data are to be analyzed in SplitFX. SplitFX does not export color data, so the point cloud cannot be exported intact.**

- Using maps, Google Earth, or similar resources, determine the orientation of the rock cut relative to north and the view of the rock cut when looking north.
- Open the georeferenced point cloud
Point clouds must be in ascii format or SplitFX’s proprietary .fx format to be imported.

- If “Specify format of ascii file” is chosen for import format, ascii columns can be designated as X,Y,Z,R,G,B, Intensity.
- Tip: If RGB values are available and specified but the point cloud appears in grayscale, go to Point Cloud-> Colors and change point colors from “Intensity lookup table” to “Encoded grayscale or color”.

- Under Region-> Properties AND Point Cloud-> Cloud Properties change the units if needed. The default is meters.
- Check the orientation of the cloud. The red/green/blue axes show X/Y/Z. SplitFX assigns the Y axis as north.
- Move the point cloud so that the view is facing as close to north as possible.
- Orientation->Orient by current view…
  - Assign the direction of the eye vector to Y+ axis
  - Assign the direction of the up vector to Z+ axis

- File->Save Region As…
- File->Export Cloud Data…
- If another cardinal direction is known, it can be used instead of north by changing which axes are defined, keeping the assumption that Y is north.
- If the average camera direction is known, Orientation->Scanner Orientation… can be used to input coordinates for orientation.

**Structural Analysis**

Both CloudCompare and SplitFX contain tools to analyze the structure of a rock cut point cloud. This is the digital equivalent of measuring the strike and dip of joints and fractures with a compass in the field. For this to be useful and successful the point cloud must be properly georeferenced and oriented, and structural details must be visible in the cloud.

SplitFX is more intuitive and user friendly than CloudCompare for semi-automatic structural analysis. CloudCompare has more options for analysis type and more control over the analysis used. Both programs analyze the data by finding flat “patches” or “facets” in the point cloud or model based on user-defined limits of size and angular variation.

Analysis should be done with care. Automatic analysis may generate hundreds to thousands of patches; user experience should be applied to determine the validity of the auto-identification. The output will have an inherent bias towards planes that are perpendicular to the camera orientation, so the “trace” tools available in both CloudCompare and SplitFX should be used to identify features parallel to the camera.

**In CloudCompare**

parameters used for analysis. Identification of planes in a point cloud ("facets") is done without
interpolating a surface. Both of the available analysis methods find small planar surfaces
("patches") and merge them based on specified parameters to output larger facets.

**Manual measurements**

- Open the georeferenced SfM point cloud
- Open the Compass plugin
- Use the Plane tool ( ) to measure the orientation of surfaces visible in the point cloud.
  Data are reported as Dip/Dip Direction in the data tree
- Use the Trace tool ( ) to estimate the orientation of joints that are not visible as exposed
  faces. Check the settings of this tool ( ) and finalize the trace with the green check ( ) to
  fit a plane.
- Export the plane and trace information using the save icon on the Compass toolbar. **NOTE:**
  strike exported by this tool is calculated as strike = dip direction+90 (UK rule?).
  Stereonet (or other US programs) by default assume dip direction = strike+90. If you
  import these data using strike/dip with no directional reference, all actual dip directions
  will be inverted. Use Dip/Dip direction instead!

**Automatic Facet Detection**

- Open the georeferenced SfM point cloud
- Edit the point cloud.
  - Remove extraneous, outlying, or incorrect points, including vegetation, sign posts,
    guardrails, etc by selecting and deleting them
- Highlight the point cloud in the data tree
- Plugins-> Facets/Fracture Detection-> Choose analysis method (see web reference)
- Cell Fusion parameters:
  - Kd Tree
    - Max angle is tolerance angle between facets
    - Max relative distance is distance between the center of a facet and the patches
      merged into it (larger = larger output facets)
  - Fast Marching
    - Octree level: Grid resolution (smaller = more smoothing)
    - Using retro-projection is more accurate
  - Facets
    - See web reference for details
    - Used to control error in merging patches and the size and continuity of facets
- Facets can be displayed by color corresponding to dip direction, or “classified” into families
  based on dip direction.
- Facets, facet groups, or normals to the point cloud can be plotted on a “stereogram” showing
  a polar plot of dip/dip direction.
To plot facets on a stereonet for analysis:
  - Plugins > Facets/Fracture Detection > Export Facet Info (CSV). The resulting file is actually semi-colon delimited and must be adjusted before use.
    - Manually change the file extension from .csv to .txt, then import it into Microsoft Excel OR open the file directly in Excel. Using Data > Text to Columns, select semi-colon as the delimiter. Once in columns, save it as a .txt or .csv file.
  - When opening the ascii file in Stereonet or Dips, use Dip/Dip Direction to load data.

In SplitFX

SplitFX is easy to use and includes a help manual. A basic overview structural analysis can be done quickly, but for a robust analysis, time must be spent to properly configure the software settings and correct the interpretation using common sense and geologic judgment. See the help for details on creating a mesh, finding patches, etc.

- Open a point cloud
  - Point clouds must be in ascii format or SplitFX’s proprietary .fx format to be imported
  - If “Specify format of ascii file” is chosen for import format, ascii columns can be designated as X,Y,Z,R,G,B, Intensity
  - Tip: If RGB values are available and specified but the point cloud appears in grayscale, go to Point Cloud > Colors and change point colors from “Intensity lookup table” to “Encoded grayscale or color”

- Under Region > Properties AND Point Cloud > Cloud Properties change the units if needed. Default is meters.

- Check the orientation of the cloud. The red/green/blue axes show X/Y/Z, where Y is North by default. If the cloud is properly georeferenced, these axes should be correct.

- Orient the view to perpendicular to the rock cut face, so as many points can be seen as possible.
  - Tip: This view can be saved for future use by going to Orientation > Saved View…
  - Alternately, this can be set as the “scanner” view using Orientation > Scanner orientation… If this is used, it can be recalled in the main window by pressing “I”

- Edit the point cloud
  - Change the mouse to selection mode and make sure points are selectable
  - Remove extraneous, outlying, or incorrect points, including vegetation, sign posts, guardrails, etc by selecting and deleting them
    - This only deletes points within the SplitFX project

- Point Cloud > Create Mesh…
  - Adjust the spacing of the cells as desired. Larger spacing will smooth out more detail.
  - 3 points per triangle is the minimum. Split Engineering recommends using 12-16.
- Check that the mesh aligns well with the point cloud
  - Point Cloud-> Find Patches…
    - Minimum patch size and maximum neighbor angle control the size and continuity of patches
    - Point Cloud-> Colors and Point Cloud-> Transparency can be used to make patches more visible and color them by dip direction
    - Patches can be manually edited by selecting a patch and inserting or deleting points
  - For joints parallel to the camera, manual traces can be added using Insert-> Trace. The tool automatically fits a plane to the trace.
  - Region-> Stereonet View will bring up a stereonet with patches and traces plotted
  - Use stereonet tools to contour, create sets, etc
  - Patches can be exported by highlighting the point cloud in the data tree and using File-> Export Cloud Data. Strike, Dip, and Dip Direction are options under “Patches”
  - To export traces:
    - Change the export format under Tools->Data Format Options->Display 3D angles as…
      - Strike/Dip, Dip/Dip Direction, and Trend/Plunge (for poles) could be used
    - Returning to the main window, File->Export Cloud Data. Export the Formatted Normals.
      - Experience suggests Strike/Dip works as it should, outputting the plane orientations including quadrant direction of dip, despite the logical inference that “formatted normals” should refer to the poles.
    - Check the exported data to be certain they make sense and were correctly exported.

**Notes and Comments**

**Current State**

- As of January 2018, control points for data sets from NH Rt 93 and Warner cut 176 are not ideal: too many lie along the same line at the base of the rock cuts. The point clouds have had to be manually corrected using the methods in Correcting the Point Cloud Orientation before use.
  - This is likely to continue to occur, due to the inaccessibility of the top of many rock cuts
- If possible to safely access the top of a cut, obtaining a few control points at the top should help prevent this

**Future Implementations**

- Freeware includes inherent risks, including lack of support, documentation, and regular updates. Acquiring licensed software such as PhotoScan or Pix4D for use making point clouds may improve the ease of use as well as the final products.
The NHDOT rock cut database contains a large amount of information about rock slopes in New Hampshire. It could be augmented by 3D models of the most hazardous rock cuts, for use with structural analysis and change detection over time.

- “A” rated cuts typically have jagged features that will make aligning two point clouds from different points in time easy.
- Control points would only need survey data acquired for the first model. Later models could be referenced to the first point cloud without repeating the control point measurements.
- A combination of ground-based SfM (as presented here) and aerial data from an unmanned aerial system (drone) could give a complete picture, where the individual datasets are limited by the camera’s line of site.

Structural analysis of a rock cut point cloud may be used to:

- Increase the number of structural measurements available in the rock cut database
- Perform slope stability analyses to quantify potential hazards
- Better understand the risk to the road
- Better understand the placement of rock supports and barriers such as bolts or netting

Change detection for rock slopes may be used for:

- Assessment of slope movement over time
- Quantifying the amount of rockfall from a slope
- Quantifying the volume of rock removed during scaling

Any object that can be photographed can be modeled in 3D using these methods. Potential other uses are:

- Quantification of stockpile volumes and change assessments
- Vegetation loss assessments
- 3D recording of slopes, roads, or embankments for later reference or measurement

**Other Software**

Other software packages exist to perform photogrammetry. Reviews of freeware can be found online, for example in this blog by Dr. Falkingham of Liverpool John Moores University: [https://pfalkingham.wordpress.com/2016/09/14/trying-all-the-free-photogrammetry/](https://pfalkingham.wordpress.com/2016/09/14/trying-all-the-free-photogrammetry/). Several other freeware packages, such as COLMAP, MicMac, and the Python Photogrammetry Toolbox, require some knowledge of command line or programming languages. Others are paid and licensed products.

**Agisoft PhotoScan**

This is licensed software mentioned by several references (Falkingham, 2017, Gauthier, 2015, and others) as a good photogrammetry package. A demo (no export/save) and a full function 30-day trial are available from the Agisoft website (http://www.agisoft.com/). The Professional Edition contains all components needed for point cloud creation, densification, model creation, georeferencing, classification, and other features. The Standard Edition allows point cloud
creation, densification, and model generation, but does not support georeferencing or classification.

**COLMAP**

This SfM freeware is available as a web download. Similar to VisualSfM, it is used for creating point clouds. It requires no extra installation, and many options are easily accessible to the user. Preliminary testing suggests it runs much slower than VisualSfM, but some settings may change this. The incorporated method of densifying a point cloud in this software requires special hardware (NVidia CUDA enabled video card). The software documentation indicates that output from this program can also be used with CMVS/PMVS for densification, as done by VisualSfM. This software is suggested for users who: know what they’re doing, want more control over feature identification, feature matching, and object reconstruction, or who are comfortable using command line. The command line interface may be needed for dense reconstruction. Documentation is plentiful but technical.

**References**


James, M. (2017). *SfM_Georef v.3.1 Instructions*. Lancaster University, UK.


### APPENDIX B. COEFFICIENTS OF RESTITUTION

Table A1. Published coefficients of restitution and friction. After Turner and Duffy (2012a) and Ashayer (2007), originally compiled by Heidenreich (2004). $R_N =$ Normal Coefficient of Restitution, $R_T =$ Tangential Coefficient of Restitution, $R_E =$ Energy Coefficient of Restitution, $R_I =$ Total Energy Coefficient of Restitution, $\mu =$ Dynamic Coefficient of Friction, $\mu_r =$ Rolling Coefficient of Friction. See Chapter 3, Turner and Duffy (2012a), and Ashayer (2007) for definitions of each coefficient.

<table>
<thead>
<tr>
<th>Source</th>
<th>$R_N$</th>
<th>$R_T$</th>
<th>$R_E$</th>
<th>$R_I$</th>
<th>$\mu$</th>
<th>$\mu_r$</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Habib 1977</td>
<td>0.75-0.80</td>
<td>0.5-0.6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Based on experience in Italy</td>
</tr>
<tr>
<td>Piteau and Claton 1977</td>
<td>0.8-0.9</td>
<td>0.65-0.75</td>
<td>0.5-0.8</td>
<td>0.45-0.65</td>
<td></td>
<td></td>
<td>Solid rock</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Detrital material mixed with large rock boulders</td>
</tr>
<tr>
<td></td>
<td>0.4-0.5</td>
<td>0.35-0.45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Compact detrital material mixed with small boulders</td>
</tr>
<tr>
<td>Wu 1985</td>
<td>0.2-0.8</td>
<td>0.5-0.75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Grass covered slopes</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rock on rock or wood platform</td>
</tr>
<tr>
<td>Heierli 1985</td>
<td>0.95</td>
<td>0.9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rock</td>
</tr>
<tr>
<td></td>
<td>0.55</td>
<td>0.3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Gravel layer (35 cm)</td>
</tr>
<tr>
<td></td>
<td>0.45</td>
<td>0.2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Gravel layer (70 cm)</td>
</tr>
<tr>
<td></td>
<td>0.45</td>
<td>0.2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Debris</td>
</tr>
<tr>
<td>Bozolo and Pamini 1986</td>
<td></td>
<td>0.7</td>
<td></td>
<td>0.55</td>
<td></td>
<td></td>
<td>Rock at a slope angle of 44°</td>
</tr>
<tr>
<td>Descouedres and Zimmermann 1987</td>
<td></td>
<td>0.4</td>
<td>0.5</td>
<td></td>
<td>0.85</td>
<td>0.5</td>
<td>Vineyard slopes</td>
</tr>
<tr>
<td>Hoek 1987</td>
<td>0.53</td>
<td>0.99</td>
<td></td>
<td>0.4</td>
<td>0.9</td>
<td></td>
<td>Clean hard bedrock</td>
</tr>
<tr>
<td></td>
<td>0.4</td>
<td>0.9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Asphalt roadway</td>
</tr>
<tr>
<td></td>
<td>0.35</td>
<td>0.85</td>
<td></td>
<td>0.32</td>
<td>0.82</td>
<td></td>
<td>Bedrock outcrops with hard surface, large boulders</td>
</tr>
<tr>
<td></td>
<td>0.32</td>
<td>0.8</td>
<td></td>
<td>0.32</td>
<td>0.8</td>
<td></td>
<td>Talus cover</td>
</tr>
<tr>
<td></td>
<td>0.3</td>
<td>0.8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Talus cover with vegetation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Soft soil, some vegetation</td>
</tr>
<tr>
<td>Source</td>
<td>$R_N$</td>
<td>$R_T$</td>
<td>$R_s$</td>
<td>$R_E$</td>
<td>$R_I$</td>
<td>$\mu$</td>
<td>$\mu_I$</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>-------</td>
<td>-------</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>Urciuoli 1988</td>
<td>0.05-0.35</td>
<td>0.5-1</td>
<td>0.02-1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>~0</td>
<td>0.24</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gerber 1995</td>
<td>0.17-0.43</td>
<td>0.45-0.88</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Usharo et al. 2000</td>
<td>0.1-0.4</td>
<td>0.71</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pfeiffer and Bowen 1989 (Older versions of CRSP)</td>
<td>0.37-0.42</td>
<td>0.87-0.92</td>
<td>0.33-0.37</td>
<td>0.83-0.87</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.30-0.33</td>
<td>0.83-0.87</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.3-0.33</td>
<td>0.80-0.83</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.28-0.32</td>
<td>0.80-0.83</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.28-0.32</td>
<td>0.78-0.82</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Giani 1992, Barbieri et al. 1988</td>
<td>0.5</td>
<td>0.95</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.35</td>
<td>0.85</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.3</td>
<td>0.7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.25</td>
<td>0.55</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Azzoni et al. 1995</td>
<td></td>
<td></td>
<td></td>
<td>0.3 m$^3$</td>
<td>1.2 m$^3$</td>
<td>0.75-0.90</td>
<td>0.4-0.45</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.55-0.6</td>
<td>0.5-0.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.35-0.45</td>
<td>0.7-0.8</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.45-0.5</td>
<td>0.6-0.7</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.4-0.5</td>
<td>0.7-1.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.55-0.7</td>
<td>0.65-1.20</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.5-0.6</td>
<td>0.55-0.65</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>&lt;0.2</td>
<td>0.85</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.50-0.65</td>
<td>0.50-0.65</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.75</td>
<td>0.40-0.45</td>
</tr>
<tr>
<td>Kamijo 2000</td>
<td>0.1-0.35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table A1 continued

<table>
<thead>
<tr>
<th>Source</th>
<th>$R_N$</th>
<th>$R_T$</th>
<th>$R_e$</th>
<th>$R_F$</th>
<th>$R_I$</th>
<th>$\mu$</th>
<th>$\mu_r$</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jones &amp; al. 2000 (Values gathered by program calibration for CRSP 4.0)</td>
<td>0.60-1.0</td>
<td>0.90-1.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Smooth hard surface and paving</td>
</tr>
<tr>
<td></td>
<td>0.15-0.3</td>
<td>0.75-0.95</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Bedrock and boulder fields</td>
</tr>
<tr>
<td></td>
<td>0.12-0.2</td>
<td>0.65-0.95</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Talus and firm soil slopes</td>
</tr>
<tr>
<td></td>
<td>0.10-0.2</td>
<td>0.50-0.80</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Soft soil slopes</td>
</tr>
<tr>
<td>Budetta &amp; Santo 1994 (evaluated by program calibration)</td>
<td>0.2</td>
<td>0.53</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rock</td>
</tr>
<tr>
<td></td>
<td>0.64</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rock slope also covered with trees</td>
</tr>
<tr>
<td></td>
<td>0.38</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rock</td>
</tr>
<tr>
<td></td>
<td>0.53</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Scattered sagebrush, grass, few other boulders</td>
</tr>
<tr>
<td></td>
<td>0.33</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rock</td>
</tr>
<tr>
<td></td>
<td>0.64</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rock slope also covered with trees</td>
</tr>
<tr>
<td>Kobayashi et al. 1990</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rock</td>
</tr>
<tr>
<td></td>
<td>0.38</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rock</td>
</tr>
<tr>
<td></td>
<td>0.53</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Scattered sagebrush, grass, few other boulders</td>
</tr>
<tr>
<td></td>
<td>0.33</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rock</td>
</tr>
<tr>
<td>Hungr, O. and Evans, S.G. 1988</td>
<td>0.5</td>
<td>0.8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Sparsely forested slope covered by a veneer of very fine weathered talus derived from weak schistose</td>
</tr>
<tr>
<td></td>
<td>0.5</td>
<td>0.8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Limestone on bare uniform talus slope formed of basalt fragments</td>
</tr>
<tr>
<td></td>
<td>0.7</td>
<td>0.9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rectangular boulder of metamorphosed tuff on bare rock and a steep snow covered shelf</td>
</tr>
<tr>
<td></td>
<td>0.32</td>
<td>0.71</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Limestone face</td>
</tr>
<tr>
<td>Robotham et al.</td>
<td>0.3</td>
<td>0.62</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Partially vegetated limestone scree</td>
</tr>
<tr>
<td></td>
<td>0.32</td>
<td>0.71</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Uncovered limestone blast pile</td>
</tr>
<tr>
<td></td>
<td>0.25</td>
<td>0.49</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Vegetated covered limestone pile</td>
</tr>
<tr>
<td></td>
<td>0.28</td>
<td>0.84</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Chalk face</td>
</tr>
<tr>
<td></td>
<td>0.27</td>
<td>0.6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Vegetated chalk scree</td>
</tr>
</tbody>
</table>
The iOS application VideoPhysics was used to estimate the trajectories of the falling rock during experimental rockfalls with the Smart Rock (SR). The “Zero” location on the slope was defined as the bottom of a red and white range pole placed at the foot of the steep rock slope, which is marked in 1 ft intervals. Red points delineate the trajectory of the test rock; points were picked at the approximate center of mass of the rock in every frame when the rock was moving quickly, or every 5 or 10 frames when it was moving too slowly for movement to be reliably discerned. On each video, points were also picked at the high and low points of each initiation blow as described in Chapter 4, in order for the video to be synced with the SR data. Data were output in tables in Microsoft Excel.

The following figures show the points picked for each of the 15 experimental rockfalls with successful SR data. The figures are marked with the rockfall trial number T1-T15. The white, circular cursor shows the designated zero point at the base of the range pole. The high points of the initiation blows can be seen clustered in the upper right corner of each image, while points on the range pole, marked stick, and yellow X were chosen to check the measurements output by the program and to estimate error.
The video for trial 2 was blurred. Points were not picked for every frame throughout the video due to the difficulty of distinguishing the center of mass.
APPENDIX D. SMART ROCK DATA FOR COLLEGE WOODS TRIALS

The figures in Appendix D graphically present the Smart Rock (SR) data for each of the successful 15 trials in College Woods and two of the four successful Derry trials. For College Woods, Trials T1-T10 were conducted with rock 1, the 5 kg compact elongated rock. Trials T11-T15 were performed with the 11 kg compact bladed rock, rock 2.

In each figure, the acceleration resultant, which is a combination of the resultant data signals from the low-g accelerometer when the acceleration is under 8 g and from the ±400 g accelerometer when the acceleration is over 8 g, is shown in black in the top graph. The resultant acceleration peaks when the rock impacts the surface, reads a value of 1 g when the rock is at rest, and is 0 g when the rock is in flight or free fall. The value at 1 g is marked on all graphs in red.

The approximate vertical location of the rock from video analysis, corrected for vertical offset from the “zero” location, is shown in blue on the acceleration graph. The vertical location data for the lower slope was estimated by linear interpolation between the last position found during video analysis and the known end location of the rock. The time that it reached the ending location was set automatically to the time at which the acceleration data indicate that the rock stopped moving.

The second graph in each figure shows the gyroscope data from the three axes of the SR and the resultant rotational velocity derived from these. The resultant rotational velocity changes sharply on impact with the surface and is constant while the rock is in flight or free fall.

No vertical location data are presented with the Derry SR data.
College Woods SR Trials 1-15

Trial 1: 5 kg rock

Maximum acceleration: 45 g at 1.33 s

Maximum rotational velocity: 3194 dps at 1.33 s
Trial 2: 5 kg rock

Maximum acceleration: 94 g at 1.51 s

Maximum rotational velocity: 2619 dps at 2.80 s
Trial 3: 5 kg rock

Maximum acceleration: 150 g at 0.43 s

Maximum rotational velocity: 2878 dps at 1.91 s
At 2.67 s in T4, the rock struck a tree to the left of the primary rockfall pathway and bounced, moving perpendicular to the normal rock path. This can be seen as a large deceleration and an abrupt decrease in rotational velocity.

Trial 1: 5 kg rock
Maximum acceleration: 195 g at 2.67 s
Maximum rotational velocity: 3377 dps at 2.63 s
Trial 5: 5 kg rock

Maximum acceleration: 154 g at 1.29 s

Maximum rotational velocity: 3088 dps at 2.42 s
Trial 6: 5 kg rock

Maximum acceleration: 110 g at 1.01 s

Maximum rotational velocity: 2596 dps at 2.21 s
Trial 7: 5 kg rock

Maximum acceleration: 256 g at 0.94 s

Maximum rotational velocity: 2006 dps at 1.60 s
Trial 8: 5 kg rock

Maximum acceleration: 241 g at 0.80 s

Maximum rotational velocity: 2632 dps at 2.27 s
Trial 9: 5 kg rock

Maximum acceleration: 67 g at 1.26 s

Maximum rotational velocity: 2193 dps at 1.64 s
Trial 10: 5 kg rock

Maximum acceleration: 362 g at 1.33 s

Maximum rotational velocity: 3088 dps at 1.60 s
Trial 11: 11 kg rock

Maximum acceleration: 203 g at 0.87 s

Maximum rotational velocity: 2069 dps at 3.8 s
Trial 12: 11 kg rock

Maximum acceleration: 123 g at 0.68 s

Maximum rotational velocity: 2113 dps at 1.6 s
Trial 13: 11 kg rock

Maximum acceleration: 104 g at 1.43 s

Maximum rotational velocity: 2495 dps at 2.15 s
Trial 14: 11 kg rock

Maximum acceleration: 299 g at 1.50 s

Maximum rotational velocity: 2241 dps at 1.76 s
Trial 15: 11 kg rock

Maximum acceleration: 372 g at 1.71 s

Maximum rotational velocity: 2152 dps at 3.08 s
Derry SR trials 1 and 3

Trial 1

Derry Trial 1: 5 kg rock

Maximum acceleration: 355 g at 2.94 s

Maximum rotational velocity: 2671 dps at 3.22 s
Trial 3

Derry Trial 3: 5 kg rock

Maximum acceleration: 397 g at 2.50 s

Maximum rotational velocity: 4989* dps at 2.56 s

*Rotation exceeded the limits of the gyroscope; number is approximate.
APPENDIX E: ROCKFALL MODEL BASICS AND TABLES OF ROCKFALL MODEL PARAMETERS USED

The RocFall software has an extensive help menu that can be found at www.rocscience.com/help/rocfall. Tutorials and workflows can be found at this site.

A model in the RocScience software RocFall requires a two-dimensional slope profile, rock information, and slope material information. To create a model, the user first chooses the units to be used (metric or imperial) under the parameters menu, as well as the analysis method (lumped mass or rigid body). The slope profile is then added to the program, either by manually choosing points using the cursor, or by inputting (X, Y) coordinates into the table under the “Edit Slope Coordinates” menu.

Once a profile has been created, the Materials menu is used to assign coefficients of restitution to the slope. Each section of slope between coordinates can be assigned a separate material. Three materials are in the program by default: “bedrock outcrops,” “talus,” and “asphalt.” More materials can be added into the Slope Material Library by manually entering values for the normal and tangential coefficients of restitution and the friction angle, dynamic coefficient of friction, and rolling coefficient of friction, depending on the analysis type. A statistical distribution and standard deviation is typically assigned to each parameter in order to add variation to the model. The values of coefficients for different materials can be found in tables such as that provided in Appendix B or from RocScience at https://www.rocscience.com.

Using the Rock Type Library, the user defines the mass, density, and shape (if applicable) of the rock to be modeled. Rocks are added to the model as a “seeder,” or rock starting location,
which may be either a single point or a line delineating a series of locations with equal probabilities of having a rock fall.

The model can be run once the slope, material, and rock are defined. If desired, the user can add barriers to the model, or specific data points at which the model will collect data. Once the model has been run, data may be output as graphs showing bounce height, total kinetic energy, or translational or rotational kinetic energy or velocity. Data may be shown for the full length of the graph or at specific points of interest.

Data is output in RocFall as histograms defined by the number of bins specified by the user. For a graph of data for the whole slope, the histogram bin size, in units of length, is defined by the length of the slope data divided by the number of bins. For data at a specific point, the histogram bin size, in units of the parameter of interest, is defined by the maximum and minimum data calculated by the program divided by the number of bins.

The following tables provide data that were used in RocFall models of the College Woods experimental location.

| Table A2: Data used to calculate coefficients of restitution from College Woods |
|----------------------------------------|-----------------|-----------------|-----------------|
|                                       | Soil Coefficient | Rock Coefficient |
|                                       | Trial | h₀ (cm) | h₁ (cm) | Rₑ | h₀ (cm) | h₁ (cm) | Rₑ |
| Rock 1                                | 1     | 110.0   | 8.3     | 0.28 | 59.0   | 11.1    | 0.43 |
|                                       | 2     | 114.2   | 12.8    | 0.33 | 58.2   | 19.1    | 0.57 |
|                                       | 3     | 112.9   | 11.2    | 0.32 | 53.1   | 3.1     | 0.24 |
|                                       | 4     | 112.7   | 11.6    | 0.32 |        |         |      |
| Rock 3                                | 1     | 103.2   | 10.1    | 0.31 | 56.0   | 19.9    | 0.60 |
|                                       | 2     | 104.3   | 8.7     | 0.29 | 54.2   | 9.4     | 0.42 |
|                                       | 3     | 102.0   | 10.6    | 0.32 | 58.7   | 13.3    | 0.48 |
| Average 1                             |       | 0.312   |         |     | 0.416  |         |     |
| Average 3                             |       | 0.308   |         |     | 0.496  |         |     |
| Average                               |       | 0.310   |         |     | 0.456  |         |     |
| Standard Deviation                    |       | 0.020   |         |     | 0.128  |         |     |
### Table A3: Model trajectory errors for the College Woods coefficient of restitution comparison

<table>
<thead>
<tr>
<th>Coefficients of Restitution Used</th>
<th>Total Rocks</th>
<th>Timed out</th>
<th>Invalid Start</th>
<th>Invalid Intersection</th>
<th>Total Paths</th>
<th>Did Not Fall</th>
<th>Start Location X (m)</th>
<th>Start Location Y (m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>220</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>220</td>
<td>60</td>
<td>-3.43</td>
<td>3.15</td>
</tr>
<tr>
<td>Literature</td>
<td>220</td>
<td>4</td>
<td>0</td>
<td>2</td>
<td>218</td>
<td>0</td>
<td>-3.43</td>
<td>3.15</td>
</tr>
<tr>
<td>Experimental</td>
<td>220</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>220</td>
<td>79</td>
<td>-3.43</td>
<td>3.15</td>
</tr>
<tr>
<td>Modified</td>
<td>220</td>
<td>6</td>
<td>0</td>
<td>1</td>
<td>219</td>
<td>77</td>
<td>-3.43</td>
<td>3.15</td>
</tr>
</tbody>
</table>

### Table A4: Model trajectory errors and starting locations for the College Woods surface model comparison

<table>
<thead>
<tr>
<th>Slope Model Used</th>
<th>Total Rocks</th>
<th>Timed out</th>
<th>Invalid Start</th>
<th>Invalid Intersection</th>
<th>Total Paths</th>
<th>Did Not Fall</th>
<th>Start Location X (m)</th>
<th>Start Location Y (m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SfM</td>
<td>220</td>
<td>6</td>
<td>0</td>
<td>1</td>
<td>219</td>
<td>77</td>
<td>-3.43</td>
<td>3.15</td>
</tr>
<tr>
<td>Manual</td>
<td>220</td>
<td>3</td>
<td>0</td>
<td>0</td>
<td>220</td>
<td>97</td>
<td>-3.43</td>
<td>3.64</td>
</tr>
<tr>
<td>1m DEM</td>
<td>220</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>220</td>
<td>100</td>
<td>-3.43</td>
<td>2.37</td>
</tr>
<tr>
<td>2m DEM</td>
<td>220</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>220</td>
<td>220</td>
<td>-3.43</td>
<td>0.93</td>
</tr>
</tbody>
</table>